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Preface

The TIBCO MDM provides Global Data Synchronization (GDSN) functionality 
through a GDSN Add-on component called the TIBCO MDM Add-On for Global 
Data Synchronization.

Topics

• Changes from the Previous Release of this Guide, page viii

• Related Documentation, page ix

• Typographical Conventions, page xi

• Connecting with TIBCO Resources, page xii
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Changes from the Previous Release of this Guide

This section itemizes the major changes to this guide from the previous release:

Support for TIBCO MDM 9.0.0

This release supports only TIBCO MDM 9.0.0.
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Related Documentation

This section lists documentation resources you may find useful.

TIBCO MDM Add-on for Global Data Synchronization Documentation
The following documents form the TIBCO MDM Add-On for Global Data 
Synchronization documentation set:

• TIBCO MDM Add-on For Global Data Synchronization Installation Guide: A 
manual for instructions on installation and configuration of the GDSN 
Add-On.

• TIBCO MDM Add-on For Global Data Synchronization User’s Guide: A manual 
for instructions on usage of the GDSN Add-On.

• TIBCO MDM Add-On for Global Data Synchronization Release Notes: Read the 
release notes for a list of new and changed features. This document also 
contains lists of known issues and closed issues for this release.

TIBCO MDM Documentation
The following documents form the TIBCO MDM documentation set:

• TIBCO MDM Installation and Configuration Guide: A manual for instructions on 
site preparation, installation, and configuration.

• TIBCO MDM User’s Guide: A manual that explains features and benefits of 
TIBCO MDM from the business users’ viewpoint. It describes the features and 
functionality as well as all the screens.

• TIBCO MDM System Administrator’s Guide: A manual that explains features 
relevant to the system administrator.

• TIBCO MDM Customization Guide: A manual to understand how the 
application can be customized to your enterprise needs.

• TIBCO MDM Best Practice Guide: A manual to learn the best practices while 
using the TIBCO MDM features and functionalities.

• TIBCO MDM Workflow Reference: A reference for automation of business 
processes. 

• TIBCO MDM Web Services Guide: A reference for using web services in MDM.

• TIBCO MDM Release Notes: A list of new and changed features. This document 
also contains lists of known issues and closed issues for this release.
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Other TIBCO Product Documentation
You may find it useful to read the documentation for the following TIBCO 
products:

TIBCO MDM Studio Documentation

• TIBCO MDM Studio Process Designer User’s Guide. 

• TIBCO MDM Studio Process Designer Tutorial.

• TIBCO MDM Studio Repository Designer User’s Guide.

• TIBCO MDM Studio Repository Designer Tutorial.

• TIBCO MDM Studio Rulebase Designer Guide.

• TIBCO MDM Studio Rulebase Designer Tutorial.

• TIBCO MDM Studio UI Builder User’s Guide.

• TIBCO MDM Studio UI Builder Tutorial.

• TIBCO MDM Studio Release Notes.

Other TIBCO Product Documentation

• TIBCO Enterprise Message Service™ software: The application can send and 
receive messages using the Java Message Service (JMS) protocol. The software 
also integrates with TIBCO Rendezvous and TIBCO SmartSockets™ 
messaging products.

• TIBCO BusinessWorks software™: This is a scalable, extensible, and easy to use 
integration platform that allows you to develop and test integration projects. 
It includes a graphical user interface (GUI) for defining business processes 
and an engine that executes the process.

• TIBCO BusinessConnect™ software: You can send and receive XML or non-XML 
business documents over the Internet. Based on a mutually agreed process 
flow and common document format, you and your trading partners can 
conduct secure and verifiable business transactions online.
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Typographical Conventions

The following typographical conventions are used in this manual.

Table 1   General Typographical Conventions

Convention Use

code font Code font identifies commands, code examples, filenames, pathnames, and 
output displayed in a command window. For example:

Use MyCommand to start the foo process.

bold code 

font 
Bold code font is used in the following ways:

• In procedures, to indicate what a user types. For example: Type admin. 

• In large code samples, to indicate the parts of the sample that are of 
particular interest.

• In command syntax, to indicate the default parameter for a command. For 
example, if no parameter is specified, MyCommand is enabled: 
MyCommand [enable | disable]

italic font Italic font is used in the following ways: 

• To indicate a document title. For example: See TIBCO BusinessWorks Concepts.

• To introduce new terms For example: A portal page may contain several 
portlets. Portlets are mini-applications that run in a portal.

• To indicate a variable in a command or code syntax that you must replace. 
For example: MyCommand pathname

Key 
combinations

Key name separated by a plus sign indicate keys pressed simultaneously. For 
example: Ctrl+C.

Key names separated by a comma and space indicate keys pressed one after the 
other. For example: Esc, Ctrl+Q.

The note icon indicates information that is of special interest or importance, for 
example, an additional action required only in certain circumstances.

The tip icon indicates an idea that could be useful, for example, a way to apply 
the information provided in the current section to achieve a specific result.

The warning icon indicates the potential for a damaging situation, for example, 
data loss or corruption if certain steps are taken or not taken.
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Connecting with TIBCO Resources

How to Join TIBCOmmunity
TIBCOmmunity is an online destination for TIBCO customers, partners, and 
resident experts. It is a place to share and access the collective experience of the 
TIBCO community. TIBCOmmunity offers forums, blogs, and access to a variety 
of resources. To register, go to http://www.tibcommunity.com.

How to Access TIBCO Documentation
Documentation for this and other TIBCO products is available on the TIBCO 
Documentation site: 

https://docs.tibco.com

Documentation on the TIBCO Documentation site is updated more frequently 
than any documentation that might be included with the product. To ensure that 
you are accessing the latest available help topics, visit us at 
https://docs.tibco.com.

How to Contact TIBCO Support
For comments or problems with this manual or the software it addresses, contact 
TIBCO Support as follows:

• For an overview of TIBCO Support, and information about getting started 
with TIBCO Support, visit this site:

http://www.tibco.com/services/support

• If you already have a valid maintenance or support contract, visit this site:

https://support.tibco.com

Entry to this site requires a user name and password. If you do not have a user 
name, you can request one.
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Chapter 1  Overview

This chapter provides an overview of the TIBCO MDM Add-on for Global Data 
Synchronization.

Topics

• Global Data Synchronization Network, page 2

• Terminology Differences in the GDSN Edition, page 3

• GDSN Specific Configuration Properties, page 4

• GDSN Specific Roles, page 6

• GDSN Predefined Components, page 7
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Global Data Synchronization Network

The Global Data Synchronisation Network (GDSN) was created as an industry 
endorsed initiative to overcome product data inaccuracies and increase efficiency 
among trading partners and their supply chains. GDSN is a web based, 
interconnected network of interoperable data pools and a global registry.

With GDSN you can capture and exchange product information in a secure 
environment conforming to global standards. By using GDSN you can assure that 
data exchanged between trading partners is accurate and compliant with 
universally supported standards. 

GDSN consists of supplier and retailer trading partner, data pools that hold and 
process trading partner data and the GS1 Global Registry. A directory that helps 
locate data sources and keep relationships between trading partners in sync.

With GDSN, trading partners always have the latest information in their systems. 
Any changes made to one company's database are automatically and immediately 
provided to all of the other companies who do business with them.

With accurate and updated data, a supplier and a customer can do business in a 
smoother, quicker, and less expensive way.
TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



Terminology Differences in the GDSN Edition | 3
Terminology Differences in the GDSN Edition

This section lists the differences between the GDSN and MDM software editions. 
The default edition is MDM.

Table 2   Terminology Differences in GDSN

GDSN Name MDM Name

Repository Repository

Synchronize Synchronize

Trading Partner Backend System

Record Record

Datapool Integration Hub
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GDSN Specific Configuration Properties

The following configuration properties are specific to GDSN:

Table 3   GDSN Specific Configuration Properties

Property Configuration 
Outline Value Description

Plugins Advanced GDSN List of Plugins installed. For 
example, GDSN.

Software Edition 
>Application Usage Profile

Basic GDSN Defines whether the application 
is used for data synchronization 
(GDSN) or master data 
management (MDM)

Software Edition > 
Common Menus 
Configuration

Advanced config/securi
ty/allmenu.x
ml

The configuration file location 
for common menus (navigation 
bar) 

Function > Enable Market 
Place

Advanced True Marketplace related menus is 
visible.

Function > Company 
Profile

Advanced True Company Profile menu is 
visible.

Integration Setup - 
External > Connector 
Rulebase

Advanced standard/rule
base/rbconne
ctorprotocold
erivation_gds
n.xml

The rulebase to identify the 
protocol (for example, CIM2CIM, 
1WorldSync)

Integration Setup - 
External > Sync Status 
Rulebase

Advanced standard/rule
base/rbsyncst
atusupdatede
rivation.xml

Sync status derivation, used to 
identify operation and 
suboperation.

Integration Setup - 
External > Synchronization 
Format Specific Attributes 
File

Advanced rbformatattri
butes_gdsn.x
ml

The name of the rulebase file 
used to customize format 
specific attributes on the 
Synchronization profile View 
and Edit screen.
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Rule Base->Send Message 
Screen Rulebase File

Advanced rbsendmessa
ge_gdsn.xml

The name of the rulebase file 
used to customize record 
attribute display on the 
SendMessage screen

Integration Setup - 
External -->Work Item 
Description Rulebase File

Advanced rbworkitemd
escription_gd
sn.xml

The name of the rulebase file to 
customize work item messages 

Table 3   GDSN Specific Configuration Properties

Property Configuration 
Outline Value Description
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GDSN Specific Roles

You can access the Roles screen by clicking Administration > Roles. It displays 
all available Roles and descriptions. 

In addition to the standard MDM roles, the following roles are GDSN specific and 
visible only in the GDSN edition of MDM:

Channel Manager

Is a user responsible for business activity in a particular sales channel. Typically 
responsible for relationships with Datapools or a set of buying organizations.

Sales Rep

Is a member of the supplier sales organization who acts upon current items in the 
Inbox that pertains to their area. Sales Rep is not created for the MDM edition. If it 
existed already, it is not deleted during migration.
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GDSN Predefined Components

For GDSN, a set of predefined components such as maps, rulebases, workflows, 
and templates are shipped with the application.

All these components are located in relevant folders under 
$MQ_HOME/plugins/gdsn/<version>/common/standard

For details, see GDSN Predefined Components, page 197.
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Chapter 2 GDSN Menu Options and Screens

This chapter describes the GDSN-specific options (that are not displayed in the 
standard MDM version) in the menus and screens in MDM.

Topics

• Datapool Profiles in the Administration Menu, page 10

• All Company Profiles Screen, page 11

• My Company Profiles Screen, page 11

• Datapool Profiles Screen, page 13

• Trading Partner Profiles Screen, page 14

• View Repository Screen, page 15

• Message Acknowledgements, page 16

• Inbox UI, page 18

• Event Log Search, page 19

• Customizing Workitem Descriptions, page 21
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GDSN Specific Menu Items

Datapool Profiles in the Administration Menu
The Administration menu includes a Datapool Profiles option that is specific to 
the GDSN version of MDM.

A Datapool Profile defines an electronic sales channel, datapool, or hub - where 
backend systems can exchange goods. Datapool Profiles and credentials are used 
to establish new datapools and manage the datapool activities. 

A Datapool Profile correlates to a workflow associated with the datapool and you 
can subscribe or unsubscribe a Datapool as required. Datapool credentials are 
provided automatically; however, you can define additional credentials. For more 
details, see Datapool Profiles Screen, page 13.
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GDSN Specific Screens

This section covers all GDSN specific screens or GDSN specific options in screens.

All Company Profiles Screen
The All Company Profiles screen is accessed by clicking Administration > All 
Company Profiles > Create and is used by super users to create enterprises. 

You can specify the Name, and Internal Name for the enterprise, the Industry 
Vertical, and the Type. The Type list contains Supplier, Retailer, and Datapool as 
options. 

My Company Profiles Screen
You can access the Company Profile screen by clicking Administration > My 
Company Profile and displays the profile of the company that you have logged 
into. 

This screen consists of contact information and credentials for your company. The 
purpose of company credentials is to enable your organization to communicate 
with a datapool.
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The following information is GDSN-specific:

Extended Credentials 

Each credential can be supplemented with additional information known as 
extended credentials. To create extended credentials, click the Credentials link in 
the Datapool section of the Company Profile screen.

This data is used for authentication when communicating with the datapool. To 
define an extended credential, first define a basic credential.

Extended credentials are unique across enterprises. These constraints are 
implemented using predefined seed data and cannot be changed using the UI.

The following constraints apply to datapools: 

• Basic credentials must be unique in an organization. 

• Only one GLN per enterprise
TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



GDSN Specific Screens | 13
To create extended credentials, click Administration > My Company Profile > 
and then click Credentials in the Datapool section. Click Create.

Enter the required details and click Save.

Datapool

This section of the screen displays the datapool the company is subscribed to. A 
"Not subscribed to any Datapool" message indicates that no datapool 
subscriptions have been made for the company.

You can subscribe to a datapool by clicking Datapool Profiles (see Datapool 
Profiles Screen, page 13). This opens the Datapool Profiles screen that displays all 
the datapools supported by TIBCO MDM. Click Subscribe to subscribe to that 
datapool. Only datapools that the company is subscribed to are available for 
participation by the backend system.

Datapool Profiles Screen
This is the first screen you see when you click Administration > Datapool 
Profiles. It displays all datapools that you can subscribe to and are supported by 
TIBCO MDM.

Use this screen for the following activities:
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• Modify Datapool Profiles
To modify a datapool profile, click Modify in the Actions column. The 
Datapool Profiles - Synchronization Formats screen is displayed. On this 
screen you can:

— Modify supported synchronization formats. TIBCO MDM supports 
formats specific to datapools, and default formats can be set for each 
datapool. If custom formats are required, they can be created using 
synchronization formats.

— Create Credentials. A Datapool credential uniquely identifies a datapool 
or backend system within a datapool. This establishes message origination 
and destination for that backend system. For example, a supplier wants to 
do business with a backend system through a datapool such as 
1WorldSync. the datapool provides User IDs and Passwords or credentials 
to both the supplier and backend system, and identifies itself to both using 
its own password and credentials.

• Subscribe or Unsubscribe to Datapools
Click the Subscribe or Unsubscibe button in the Actions column.

• Filter Datapools 
By default, all datapools are displayed. They can be sorted based on 
subscription from the View drop-down list.

There are two forms of Datapool profiles. The most common form is when a 
company wants to communicate with a Datapool. In this case, the only data 
elements visible are: 

• Subscribe to this Datapool.

• Define any integration URL, if applicable. 

• Define credentials. Here, the credentials of the Datapool are defined (and not 
the company as company credentials are defined in the Company Profile). 

• Some preexisting credentials are displayed as read only. These credentials are 
global and can only be modified by a super user. 

A supplier organization Datapool Profile consists of:

• Documents for communication - such as Item Add, or Item Publish.

• A document format - such as EANUCC, XML, 1WorldSync, and so on.

Trading Partner Profiles Screen
You can access the screen by clicking Administration > Trading Partner Profiles, 
and then clicking Create. 
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Using this screen you can create a new trading partner profile for your company. 
Two ways to exchange data with a trading partner are: 

• Publish data to the Datapool from where the data gets synchronized with the 
trading partner. 

• Deliver the data to the trading partner directly through FTP or email.

The Datapool option in this screen is GDSN-specific. Select to subscribe. 

When you view a trading partner profile, if not subscribed to any datapools, you 
see the message "Not subscribed to any datapools" in the Datapool Participation 
section.

View Repository Screen
The View Repository screen displays the content of a selected repository and you 
can access by clicking Item Data > Repositories. The following information is 
GDSN-specific:
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Selected Predefined Classification Schemes

Classification schemes that are provided with the application by default are 
referred to as predefined classification schemes and are listed here. The schemes 
listed here are those selected at the time of creating the repository.

You can click the Classification Scheme name to view details; this displays the 
Classification Scheme Modify screen. On this screen, click Show Usage to view 
the Classification Scheme Usage.

Message Acknowledgements
When a message is sent from a Supplier to a Retailer, the retailer can send an 
acknowledgment for the message using the Send Response utility. 

Enabling Message Acknowledgments

By default, message acknowledgements are not enabled. You need to enable 
permissions for a user to send a response.

1. Go to Administration >Resource Security.

2. From the list, select Resource Type as Repository and Resources as <name of 
Repository>. Click Show Permissions. The Manage Resource Security for 
Repositories screen is displayed.
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3. On the Manage Resource Security for Repositories screen, select Resource 
Type as Record and click the Add Grantee button.

4. You can assign a user or a role as grantee. Select the grantee and click OK.

5. A list of permissions is displayed in the Permission Name column.
Click Allow against Allow action - Send Response permission and click 
Save.

Sending Message Acknowledgments 

To send a record as a response, do the following:

1. Click Browse and Search. From the Repository Name list, select the name of 
the repository. 

2. Click View All. A list of records is displayed. 

3. Click the record ID of a record. 
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4. From the More Actions menu, select Send Response. 

5. The Send Response screen is displayed.

6. On the Send Response screen, you can set the following options:

— Action: You can select Review, Received, Synchronised, or Rejected.

— Retailer Credential: You can select the retailer credential from the 
dropdown list.

7. Click Submit. The Record View screen is displayed.

8. Click Ok. The acknowledgment is sent to the Supplier. 

Inbox UI
You can access the page by clicking Inbox on the main menu. The Inbox shows a 
list of tasks or work items assigned or delegated based on the configured business 
process rule. The Inbox content is influenced by your Role. Work items are 
classified as notification (no action required) or action (action required).

You can search for items (by clicking the Search button) based on criteria such as:

• State: View work items by state - All, Cancelled, Closed, Open, or Timed out 
work items.

• Type: Filter work items by type - All, Action Items, Notifications.
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• Document Type: Filter work items by Document Type such as All, Mass 
Update, Record Content Notification, Record Edit, or Synchronization.

• Action: Filter work items by the Action performed, such as Data Change, Data 
Correction, MassUpdate, Record Add, Record Add Notification, and 
Synchronization.

• Trading Partner: Filter work items by trading partner. 

• Event ID: Filter work items by entering the exact event ID. 

• From Date/To Date: Filter work items created within a certain date range. It is 
not mandatory to specify both the start and end dates of a period that you are 
tracking. You can specify either of them.

• Repository: Filter work items by repository. It displays the list of repositories 
to which you have access (at least LIST access). Work items can be searched 
for a specific repository. To remove a filter the search needs to be cleared. 

• Record Attribute: Filter work items based on the values of Record Attributes. 
For example, to search SecurityID - 00049822430355; you can either enter the 
complete SecurityID or enter a partial value (00049822) to get the work item.

• Sort by Record Attribute: Sort work items based on record attribute. Select 
the record attribute from the drop-down list. If you want to sort the list in the 
descending order of the record attribute, select the Descending check box.

• Datapool: Filter work items by datapool.

• Show Action Items First: If selected, displays action items followed by 
notifications.

• Search/Sort: Enter your search criteria and click Search/Sort to generate a list 
of work items matching your criteria. If you want to change the search criteria, 
click Clear to reset the criteria.

• Clear: Clears the search

• Configure: To configure the columns displayed in the table.

Event Log Search
To access this page, click Event Log in the main menu and then click the Search 
option.
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The Event Log screen shows a list of all events in the system. You can click Search 
to search for events based on criteria such as:

• Event Status

• Event Type

• Event ID

• User ID

• Operation

• Trading Partner

• Datapool

• Event Start Date

• Event End Date

• Record ID

• RecordID Ext.
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GDSN Customization

Customizing Workitem Descriptions
You can include hyperlinks to objects such as Repositories, Catalogs, Trading 
Partners, and so on in your workitem description. You can include only one 
hyperlink per object in a message by including the relevant token in the 
description. 

For details on tokens that can be used, refer to chapter Customizing Workitem 
Descriptions in the TIBCO MDM Customization Guide . 

GDSN Specific Information

For the $Catalog$ token that is used to create a hyperlink with a catalog, the name 
of the catalog appears in place of the token, hyperlinked to the latest version of 
the catalog. However, there are some exceptions applicable to the GDSN version:

• Catalogue Item Notification (CIN) message notifications received by retailers

• Catalog Item Confirmation (CIC) received by suppliers, which were not sent 
to the retailers using the catalog
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Chapter 3 Synchronization

This chapter describes GDSN-specific information in synchronization profiles and 
formats in TIBCO MDM.

Topics

• Synchronization Profiles, page 24

• GDSN Specific Synchronization Formats, page 28

• Using Custom Synchronization Formats, page 29

• Updating Synchronization Status, page 30
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Synchronization Profiles

Synchronization Profiles provide a way of extracting information from 
repositories. As part of the Synchronization Profile definition, you can choose 
records and attributes to be extracted, record versions, whether to apply 
transformation rules, and where to send the extracted data. Synchronization 
Profiles once created can be reused to extract data.

Viewing Synchronization Profiles
You can access this page by clicking Item Data > Synchronization Profiles. 
Details for all available synchronization profiles can be viewed here, with related 
information in specific columns such as the Repository, Synchronization Format, 
Delivery, and so on.

Creating Synchronization Profiles
You can create synchronization profiles by clicking Item Data > Synchronization 
Profiles and then clicking Create on the Synchronization Profiles screen.

When creating a Synchronization Profile, some options are GDSN-specific. 
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Delivery

In the Delivery section of the Create Synchronization Profile screen, you can 
select the entity to deliver records to. The following entities are GDSN-specific:

— Datapool

Datapool is the central repository. When you select Datapool, and click 
Synchronize, the system sends the data as a message to the Datapool. The 
message is sent in the XML format and the system requires an 
acknowledgement from the Datapool. You need to provide the name of the 
Datapool, the output map, and the delivery mechanism.

— Trading Partner on Datapool

When you select this option, and click Synchronize, the message is sent to 
only those trading partners who are subscribed to the Datapool. The 
trading partner should have a valid GLN account with the Datapool. You 
can select multiple trading partners in this option. You need to specify both 
the Datapool and trading partners subscribed to the Datapool. You also 
need to specify the Output Map format and the delivery mechanism.

Format Specific Attributes 

Format Specific Attributes vary based on where you want to deliver the records.

If Datapool is selected in the Delivery group, the following is displayed:
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• Operation: You can select from the following operations:

— Add: Adds the record to the Datapool.

— Data Correction: If there is a discrepancy in the published record, you can 
select Data Correction to rectify the record. In this case, the record reverts 
to its original state.

— Cancel: If you cancel a record, you cannot publish or reinstate the same 
record within 24 to 48 months of cancellation.

— Discontinue: If you discontinue a record, you cannot publish the same 
record within 24 to 48 months.

— Reinstate: Using reinstate, you can republish a discontinued record. 

• Classification Scheme: The classification scheme listed in the Company 
Profile are displayed here.

• Supplier Credential: The credentials listed in the Company Profile are 
displayed here.

• Deliver Synchronization Profile: Select Yes if you wish to deliver the 
synchronization profile to the backend system.

• Generate Output file?: Select the option to generate output file.

If Trading Partner on Datapool is selected in the Delivery group, the following 
additional fields are displayed:
TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



Synchronization Profiles | 27
• Operation: You can select from the following operations:

— Add: Adds the record to the Datapool.

— Data Correction: If there is a discrepancy in the published record, you can 
select Data Correction to rectify the record. In this case, the record reverts 
to its original state.

— Publish: Publishes the record to the selected backend systems.

• Classification Scheme: The classification scheme listed in the Company 
Profile are displayed here.

• Supplier Credential: The credentials listed in the Company Profile are 
displayed here.

• Deliver Synchronization Profile: Select Yes if you wish to deliver the 
synchronization profile to the backend system.

• Generate Output file?: Select the option to generate output file.
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Synchronization Formats

You can access this screen by clicking Item Data > Synchronization Formats. The 
application currently provides a set of predefined synchronization formats.

GDSN Specific Synchronization Formats
Synchronization formats define the attributes and structure of the data required 
by the consumers of that data (external systems or datapools).

Output maps define mappings of repository attributes to synchronization 
formats. When a repository is synchronized, the synchronization format provides 
the structure for the output information.

For GDSN, many predefined synchronization formats are supplied which are not 
modified. The following are GDSN-specific synchronization formats:

• 1SYNC

• EAN.UCC

• EAN.UCC.SUBSCRIPTION

• GS1

• SA2

• TIBCO

• XML
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Using Custom Synchronization Formats

1. Copy the EAN.UCC synchronization format to create the <CustomUCC> 
format.

— Select the EAN.UCC format check box and click the Copy button.

— Provide a name and description on the Synchronization Format copy 
screen.

2. Create output map <CustomOutputMap>.

— Go to Item Data->Repositories

— Select a repository, go to the Output Maps tab, click Create.

3. Change the rulebase to select <CustomOutputMap>. For more information on 
creating a rulebase, refer the TIBCO MDM Studio Rulebase Designer Guide. The 
modified rulebase section will look like the following:

<assign>
<var>OUTPUTFORMAT</var> 
<const type="string">CustomOutputMap</const> 
</assign>

4. Perform Update sync status. For more information on updating 
synchronization status, see Updating Synchronization Status, page 30.

If you are not using the default EAN.UCC format, you need to make changes to 
the rulebase to publish an output map created for a custom synchronization 
format. 

Navigate to 
<MQ_COMMONDIR>/standard/rulebase/rbsyncstatusupdatederivation.xml 
to add the name of custom output map instead of "EAN.UCC" as in the following 
section:
<assign>
<var>OUTPUTFORMAT</var> 
<const type="string">EAN.UCC</const> 
</assign>

There may be several similar replacements required.
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Synchronization Status

Updating Synchronization Status
Records are always synchronized with Datapools. The synchronization state (sync 
status) of a record can be incorrect in the following cases:

1. Datapool failed to respond.

2. Message(s) failed in Datapool(s) and there was no response from messages.

3. Response was received but response format was not comprehensive and the 
processing failed.

4. Record was synchronized outside the application. For instance, you migrated 
from MDM to another GDSN system.

When the synch status is incorrect, it affects the next message generated by the 
application and synchronization is not possible. To resolve this issue, the synch 
status needs to be updated. 

To update the synch status of the record, do the following:

1. Click Browse and Search. A list of Repositories are displayed. 

2. In the Repository list, select the repository. 

3. Click View All Records. A list of records is displayed. 

4. Click on the record whose synch status you want to update. The View Record 
screen is displayed. 

5. Click More Actions > update synch status. 

6. The Update Synch Status screen is displayed.
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7. Specify the following fields on the Update Synch Status screen:

— Datapool

— Trading Partner

— Operation

— Sub-Operation

8. Click Save to update synch status.

An out-of-box installation assumes that EAN.UCC is associated with the 
repository. If this format is not associated, the operation fails. To correct this, 
either associate the synchronization format or use another synchronization format 
in the rulebase rbsyncstatusupatederivation.xml. 
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Chapter 4 Validations and Codelists

This chapter describes validations in MDM for mandatory and optional 
attributes in 1WorldSync and MDM’s implementation of the 1WorldSync 
codelists.

Topics

• 1WorldSync Validations Overview, page 34

• MDM Validation for 1WorldSync Mandatory Attributes, page 35

• MDM Validation for 1WorldSync Optional Attributes, page 37

• MDM Implementation of 1WorldSync Codelist, page 45
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1WorldSync Validations Overview

While communicating to subscribers, 1WorldSync specifies certain rules to be 
followed to ensure that the data received is correct. 1WorldSync performs 
validation on different types of messages received and processed. 

Supported 1WorldSync Validations
MDM supports the following 1WorldSync validations:

• When messages of type Item Load (Item Add, Item Modify Item Link, or Item 
Unlink transaction) are received

• When messages of type Item Publish are received

For more details, refer MDM Validation for 1WorldSync Mandatory Attributes 
and MDM Validation for 1WorldSync Optional Attributes for validations 
implemented in MDM for mandatory and optional attributes by 1WorldSync for 
Item Load messages.
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MDM Validation for 1WorldSync Mandatory Attributes

The following table lists validations implemented in MDM for mandatory 
attributes specified by 1WorldSync for Item Load messages (Item Add, Item 
Modify). 

In the table below:

• IM Attribute is the attribute name in 1WorldSync.

• 1WorldSync Error Code is the error displayed by 1WorldSync in case of 
validation problems.

• MDM Repository Attribute is corresponding name of the 1WorldSync 
attribute in the MDM Repository.

• 1WorldSync Catalog Output Map Attribute is the name of an attribute 
created by MDM using the 1WorldSync Catalog Output Map.

Table 4   Validation for 1WorldSync mandatory attributes

IM Attribute 1WorldSync Error Code Repository Attribute Sync Profile 
Attribute

Global Trade 
Item Number

1021, 1024, 1025 GTIN GTIN

GTIN Name 1040 GTIN_NAME GTIN_NAME

Product Type 1080 UOM PRODUCT_TYPE

Target Market 1160 TARGET_MARKET_ID TARGET_MARKET

Language No error code available DESCLANGUAGE LANGUAGECODE

Information 
Provider 
(GLN)

1011 1061, 1064, 1062, 
4020

INFORMATION_PROVIDER_
ID

INFORMATION_PROVID
ER

Brand Name 1050 ITEM_BRAND_NAME BRAND_NAME

Item 
Classification 
Code (GPC)

1070 ADDITIONAL_CLASS_CAT_
CODE

ALT_ITEM_CLASSN_CO
DE

Qty of Next 
Level Item(s)

1130 UNITS_PER_CONTAINER PACK
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Ordering Unit 
Indicator

1140 ORDERING_UNIT ORDERING_UNIT_INDI
CATOR

Start 
Availability 
Date

1150 START_AVAILABILITY_DA
TE

START_AVAILABILITY
_DATE

Height 1100 PRODUCTHEIGHT HEIGHT

Height UOM 1101 HEIGHT_UOM HEIGHT_UOM

Width 1120 PRODUCTWIDTH WIDTH

Width UOM 1121 WIDTH_UOM WIDTH_UOM

Depth 1110 PRODUCTDEPTH DEPTH

Depth UOM 1111 DEPTH_UOM DEPTH_UOM

Table 4   Validation for 1WorldSync mandatory attributes

IM Attribute 1WorldSync Error Code Repository Attribute Sync Profile 
Attribute
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MDM Validation for 1WorldSync Optional Attributes

The following table lists validations implemented in MDM for optional and 
dependant attributes specified by 1WorldSync for Item Load messages (Item Add, 
Item Modify). 

Table 5   Validation for 1WorldSync Optional Attributes

IM Attribute 1WorldSync 
Error Code Repository Attribute Sync Profile Attribute 

Alternate Item 
Classification 
Scheme

1071, 1077, 3085 ADDITIONAL_CLASS_CAT_CO

DE

ALT_ITEM_CLASSN_CODE

CLASSIFICATIONSCHEME CLASSIFICATION_SCHEME

Flash Point 
Temperature 
UOM

1548, 1549 FLASHPOINT_TEMP1 FLASHPOINT_TEMP

FLASHPOINT_UNITS1 FLASHPOINT_TEMP_UOM

Product 
Strength UOM

1686, 1687 PROD_STRENGTH PROD_STRENGTH

PROD_STRENGTH_UOM PROD_STRENGTH_UOM

Product 
Strength Basis 
UOM

1689, 1690 PROD_STRENGTH_BASIS PROD_STRENGTH_BASIS

PROD_STRENGTH_BASIS_UOM PROD_STRENGTH_BASIS_U

OM

Diameter 
UOM

1780, 1781 DIAMETER DIAMETER

DIAMETER_UOM DIAMETER_UOM

Drained 
Weight UOM

1783, 1784 DRAINED_WEIGHT DRAINED_WEIGHT

DRAINED_WEIGHT_UOM DRAINED_WEIGHT_UOM

Gross Weight 
UOM

1786, 1787 GROSSWEIGHT GROSS_WEIGHT

GROSS_WEIGHT_UOM GROSS_WEIGHT_UOM

Net Weight 
UOM

1790, 1789 NETWEIGHT NET_WEIGHT

NET_WEIGHT_UOM NET_WEIGHT_UOM
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Volume UOM 1801, 1802 VOLUME VOLUME

VOLUME_UOM VOLUME_UOM

Width UOM 1804, 1805 PRODUCTWIDTH WIDTH

WIDTH_UOM WIDTH_UOM

Max Stacking 
Weight UOM 
(formerly Max 
Admissible 
Stacking 
Weight UOM)

1901, 1902 STACKING_WEIGHT_MAX MAX_ADM_STACKING_WEIG

HT

MAX_ADM_STACKING_WEIGHT

_UOM

MAX_ADM_STACKING_WEIG

HT_UOM

Storage/Hand
ling Temp 
UOM

6228 STORAGE_HANDL_TEMP_MIN_

UOM

STORAGE_HANDL_TEMP_MI

N_UOM

STORAGE_HANDL_TEMP_MAX_

UOM

STORAGE_HANDL_TEMP_MA

X_UOM

Alternate Item 
Number

2002 ALTERNATE_ID ALTERNATE_ITEM_ID

ALTERNATE_ITEMID_MNT_AG

ENCY

ALTERNATE_ITEMID_MNT_

AGENCY

Fat Content 
Basis of 
Measure UOM

2084, 2085 FAT_CONTENT_BASIS_MEASU

RE

FAT_CONTENT_BASISOF_M

EASURE

FAT_CONTENT_BASIS_UOM FAT_CONTENT_BASIS_UOM

Net Content 
(Metric) UOM 
(formerly Size 
(Metric) UOM)

4043 BASE_UNIT BASE_UNIT_INDICATOR

NET_CONTENT_PRIMARY SIZE_METRIC

NET_CONTENT_UOM SIZE_METRIC_UOM

Table 5   Validation for 1WorldSync Optional Attributes

IM Attribute 1WorldSync 
Error Code Repository Attribute Sync Profile Attribute 
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Ordering Unit 
Indicator 

3013, 3014, 3015 ORDERING_UNIT ORDERING_UNIT_INDICAT

OR

Gross Weight GROSSWEIGHT GROSS_WEIGHT

Gross Weight 
UOM

GROSS_WEIGHT_UOM GROSS_WEIGHT_UOM

Product 
Strength Basis

3040, 3041 PROD_STRENGTH PROD_STRENGTH

PROD_STRENGTH_BASIS PROD_STRENGTH_BASIS

Ordering Unit 
Indicator

3051 ORDER_INCREMENT ORDER_QUANTITY_MULTIP

LE

ORDERING_UNIT ORDERING_UNIT_INDICAT

OR

Ordering Unit 
Indicator

3053 MAXIMUMORDER MAX_ORDER_QUANTITY 

ORDERING_UNIT ORDERING_UNIT_INDICAT

OR

Ordering Unit 
Indicator

3055 MINIMUMORDER MIN_ORDER_QUANTITY

ORDERING_UNIT ORDERING_UNIT_INDICAT

OR

Fat Content 
Basis of 
Measure

3100, 3101 FAT_PERCENT_IN_DRY_MATT

ER

FAT_CONTENT

FAT_CONTENT_BASIS_MEASU

RE

FAT_CONTENT_BASISOF_M

EASURE

Non GTIN 
Pallet Height 
UOM

3138 PACKAGEDHEIGHT NONGTIN_PL_HEIGHT

NONGTIN_PL_HEIGHT_UOM NONGTIN_PL_HEIGHT_UOM

Non GTIN 
Pallet Gross 
Weight UOM

3140 NONGTIN_PL_GR_WEIGHT NONGTIN_PL_GR_WEIGHT 

NONGTIN_PL_GR_WEIGHT_UO

M

NONGTIN_PL_GR_WEIGHT_

UOM

Table 5   Validation for 1WorldSync Optional Attributes

IM Attribute 1WorldSync 
Error Code Repository Attribute Sync Profile Attribute 
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Global Item 
Classification 
Code

1072 ADDITIONAL_CLASS_CAT_CO

DE

ALT_ITEM_CLASSN_CODE

EAN/UCC 
Code 

4008 EAN_UCC_CODE EAN_UCC_CODE 

EAN/UCC 
Type

EAN_UCC_TYPE EAN_UCC_TYPE

EAN/UCC 
Code

4002, 4003 EAN_UCC_CODE EAN_UCC_CODE

Qty of Next 
Level Item(s)

212, 4005, 106, 
4023

UNITS_PER_CONTAINER PACK

Brand Name 1051 ITEM_BRAND_NAME BRAND_NAME

Sub Brand 1740 ITEM_SUB_BRAND_NAME SUB_BRAND

Ordering Unit 
Indicator

655, 111 ORDERING_UNIT ORDERING_UNIT_INDICAT

OR

Special Item 
Code

4022 SPECIAL_ITEM_CODE SPECIAL_ITEM_CODE

Depth UOM 3120 DEPTH_UOM DEPTH_UOM

Width UOM WIDTH_UOM WIDTH_UOM

Height UOM HEIGHT_UOM HEIGHT_UOM

Diameter 
UOM

DIAMETER_UOM DIAMETER_UOM

Peg Hole 
Number

6216 PEG_HORIZONTAL PEG_HORIZONTAL

PEG_VERTICAL PEG_VERTICAL

PEG_HOLE_NUMBER PEG_HOLE_NUMBER

Table 5   Validation for 1WorldSync Optional Attributes

IM Attribute 1WorldSync 
Error Code Repository Attribute Sync Profile Attribute 
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Peg Horizontal 
UOM

6216 PEG_HORIZONTAL PEG_HORIZONTAL

PEG_HORIZONTAL_UOM PEG_HORIZONTAL_UOM

Peg Vertical 
UOM

6216 PEG_VERTICAL PEG_VERTICAL

PEG_VERTICAL_UOM PEG_VERTICAL_UOM

Net Content 
(Metric 
(formerly Size 
Imperial 
UOM))

6216 NET_CONTENT_SECONDARY, SIZE_IMPERIAL, 

NET_CONTENT_SECONDARY_U

OM

SIZE_IMPERIAL_UOM

Net Content 
(Metric 
(formerly Size 
(Metric))

6216 NET_CONTENT_PRIMARY SIZE_METRIC

NET_CONTENT_UOM SIZE_METRIC_UOM

List Price Basis 
UOM

6216 LIST_PRICE_BASIS_PER_UN

IT

LIST_PRICE_BASISPERUN

IT

LIST_PRICE_BASISPERUNIT

_UOM

LIST_PRICE_BASISPERUN

IT_UOM

Product Size 
Code 
Maintenance 
Agency

6216 SIZE_CODE PROD_SIZE_CODE

SIZE_CODE_LIST_AGENCY PROD_SIZE_CODE_MAINT_

AGENCY

Storage/Hand
ling Temp 
UOM

6216 STORAGE_HANDLING_TEMP_M

AX, 

STORAGE_HANDL_TEMP_MA

X, 

STORAGE_HANDL_TEMP_MAX_

UOM

STORAGE_HANDL_TEMP_MA

X_UOM

Storage/Hand
ling Temp 
UOM

6216 STORAGE_HANDLING_TEMP_M

IN

STORAGE_HANDL_TEMP_MI

N

STORAGE_HANDL_TEMP_MIN_

UOM

STORAGE_HANDL_TEMP_MI

N_UOM

Table 5   Validation for 1WorldSync Optional Attributes

IM Attribute 1WorldSync 
Error Code Repository Attribute Sync Profile Attribute 
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Color 6216 COLOR COLOR 

Color Code 
Maintenance 
Agency

COLOR_CODE_AGENCY COLOR_CODE_MNT_AGENCY

Organic Claim 
Agency 

6216 ORGANIC_CLAIM_AGENCY ORGANIC_CLAIM_AGENCY 

Organic Claim 
Item Code

ORGANIC_CODE ORGANIC

Material Code 
Agency 

6216 MATERIAL_CODE_AGENCY MATERIAL_CODE_AGENCY

Packaging 
Material Code

PKG_MATERIAL_CODE PACKAGING_M 

ATERIAL_CODE

Packaging 
Material 
Composition 

PACKAGING_WEIGHT PACKAGING_WEIGHT

Packaging 
Material 
Composition 
UOM

PACKAGING_WEIGHT_UOM PACKAGING_WEIGHT_UOM

List Price Basis 
Per Unit 

List Price Basis 
Per Unit UOM

6216 LIST_PRICE LIST_PRICE

PRICEUOMCODE PRICEUOMCODE

LIST_PRICE_BASISPERUNIT

_UOM

LIST_PRICE_BASISPERUN

IT_UOM

LIST_PRICE_BASISPER_UNI

T

LIST_PRICE_BASISPERUN

IT

LIST_PRICE_DATE_START LIST_PRICE_DATE_START

Table 5   Validation for 1WorldSync Optional Attributes

IM Attribute 1WorldSync 
Error Code Repository Attribute Sync Profile Attribute 
TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



MDM Validation for 1WorldSync Optional Attributes | 43
Tax (Rate) 6216 TAX_RATE TAX_RATE

Type Code 
Tax (Rate) 

TAX_TYPE_CODE TAX_TYPE

Type 
Description 
Tax (Rate) 

TAX_TYPE_DESC TAX_TYPE_DESC

Type Agency TAX_AGENCY_CODE TAX_AGENCY_CODE

Tax Amount 6216 TAX_AMOUNT TAX_AMOUNT

Tax Amount 
Currency 

CURRENCY_CODE CURRENCY_CODE

Tax (Amount) 
Type 
Description

TAX_AMT_TAX_TYPE_DESC TAX_AMT_TAX_TYPE_DESC

Tax (Amount) 
Type Agency 

TAX_AMT_TAX_AGENCY_CODE TAX_AMT_TAX_AGENCY_CO

DE

Tax (Amount) 
Type Code

TAX_AMT_TAX_TYPE_CODE TAX_AMT_TAX_TYPE_CODE

Alternate Item 
Classification 
Code

1078 UDEXCODE GLOBAL_CLASSIFICATION

_CODE

Information 
Provider 
(GLN)

VE-0180_VE-0190 INFORMATION_PROVIDER_ID INFORMATION_PROVIDER

Table 5   Validation for 1WorldSync Optional Attributes

IM Attribute 1WorldSync 
Error Code Repository Attribute Sync Profile Attribute 
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Brand Owner
(formerly 
Owning 
Organization)

VE-0270 BRAND_OWNER_ID OWNING_ORGANIZATION_G

LN

Variant VE-0320 VARIANT VARIANT

Functional 
Name

VE-0330 PRODUCTNAME PROD_NAME

Table 5   Validation for 1WorldSync Optional Attributes

IM Attribute 1WorldSync 
Error Code Repository Attribute Sync Profile Attribute 
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MDM Implementation of 1WorldSync Codelist

Certain 1WorldSync attributes accept only values from a code list. The following 
table lists the MDM implementation of the 1WorldSync code list. For a given 
attribute in the ‘IM Attribute’ column, the Repository Attribute column lists how 
the code list is implemented on the attribute.

Table 6   MDM Implementation of 1WorldSync Codelist

IM Attribute Repository Attribute MDM Datasource Name

Language DESCLANGUAGE LANGUAGE_CODES

Storage/Handling Temp UOM STORAGE_HANDL_TEMP_MA
X_UOM
STORAGE_HANDL_TEMP_MI
N_UOM

TEMP_CODES

Barcode Type BAR_CODE_TYPE BAR_CODE_TYPES

Alternate Item Classification Scheme CLASSIFICATIONSCHEME CLASSIFICATION_SCHEME
S

Country of Origin COUNTRYOFORIGINCODE COUNTRY

Country of Assembly TRADE_ITEM_COUNTRY_AS
SEMBLY

COUNTRY

Variable Trade Item Type VARIABLE_TRADE_ITEM_T
YPE

No Datasource.

Code values are of type 
enumeration, contained in 
the rulebase XML file.
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Depth UOM DEPTH_UOM LINEARUNIT

Width UOM WIDTH_UOM

Height UOM HEIGHT_UOM

Diameter UOM DIAMETER_UOM

Peg Horizontal UOM PEG_HORIZONTAL_UOM

Peg Vertical UOM PEG_VERTICAL_UOM

Size Dimension UOM SIZE_DIMENSION_UOM

Non GTIN Pallet Height UOM NONGTIN_PL_HEIGHT_UOM

Gross Weight UOM GROSS_WEIGHT_UOM WEIGHTUNIT

Net Weight UOM NET_WEIGHT_UOM

Drained Weight UOM DRAINED_WEIGHT_UOM

Material Weight UOM MATERIAL_WEIGHT_UOM

Packaging Material Composition 
UOM

PACKAGING_WEIGHT_UOM

Non GTIN Pallet Gross Weight UOM NONGTIN_PL_GR_WEIGHT_
UOM

Max Stacking Weight UOM MAX_ADM_STACKING_WEIG
HT_UOM

Table 6   MDM Implementation of 1WorldSync Codelist

IM Attribute Repository Attribute MDM Datasource Name
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Fat Content UOM, FAT_CONTENT_UOM PRICE_MATERIAL_UOM_CO
DES

Fat Content Basis of Measure UOM FAT_CONTENT_BASIS_UOM

Product Strength UOM PROD_STRENGTH_UOM

Product Strength Basis UOM PROD_STRENGTH_BASIS_U
OM

List Price Basis Basis UOM LIST_PRICE_BASISPERUN
IT_UOM

Suggested Retail Price Basis UOM RECOMMEND_PRICE_PERUN
IT_UOM

Selling UOM SELLING_UOM SELLING_ORDERING_UOM_
CODES

Ordering UOM ORDERING_UOM

Price Comparison Measurement 
UOM

PRICE_COMP_UOM

Order Sizing Factor UOM ORDER_SIZING_FACTOR_U
OM

Generic Ingredient Strength Units of 
Measure

GENERIC_INGREDIENT_ST
R_UOM

GENERIC_INGR_STRGTH_U
OM_CODES

Product Size Code Maintenance 
Agency

SIZE_CODE_LIST_AGENCY PRODUCT_SIZE_CODE_AGE
NCIES

Organic Claim Agency ORGANIC_CLAIM_AGENCY ORGANIC_CLAIM_AGENCY_
CODES

Size System SIZE_SYSTEM SIZE_SYSTEM_CODES

Size Group SIZE_GROUP SIZE_GROUP_CODES

Size Type SIZE_TYPE SIZE_TYPE_CODES

Composition Width UOM TRADE_ITEM_COMPOS_WID
TH_UOM

No Datasource.

Code values are of type 
enumeration, contained in 
the rulebase xml file.

Table 6   MDM Implementation of 1WorldSync Codelist

IM Attribute Repository Attribute MDM Datasource Name
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Packaging Material Code PKG_MATERIAL_CODE PACKAGING_MATERIAL_CO
DES

Material Code Agency MATERIAL_CODE_AGENCY PACKAGING_MATERIAL_CO
DES

Returnable Package Deposit Amount 
Currency

RETURN_PKG_DEPOSIT_AM
T_CURR

CURRENCY_CODES

Tax Amount Currency CURRENCY_CODE

List Price Currency PRICEUOMCODE

Retail Price On Trade Item Currency RETAIL_PRICE_ON_ITEM_
CURR

Security Tag Location SECURITY_TAG_LOCATION SECURITY_TAG_LOCATION
S

Security Tag Type SECURITY_TAG_TYPE SECURITY_TAG_TYPES

Packaging Marked Expiration Date 
Type

PKG_MARKED_EXPIRE_DAT
E_TYPE

No Datasource. 

Code values is of type 
enumeration, contained in 
the rulebase xml file.

Package Marks Diet Allergen PACKAGE_MARKS_DIET_AL
LERGEN

PACKAGE_MARKS_DIET_AL
LERGEN

Package Marks Free From PACKAGE_MARKS_FREE_FR
OM

PACKAGE_MARKS_FREE_FR
OM_LIST

Package Marks Ethical PACKAGE_MARKS_ETHICAL No Datasource.

Code values are of type 
enumeration, contained in 
the rulebase xml file.

Pallet Code PALLET_TYPE_CODE PALLET_TYPE_CODES

Pallet Terms and Conditions PALLET_HANDL_ONEWAY_R
EUSE

PALLET_TERMS_AND_COND
ITIONS

Import Classification Type IMPORT_CLASS_TYPE IMPORT_CLASSIFICATION
_TYPES

Table 6   MDM Implementation of 1WorldSync Codelist

IM Attribute Repository Attribute MDM Datasource Name
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Min Storage Humidity UOM STORAGE_HUMIDITY_MIN_
UOM

No Datasource.

Code values are of type 
enumeration, contained in 
the rulebase xml file.

Max Storage Humidity UOM STORAGE_HUMIDITY_MAX_
UOM

Min DC Delivery Temp UOM DELIVERY_DC_TEMP_UOM TEMP_CODES

Max DC Delivery Temp UOM

Min Market Delivery Temp UOM DELIVERY_MARKET_TEMP_
UOM

Max Market Delivery Temp UOM

Flash Point Temperature UOM FLASHPOINT_UNITS1

Storage/Handling Temp UOM STORAGE_HANDL_TEMP_MA
X_UOM

STORAGE_HANDL_TEMP_MI
N_UOM

Compliance Regulation Code CLASS_COMPLIANCE_REG_
CODE

CLASS_COMPLIANCE_REG_
CODES

Goods Pick Up Lead Time UOM GOODS_PICKUP_LEAD_TIM
E_UOM

No Datasource.

Code values are of type 
enumeration, contained in 
the rulebase xml file.

Price Comparison Content Type PRICE_COMP_CONTENT_TY
PE

PRICECOMPARISIONCONTE
NTTYPES

Price By Measure Type PRICE_BY_MEASURE_TYPE PRICE_BY_MEASURE_TYPE
S

Target Consumer Gender TARGET_CONSUMER_GENDE
R

No Datasource.

Code values are of type 
enumeration, contained in 
the rulebase xml file.

Season Parameter SEASON_PARAMETER SEASON_PARAMETERS

Table 6   MDM Implementation of 1WorldSync Codelist

IM Attribute Repository Attribute MDM Datasource Name
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Dangerous Goods Regulation Code HAZMAT_CLASSCODE1 DANGER_GOODS_REGULATI
ON_CODES

Color Code Maintenance Agency COLOR_CODE_AGENCY COLOR_CODE_AGENCIES_1
SYNC

Handling Instruction Code SPECIAL_HANDLING_CODE SPECIAL_HANDLING_CODE
S

Lead Time UOM LEADTIMEUOMCODE No Datasource.

Organic Trade Item Code ORGANIC_CODE ORGANIC_TRADE_ITEM_CO
DES

Packaging Terms And Condition PACKAGING_TERMS_CONDI
TIONS

PKG_TERMS_CONDITIONS_
CODES

Packaging Type Code PACKAGING_TYPE_CODE PACKAGING_TYPE_CODES

Primary Delivery Methods PRIMARY_DELIVERY_METH
OD

PRIMARY_DELIVERY_METH
OD_CODES

GTIN Variation Registry GTIN_VARIATION_REGIST
RY

No Datasource.

Code values are of type 
enumeration, contained in 
the rulebase xml file.

Table 6   MDM Implementation of 1WorldSync Codelist

IM Attribute Repository Attribute MDM Datasource Name
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Base Unit Indicator BASE_UNIT No Datasource.

Code values are of type 
enumeration, contained in 
the rulebase xml file.

Consumer Unit Indicator CONSUMER_UNIT

Dangerous Goods Indicator DANGEROUS_GOODS

Dispatch Unit Indicator DESPATCH_UNIT

Has Batch Number HAS_BATCH_NUMBER

Invoice Unit Indicator INVOICE_UNIT

Is Trade Item Reorderable IS_REORDERABLE

Is Size Based Pricing IS_TRADEITEM_SIZE_BAS
ED_PRIC

Net Content Declared NET_CONTENT_DEC_INDIC
ATED

Ordering Unit Indicator ORDERING_UNIT

Packaging Marked Returnable PACKAGE_MARKED_RETURN
ABLE

Pricing On Product PRICE_ON_PACKAGE

Pricing Item Indicator PRICING_ITEM

Is Private PRIVATE

Private Label PRIVATE_LABEL

Product Marked Recyclable PROD_MARKED_RECYCLABL
E

Right of Return for Non-Sold Trade 
Item

RIGHT_RETURN_NONSOLD_
TRADE

Variable Weight Trade Item VARIABLE_UNIT

Product Marked with Ingredients WITH_INGREDIENTS

Is Barcode Symbology Derivable ISBARCODEDERIVABLE

EANUCC Type EAN_UCC_TYPE EANUCCTYPE

Table 6   MDM Implementation of 1WorldSync Codelist

IM Attribute Repository Attribute MDM Datasource Name
 TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



52 | Chapter 4  Validations and Codelists
Volume UOM VOLUME_UOM VOLUMEUNIT

Net Content UOM NET_CONTENT_UOM NETCONTENTUNIT

Product Type UOM UNITDESCRIPTOR

Target Market TARGET_MARKET_ID COUNTRY

Alternate Item Identification 
Maintenance Agency

ALTERNATE_ITEMID_MNT_
AGENCY

ALTERNATEITEMIDMAINTA
INAGENCY

Special Item Code SPECIAL_ITEM_CODE SPECIALITEMCODE

Is Ingredient Irradiated INGREDIENT_IRRADIATED No Datasource.

Code values are of type 
enumeration, contained in 
the rulebase xml file.

Is Raw Material Irradiated RAW_MATERIAL_IRRADIAT
ED

Is Trade Item Irradiated IRRADIATED

Genetically Modified GENETICALLY_MODIFIED

Is Product Subject To A Manufacturer 
Take Back Program

TAKE_BACK_PROGRAM

Is Hazardous Component 
Brokendown Easily For Recycling

HAZARDOUS_COMP_REMOVA
BLE

Is Product Disassembly By Recycling 
Facility Completed Using Standard 
Tools

DESIGN_FOR_EASY_DISAS
SMBLY

Product RoHS Compliance Code IS_RIGID_PLASTIC_PACK
AGING

Table 6   MDM Implementation of 1WorldSync Codelist

IM Attribute Repository Attribute MDM Datasource Name
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Does Product Contain SCCPs CONTAINS_SCCP No Datasource.

Code values are of type 
enumeration, contained in 
the rulebase xml file.

Does Product Contain PVC CONTAINS_PVC

Can Product Be Easily Upgraded Or 
Maintained By Consumer

IS_UPGRADEABLE_OR_MAI
NTAIN

Is TradeItem Auto Powered Down 
Enabled When Shipped To Customer

POWER_DOWN_ENABLED

Is Product Chemical Not Intended For 
Human Consumption

CHEMICAL_FOR_HUMAN_CO
NSUME

Is Product A Pesticide CONTAINS_PESTICIDE

Is Product Aerosol CONTAINS_PROPELLANT

Is Product Considered Universal 
Waste

IS_UNIVERSAL_WASTE

Is Product RPPC Compliant In 
TargetMarket

IS_ROHS_COMPLIANT

Is TradeItem Packed Irregularly IS_ITEM_PACKED_IRREGU
LARLY

Has Display Ready Packaging HAS_DISPLAY_READY_PKG

Table 6   MDM Implementation of 1WorldSync Codelist

IM Attribute Repository Attribute MDM Datasource Name
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Chapter 5 Maintaining Validations and Codelists

This chapter provides details on updating codelists and adding validations.

Topics

• Updating Codelists, page 56

• Updating Validations, page 58
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Updating Codelists

Certain attribute values are from a list of values only, called the code list. Values 
not in the list are not accepted. In MDM, code lists are implemented using a 
rulebase and in most cases, populated using a predefined datasource created for 
the tibcocim/tadmin (enterprise/user) super user.

If datapool has released an update to the code list, first establish whether the code 
list was implemented using a datasource or enumeration.

Updating a Codelist Implemented Using Datasource
Follow these steps to update the code list in MDM:

1. Find the name of the datasource used for the code list. See MDM 
Implementation of 1WorldSync Codelist, page 45.

2. Create a CSV file of the updated codelist. 

3. Log in to the super user enterprise.

4. Click Item Data > Data Sources.

5. Modify the datasource as obtained in step 1.

6. Expand the Attribute tab on the Data Source Modify page. Ensure the 
attribute name in the datasource definition on the UI and the CSV file’s 
(created in step 2) header are the same.

7. Provide the CSV file created in step 2 to the File to Upload field.

8. Click Save and Upload.

9. Check the Event Log to ensure the event completes successfully, and all rows 
of the CSV file import successfully.

Updating a Codelist Implemented Using Enumeration
Follow these steps to update the code list in MDM:

1. Edit the 
$MQ_COMMON_DIR/standard/rulebase/_XX_mastercatalog_validation.x

ml file. Here XX is the name of datapool for which you want to update the code 
list.

2. Find the name of the MDM attribute for which the enumeration is defined.

3. In the validation file, search for the constraint with the attribute name. For 
example, to update the code list for MATERIAL_WEIGHT_UOM for 1WorldSync, 
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update following constraint in the _1sync_mastercatalog_validation.xml 
validation file.

<constraint>
 <name>Drop down for  MATERIAL_WEIGHT_UOM</name>
  <description>Valid value list for  MATERIAL_WEIGHT_UOM</description>
  <usefor>
   <var>MATERIAL_WEIGHT_UOM</var>
  </usefor>
  <action>
   <select novalue="default">
<enum header="yes" col="2">    
     <const type="string">UOM<sep/>Description</const>
<const type="string">ON<sep/>Ounces per square yard</const>
<const type="string">GM<sep/>Grams per square meter</const>
</enum>
   </select>
  </action>
 </constraint>

For more details on rulebase constraints, refer to the TIBCO MDM Studio Rulebase 
Designer guide.
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Updating Validations

To add a new validation, add a new constraint with the new attribute name in the 
relevant rulebase. 

Example

New Attribute to Add

Consider a new mandatory attribute Target Region to be added to 1WorldSync. 
And presume that TARGET_REGION is the attribute name added to both the 
1WorldSync catalog format and TIBCO format.

Files to Add Constraint to

The constraint should be added to both the files listed below, both in the 
$MQ_COMMON_DIR/standard/rulebase folder.

_1sync_mastercatalog_catalogvalidation.xml 
_1sync_catalogvalidation.xml

Constraint to Add

<constraint>
      <name>Mandatory validation for TARGET_REGION </name>
      <description>This attribute is mandatory.</description>
      <usefor>
         <var> TARGET_REGION </var>
      </usefor>
      <action>
         <check>
<explanation>This attribute is mandatory.</explanation>
            <defined>
               <var />
            </defined>
         </check>
      </action>

   </constraint>
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Chapter 6 Message Choreography

This chapter provides details on message choreography.

Topics

• Message Choreography, page 60

• MDM Message Choreography for 1WorldSync, page 61

• Changing Message Choreography, page 113

• Changing Message Choreography, page 113

• Configurable Components, page 115
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Message Choreography

Message choreography, in this context, refers to the information flow between a 
specific datapool (1WorldSync for instance) and the GS1 Global Registry. 

GDSN supports trading partners to use the (certified) datapool of their choice to 
synchronize data with other trading partners in GDSN. GDSN certified datapools 
helps in continued synchronization of data, and registered trading partners are 
assured of updated and accurate data in their systems. 

MDM currently supports 1WorldSync datapool. For MDM to work with this 
datapool, some specific changes are required. 

Validation takes place in 2 instances: on the record ID when entering the records 
and when synchronizing data. GS1 and 1WorldSync specify certain rules which 
must be followed to ensure that the quality of data received is correct. 
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MDM Message Choreography for 1WorldSync

1WorldSync Attribute Mapping

The following table lists how attributes in 1WorldSync map to attributes in MDM.

In the following table, "Sync Profile Attribute" refers to the 1WorldSync Output 
map attribute. Sync is the abbreviated form of Synchronization.

Table 7   1WorldSync Attribute Mapping

1WorldSync 
Attribute

MDM 
Data 
Type

Sync Profile 
Attribute 

Repository 
Attribute Xpath in 1WorldSync 

message

Global Trade 
Item Number

String GTIN GTIN os:envelope/catalogueR
equest/document/item/g
tin

Information 
Provider

String INFORMATION_PR
OVIDER

INFORMATION_PR
OVIDER_ID 

os:envelope/catalogueR
equest/document/item/i
nformationProviderGLN

Effective Date Date TDC_PRODUCTION
_DATE 

TDC_PRODUCTION
_DATE 

os:envelope/catalogueR
equest/document/item/e
ffectiveDate

GTIN Name String GTIN_NAME GTIN_NAME os:envelope/catalogueR
equest/document/item/g
lobalAttributes/gtinNa
me

NA String LANGUAGECODE DESCLANGUAGE "This is a common 
attribute, which is 
being used in many 
elements of the 
1WorldSync message, 
for example:

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
productDescription[@la
ng]; 
os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
shortDescription[@lang
]"
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Product Type String PRODUCT_TYPE UOM os:envelope/catalogueR
equest/document/item/g
lobalAttributes/produc
tType

Brand Name String BRAND_NAME ITEM_BRAND_NAM
E 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/brandN
ame

Brand Owner 
GLN

String OWNING_ORGANIZ
ATION_GLN

BRAND_OWNER_ID os:envelope/catalogueR
equest/document/item/g
lobalAttributes/brandO
wnerGLN

Net Content Decimal SIZE_METRIC NET_CONTENT_PR
IMARY 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/netCon
tent[@uom]

Net Content 
UOM

String SIZE_METRIC_UO
M

NET_CONTENT_UO
M 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/netCon
tent[@uom]

Alternate Item 
Classification 
Code

String GLOBAL_CLASSIF
ICATION_CODE

UDEXCODE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
alternateClassificatio
n/code

Packaging 
Type

String PACKAGING_TYPE PACKAGING_TYPE
_CODE 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/packag
ingInformation/packagi
ngTypeCode

Qty of Next 
Level Item(s)

String PACK UNITS_PER_CONT
AINER 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/totalQ
uantityOfNextLowerTrad
eItem

Packaging 
Information 
Height

Float PACKAGING_HEIG
HT

PACKAGING_HEIG
HT

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingInformation/h
eight

Table 7   1WorldSync Attribute Mapping

1WorldSync 
Attribute

MDM 
Data 
Type

Sync Profile 
Attribute 

Repository 
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Packaging 
Information 
Height UOM

Varchar PACKAGING_HEIG
HT_UOM

PACKAGING_HEIG
HT_UOM

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingInformation/h
eight

Packaging 
Information 
Depth

Float PACKAGING_DEPT
H

PACKAGING_DEPT
H

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingInformation/d
epth

Packaging 
Information 
Depth UOM

Varchar PACKAGING_DEPT
H_UOM

PACKAGING_DEPT
H_UOM

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingInformation/d
epth

Packaging 
Information 
Width

Float PACKAGING_WIDT
H

PACKAGING_WIDT
H

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingInformation/w
idth

Packaging 
Information 
Width UOM

Varchar PACKAGING_WIDT
H_UOM

PACKAGING_WIDT
H_UOM

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingInformation/w
idth

Inner Pack String INNER_PACK UNITS_PER_INNE
R_CONTAINER 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/innerP
ack

Product Form String PRODUCT_FORM FORM_DESCRIPTI
ON 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/Produc
tForm

Base Unit 
Indicator

Boolean BASE_UNIT_INDI
CATOR 

BASE_UNIT os:envelope/catalogueR
equest/document/item/g
lobalAttributes/isBase
Unit

Consumer 
Unit Indicator

Boolean IS_TRADE_ITEM_
CONSUMER_UNIT 

CONSUMER_UNIT os:envelope/catalogueR
equest/document/item/g
lobalAttributes/isCons
umerUnit
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Variable 
Weight Trade 
Item

Boolean VARIABLE_WEIGH
T_TRADE_ITEM 

VARIABLE_UNIT os:envelope/catalogueR
equest/document/item/g
lobalAttributes/isVari
ableWeightItem

Num of 
Complete 
Layers Cont in 
Item/GTIN 
Pallet Hi

Integer HI HI os:envelope/catalogueR
equest/document/item/g
lobalAttributes/hi

Num of Items 
in a Complete 
Layer/GTIN 
Pallet Ti

Integer TI TI os:envelope/catalogueR
equest/document/item/g
lobalAttributes/ti

Storage/Hand
ling Temp Max

Decimal STORAGE_HANDL_
TEMP_MAX 

STORAGE_HANDLI
NG_TEMP_MAX 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemTemperatureIn
formation/maximumTempe
rature

Storage/Hand
ling Temp 
UOM

String STORAGE_HANDL_
TEMP_MAX_UOM

STORAGE_HANDL_
TEMP_MAX_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
storageHandlingTempMax
[@uom]

Storage/Hand
ling Temp Min

Decimal STORAGE_HANDL_
TEMP_MIN 

STORAGE_HANDLI
NG_TEMP_MIN 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemTemperatureIn
formation/minimumTempe
rature

Storage/Hand
ling Temp 
UOM

String STORAGE_HANDL_
TEMP_MIN_UOM

STORAGE_HANDL_
TEMP_MIN_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
storageHandlingTempMin
[@uom]

Own 
Label/Private 
Label

Boolean OWN_LABEL_PRIV
ATE_LABEL 

PRIVATE_LABEL os:envelope/catalogueR
equest/document/item/g
lobalAttributes/brandD
istributionTradeItemTy
pe
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Number of 
Items/Pallet

Integer NUM_OF_ITEMS_P
ER_PALLET 

PALLET_QUANTIT
Y 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
numberOfItemsPerPallet

Target Market String TARGET_MARKET TARGET_MARKET_
ID 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
targetMarket

Target Market 
Description

String TARGET_MARKET_
DESC

TARGET_MARKET_
DESC 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
targetMarketName

NA String MARKET_GROUP MARKET_GROUP os:envelope/catalogueR
equest/document/public
ation/marketGroup

EANUCC 
Code

String EAN_UCC_CODE EAN_UCC_CODE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
gs1TradeItemIdentifica
tionKey/value

EANUCC 
Type

String EAN_UCC_TYPE EAN_UCC_TYPE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
gs1TradeItemIdentifica
tionKey/code

Manufacturer 
GLN

String MANUFACTURER_G
LN

null os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
manufacturer/gln

Sub Brand String SUB_BRAND ITEM_SUB_BRAND
_NAME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
subBrand

Functional 
Name

String PROD_NAME PRODUCTNAME os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
functionalName[@lang]
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Variant String VARIANT VARIANT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='variants']/row/att
rQualMany[@name='varia
nt]/value

Country of 
Origin

String COUNTRY_OF_ORI
GIN

COUNTRYOFORIGI
NCODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
countryOfOrigin/countr
yCode

Is Private Boolean IS_PRIVATE PRIVATE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
isPrivate

Primary 
Delivery 
Method

String PRIMARY_DELIVE
RY_METHOD

PRIMARY_DELIVE
RY_METHOD 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
distributionDetails/di
stributionMethodCode

Coupon 
Family Code

Integer COUPON_FAMILY_
CODE 

COUPON_FAMILY_
CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
couponFamilyCode

Has Batch 
Number

Boolean HAS_BATCH_NUMB
ER 

HAS_BATCH_NUMB
ER 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
hasBatchNumber

Net Content 
Declared

Boolean NET_CONTENT_DE
C_INDICATED 

NET_CONTENT_DE
C_INDICATED 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
isNetContentDeclaratio
n

Product 
Strength

Decimal PROD_STRENGTH PROD_STRENGTH os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonFoodIngredient/ingr
edientStrength/ingredi
entStrength
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Product 
Strength UOM

String PROD_STRENGTH_
UOM

PROD_STRENGTH_
UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
productStrength[@uom]

Product 
Strength Basis

Decimal PROD_STRENGTH_
BASIS 

PROD_STRENGTH_
BASIS 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonFoodIngredient/ingr
edientStrength/ingredi
entStrengthBasis

Product 
Strength Basis 
UOM

String PROD_STRENGTH_
BASIS_UOM

PROD_STRENGTH_
BASIS_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
productStrengthBasis[@
uom]

Product Size 
Code

String PROD_SIZE_CODE PROD_SIZE_CODE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
productSize/code

Product Size 
Code 
Maintenance 
Agency

String PROD_SIZE_CODE
_MAINT_AGENCY

SIZE_CODE_LIST
_AGENCY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
productSize/maintenanc
eAgency

Product 
Description

String PROD_DESC SHORTDESC os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
productDescription[@la
ng]; 
os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
shortDescription[@lang
]

Product Color 
Description

String PROD_COLOR_DES
C

PROD_COLOR_DES
C 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
color/description
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Min Product 
Lifespan from 
Arrival

Integer MIN_PROD_LIFE_
SPAN 

LIFESPAN_FROM_
ARRIVAL_MIN 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
minimumTradeItemLifesp
anFromArrival

Additional 
Description

String ADDITIONAL_DES
CRIPTION

ADDITIONAL_DES
CRIPTION 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
additionalDescription

Order Sizing 
Factor

String ORDER_SIZING_F
ACTOR

ORDER_SIZING_F
ACTOR 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
orderSizingFactor

Lead Time Integer LEAD_TIME LEADTIME os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
distributionDetails/or
deringLeadTime

Order 
Quantity 
Multiple

Integer ORDER_QUANTITY
_MULTIPLE 

ORDER_INCREMEN
T 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
orderQuantityMultiple

Min Order 
Quantity

Integer MIN_ORDER_QUAN
TITY 

MINIMUMORDER os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
minimumOrderQuantity

Max Order 
Quantity

Integer MAX_ORDER_QUAN
TITY 

MAXIMUMORDER os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
maximumOrderQuantity

Start 
Availability 
Date

Date START_AVAILABI
LITY_DATE 

START_AVAILABI
LITY_DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
startAvailabilityDate

End 
Availability 
Date

Date END_AVAILABILI
TY_DATE 

END_AVAILABILI
TY_DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
endAvailabilityDate
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First Ship Date Date FIRST_SHIP_DAT
E 

FIRST_SHIP_DAT
E 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
firstShipDate

Last Ship Date Date LAST_SHIP_DATE LAST_SHIP_DATE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
lastShipDate

Height Decimal HEIGHT PRODUCTHEIGHT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
height

Height UOM String HEIGHT_UOM HEIGHT_UOM os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
height[@uom]

Width Decimal WIDTH PRODUCTWIDTH os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
width

Width UOM String WIDTH_UOM WIDTH_UOM os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
width[@uom]

Depth Decimal DEPTH PRODUCTDEPTH os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
depth

Depth UOM String DEPTH_UOM DEPTH_UOM os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
depth[@uom]

Non GTIN 
Pallet Height

Decimal NGTIN_PL_HEIGH
T 

PACKAGEDHEIGHT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonGTINPalletHeight
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Non GTIN 
Pallet Height 
UOM

String NGTIN_PL_HEIGH
T_UOM

NGTIN_PL_HEIGH
T_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonGTINPalletHeight[@u
om]

Diameter Decimal DIAMETER DIAMETER os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
diameter

Diameter 
UOM

String DIAMETER_UOM DIAMETER_UOM os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
diameter[@uom]

Drained 
Weight

Decimal DRAINED_WEIGHT DRAINED_WEIGHT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
drainedWeight

Drained 
Weight UOM

String DRAINED_WEIGHT
_UOM

DRAINED_WEIGHT
_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
drainedWeight[@uom]

Gross Weight Decimal GROSS_WEIGHT GROSSWEIGHT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
grossWeight

Gross Weight 
UOM

String GROSS_WEIGHT_U
OM

GROSS_WEIGHT_U
OM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
grossWeight[@uom]

Non GTIN 
Pallet Gross 
Weight

Decimal NGTIN_PL_GR_WE
IGHT 

NGTIN_PL_GR_WE
IGHT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonGTINPalletGrossWeig
ht

Non GTIN 
Pallet Gross 
Weight UOM

String NGTIN_PL_GR_WE
IGHT_UOM

NGTIN_PL_GR_WE
IGHT_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonGTINPalletGrossWeig
ht[@uom]

Table 7   1WorldSync Attribute Mapping

1WorldSync 
Attribute

MDM 
Data 
Type

Sync Profile 
Attribute 

Repository 
Attribute Xpath in 1WorldSync 

message
TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



MDM Message Choreography for 1WorldSync | 71
Net Weight Decimal NET_WEIGHT NETWEIGHT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
netWeight

Net Weight 
UOM

String NET_WEIGHT_UOM NET_WEIGHT_UOM os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
netWeight[@uom]

Packaging 
Material 
Composition

String PACKAGING_WEIG
HT

PACKAGING_WEIG
HT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMaterial[@uom
]

Packaging 
Material 
Composition 
UOM

String PACKAGING_WEIG
HT_UOM

PACKAGING_WEIG
HT_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMaterial[@uom
]

Peg Horizontal Decimal PEG_HORIZONTAL PEG_HORIZONTAL os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
pegMeasurements/pegHor
izontal

Peg Horizontal 
UOM

String PEG_HORIZONTAL
_UOM

PEG_HORIZONTAL
_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
pegMeasurements/pegHor
izontal[@uom]

Peg Vertical Decimal PEG_VERTICAL PEG_VERTICAL os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
pegMeasurements/pegVer
tical

Peg Vertical 
UOM

String PEG_VERTICAL_U
OM

PEG_VERTICAL_U
OM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
pegMeasurements/pegVer
tical[@uom]
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Volume Decimal VOLUME VOLUME os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
volume

Volume UOM String VOLUME_UOM VOLUME_UOM os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
volume[@uom]

Percentage of 
Alcohol per 
Volume

Decimal PERCENT_ALCOHO
L_PER_VOL 

PERCENT_ALCOHO
L 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
percentageOfAlcoholPer
Volume

Packaging 
Material Code

String PACKAGING_MATE
RIAL_CODE

PKG_MATERIAL_C
ODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMaterial/pack
agingInformation/packa
gingMaterial/packaging
MaterialTypeCode

Product 
Marked with 
Ingredients

Boolean PROD_MARKEDWIT
H_INGREDIENTS 

WITH_INGREDIEN
TS 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
productMarkedWithIngre
dients

Product 
Marked 
Recyclable

Boolean PROD_MARKED_RE
CYCLABLE 

PROD_MARKED_RE
CYCLABLE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
productMarkedRecyclabl
e

Packaging 
Marked 
Returnable

Boolean PACKAGE_MARKED
_RETURNABLE 

PACKAGE_MARKED
_RETURNABLE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMarkedReturna
ble

Dispatch Unit 
Indicator

Boolean DISPATCH_UNIT_
INDICATOR 

DESPATCH_UNIT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
isDispatchUnit
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Invoice Unit 
Indicator

Boolean INVOICE_UNIT_I
NDICATOR 

INVOICE_UNIT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
isInvoiceUnit

Ordering Unit 
Indicator

Boolean ORDERING_UNIT_
INDICATOR 

ORDERING_UNIT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
isOrderableUnit

Handling 
Instruction 
Code

String PROD_HANDLING_
INSTRUCTION

SPECIAL_HANDLI
NG_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
handlingInstructions/h
andlingInstructionCode

Max Stacking 
Weight

Decimal MAX_ADM_STACKI
NG_WEIGHT 

STACKING_WEIGH
T_MAX 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemStacking/stac
kingWeightMaximum

Max Stacking 
Weight UOM

String MAX_ADM_STACKI
NG_WEIGHT_UOM

MAX_ADM_STACKI
NG_WEIGHT_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
maximumStackingWeight[
@uom]

Stacking 
Factor

Integer STACKING_FACTO
R 

STACKING_FACTO
R 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemStacking/stac
kingFactor

Pallet Code String PALLET_CODE PALLET_TYPE_CO
DE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingInformation/p
latformTypeCode

Pallet Terms 
and 
Conditions

String PALLET_HANDL_O
NEWAY_REUSE

PALLET_HANDL_O
NEWAY_REUSE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingInformation/p
latformTermsAndConditi
onsCode
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Dangerous 
Goods 
Hazardous 
Code

String HAZARD_CODE HAZMAT_CODE1 os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
hazardousMaterial/dang
erousGoods/transportat
ionClassification/regu
latedTransportationMod
e/hazardousInformation
Header/hazardousInform
ationDetail/dangerousG
oodsHazardousCode

Dangerous 
Goods Class 
Code

String HAZMAT_CLASS_C
ODE

HAZMAT_CLASSCO
DE1 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
hazardousMaterial/dang
erousGoods/transportat
ionClassification/regu
latedTransportationMod
e/hazardousInformation
Header/hazardousInform
ationDetail/classOfDan
gerousGoods

Dangerous 
Goods 
Regulation 
Code

String HAZARD_TYPE_CL
ASS_SYSTEM

HAZARD_TYPE_CL
ASS_SYSTEM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
hazardousMaterial/tran
sportationClassificati
on/regulatedTransporta
tionMode/hazardousInfo
rmationHeader/dangerou
sGoodsRegulationCode

U.N. 
Dangerous 
Goods 
Number

String DANGEROUS_GOOD
S_SUB_ID

DANGEROUS_GOOD
S_HAZARD_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
hazardousMaterial/dang
erousGoods/transportat
ionClassification/regu
latedTransportationMod
e/hazardousInformation
Header/hazardousInform
ationDetail/unitedNati
onsDangerousGoodsNumbe
r
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Dangerous 
Goods Packing 
Group

String DANGEROUS_GOOD
S_PACK_GROUP

DANGEROUS_GOOD
S_PACK_GROUP 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
hazardousMaterial/dang
erousGoods/transportat
ionClassification/regu
latedTransportationMod
e/hazardousInformation
Header/hazardousInform
ationDetail/dangerousG
oodsPackingGroup

Dangerous 
Goods 
Shipping 
Name

String DANGEROUS_GOOD
S_SHIP_NAME

DANGEROUS_GOOD
S_SHIP_NAME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
hazardousMaterial/dang
erousGoods/transportat
ionClassification/regu
latedTransportationMod
e/hazardousInformation
Header/hazardousInform
ationDetail/dangerousG
oodsShippingName

Dangerous 
Goods 
Technical 
Name

String DANGEROUS_GOOD
S_TECH_NAME

DANGEROUS_GOOD
S_TECH_NAME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
hazardousMaterial/dang
erousGoods/transportat
ionClassification/regu
latedTransportationMod
e/hazardousInformation
Header/hazardousInform
ationDetail/dangerousG
oodsTechnicalName

Flash Point 
Temperature

Decimal FLASHPOINT_TEM
P 

FLASHPOINT_TEM
P1 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
hazardousMaterial/tran
sportationClassificati
on/regulatedTransporta
tionMode/hazardousInfo
rmationHeader/flashPoi
ntTemperature
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Flash Point 
Temperature 
UOM

String FLASHPOINT_TEM
P_UOM

FLASHPOINT_UNI
TS1 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
transportationClassifi
cation/hazardousInform
ationHeader/flashPoint
Temperature

Hazmat 
Special 
Instructions

String HAZMAT_SPECIAL
_INSTRUCTIONS

HAZMAT_SPECIAL
_INSTRUCTIONS 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
hazardousMaterial/dang
erousGoods/specialInst
ructions

Trade Item 
Group Code

String TRADEITEM_GROU
P_CODE

TRADEITEM_GROU
P_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemGroupIdentifi
cation/tradeItemGroupI
dentificationCodeRefer
ence

Trade Item 
Group 
Description

String TRADEITEM_GROU
P_DESC

TRADEITEM_GROU
P_DESC 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemGroupIdentifi
cation/tradeItemGroupI
dentificationCodeDescr
iption

Pricing On 
Product

Boolean PRICING_ON_PRO
DUCT 

PRICE_ON_PACKA
GE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
pricingOnProduct

Material Safety 
Data Sheet 
Number

String MAT_SAFETY_DAT
ASHEET_NUM

MAT_SAFETY_DAT
ASHEET_NUM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
safetyDataSheetInforma
tion/sDSSheetNumber

Number of 
Layers Per 
Pallet/Non 
GTIN Pallet Hi

Integer N_GTIN_PALLET_
HI 

N_GTIN_PALLET_
HI 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonGTINPalletHi
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Number of 
Trade Items 
Per Pallet 
Layer/Non 
GTIN Pallet Ti

Integer N_GTIN_PALLET_
TI 

N_GTIN_PALLET_
TI 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonGTINPalletTi

Alternate Item 
Classification 
Scheme

String CLASSIFICATION
_SCHEME

CLASSIFICATION
SCHEME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
alternateClassificatio
n/scheme

Color String COLOR COLOR os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
color

Color Code 
Maintenance 
Agency

String COLOR_CODE_MNT
_AGENCY

COLOR_CODE_AGE
NCY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
color/agency

List Price Decimal LIST_PRICE LIST_PRICE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
cataloguePrice/price

List Price 
Currency

String LIST_PRICE_CUR
RENCY

PRICEUOMCODE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
cataloguePrice/price[@
currency]

List Price Basis 
Per Unit

Decimal LIST_PRICE_BAS
ISPERUNIT 

LIST_PRICE_BAS
IS_PER_UNIT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
cataloguePrice/basisPe
rUnit

List Price Basis 
Per Unit UOM

String LIST_PRICE_BAS
ISPERUNIT_UOM

LIST_PRICE_BAS
ISPERUNIT_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
cataloguePrice/basisPe
rUnit[@uom]
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Suggested 
Retail Price

Amount RECOMMEND_SALE
S_PRICE 

SUGGESTED_RETA
IL_PRICE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
suggestedRetail/price[
@currency]

Suggested 
Retail Price 
Currency

String RECOMMEND_PRIC
E_CURRENCY

RECOMMEND_PRIC
E_CURRENCY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
suggestedRetail/price[
@currency]

Suggested 
Retail Price 
Basis Per Unit

Decimal RECOMMEND_PRIC
E_PERUNIT 

RECOMMEND_PRIC
E_PERUNIT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
suggestedRetail/basisP
erUnit[@uom]

Suggested 
Retail Price 
Basis Per Unit 
UOM

String RECOMMEND_PRIC
E_PERUNIT_UOM

RECOMMEND_PRIC
E_PERUNIT_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
suggestedRetail/basisP
erUnit[@uom]

Right of 
Return for 
Non-Sold 
Trade Item

Boolean RIGHT_RETURN_N
SOLD_TRADE 

RIGHT_RETURN_N
SOLD_TRADE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
rightOfReturnForNonSol
dTradeItem

Tax Rate Decimal TAX_RATE TAX_RATE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
taxRate/rate

Tax (Rate) 
Type Code

String TAX_TYPE TAX_TYPE_CODE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
taxRate/typeCode

Alternate Item 
Number

String ALTERNATE_ITEM
_ID

ALTERNATE_ID os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
alternateItemIdentific
ation/id
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Alternate Item 
Identification 
Maintenance 
Agency

String ALTERNATE_ITEM
ID_MNT_AGENCY

ALTERNATE_ITEM
ID_MNT_AGENCY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
alternateItemIdentific
ation/agency

Replaced by 
GTIN

String REPLACED_ITEM_
GTIN

REPLACED_BY_GT
IN 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
referencedTradeItem/re
ferencedTradeItemGTIN/
referencedTradeItem/re
ferencedTradeItemTypeC
ode=REPLACED_BY

Organic Trade 
Item Code

String ORGANIC ORGANIC_CODE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
organic/organicClaim/o
rganicTradeItemCode

Degree of 
Original Wort

String DEGREE_OF_ORIG
INAL_WORT

DEGREE_OF_ORIG
INAL_WORT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
degreeOfOriginalWort

Fat Content 
UOM

String FAT_CONTENT_UO
M

FAT_CONTENT_UO
M 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
fatContent[@uom]

Fat Content 
Basis of 
Measure UOM

String FAT_CONTENT_BA
SIS_UOM

FAT_CONTENT_BA
SIS_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
fatContentBasisOfMeasu
re[@uom]

Units Per 
Consumer 
Unit

Integer UNITS_PER_CONS
UMER_UNIT 

UNITS_PER_CONS
UMER_UNIT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
unitsPerConsumerUnit

Total Units per 
Case

Integer TOTAL_UNITS_PE
R_CASE 

UNITS_PER_CASE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
totalUnitsPerCase
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Pricing Item 
Indicator

Boolean PRICING_ITEM_I
NDICATOR 

PRICING_ITEM os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
pricingItemIndicator

NA Date PUBLISH_DATE PUBLISH_DATE os:envelope/catalogueR
equest/document/public
ation/publishDate

First Order 
Date

Date FIRST_ORDER_DA
TE 

FIRST_ORDER_DA
TE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
firstOrderDate

Last Order 
Date

Date LAST_ORDER_DAT
E 

LAST_ORDER_DAT
E 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
lastOrderDate

Global 
Classification 
Code

String ALT_ITEM_CLASS
N_CODE

ADDITIONAL_CLA
SS_CAT_CODE 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/global
ClassificationCategory
/code

Pricing Pack Decimal PRICING_PACK PRICING_PACK os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
pricingPack

List Price 
Effective Start 
Date

Date LIST_PRICE_DAT
E_START 

LIST_PRICE_DAT
E_START 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
cataloguePrice/effecti
veStartDate

List Price 
Effective End 
Date

Date LIST_PRICE_DAT
E_END 

LIST_PRICE_DAT
E_END 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
cataloguePrice/effecti
veEndDate

Special Item 
Code

String SPECIAL_ITEM_C
ODE

SPECIAL_ITEM_C
ODE 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/market
ingInformation/special
ItemCode
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Feature Benefit String FEATURED_PRODU
CT_DESC

FEATURED_PRODU
CT_DESC 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemFeatureBenefi
t

Is Raw 
Material 
Irradiated

String RAW_MATERIAL_I
RRADIATED 

RAW_MATERIAL_I
RRADIATED 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
isRawMaterialIrradiate
d

Is Ingredient 
Irradiated

String INGREDIENT_IRR
ADIATED 

INGREDIENT_IRR
ADIATED 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
isIngredientIrradiated

Peg Hole 
Number

Integer PEG_HOLE_NUMBE
R 

PEG_HOLE_NUMBE
R 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
pegMeasurements/pegHol
eNumber

Barcode Type String BAR_CODE_TYPE BAR_CODE_TYPE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
dataCarrierTypeCode

Country of 
Assembly

String TRADE_ITEM_COU
NTRY_ASSEMBLY

TRADE_ITEM_COU
NTRY_ASSEMBLY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemCountryOfAsse
mbly

Variable Trade 
Item Type

String VARIABLE_TRADE
_ITEM_TYPE

VARIABLE_TRADE
_ITEM_TYPE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
variableTradeItemType

Campaign End 
Date

Date CAMPAIGN_END_D
ATE 

CAMPAIGN_END_D
ATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
campaignEndDate
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Campaign 
Name

String CAMPAIGN_NAME CAMPAIGN_NAME os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
productActivityDetails
/countryOfActivity/cou
ntryCode

Campaign 
Start Date

Date CAMPAIGN_START
_DATE 

CAMPAIGN_START
_DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
campaignStartDate

Marketing 
Message

String TRADE_ITEM_MAR
KETING_MESSAGE

TRADE_ITEM_MAR
KETING_MESSAGE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemMarketingMess
age

Season 
Calendar Year

Integer SEASON_CALENDA
R_YEAR 

SEASON_CALENDA
R_YEAR 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
season/seasonCalendarY
ear

Season Name String SEASON_NAME SEASON_NAME os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
season/seasonName

Season 
Parameter

String SEASON_PARAMET
ER

SEASON_PARAMET
ER 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
season/seasonParameter

Seasonal Start 
Date

Date SEASON_AVAIL_S
TART_DATE 

SEASON_AVAIL_S
TART_DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
season/seasonalAvailab
ilityStartDate

Seasonal End 
Date

Date SEASON_AVAIL_E
ND_DATE 

SEASON_AVAIL_E
ND_DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
season/seasonalAvailab
ilityEndDate
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Target 
Consumer Age

String TARGET_CONSUME
R_AGE

TARGET_CONSUME
R_AGE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
targetConsumerAge

Target 
Consumer 
Gender

String TARGET_CONSUME
R_GENDER

TARGET_CONSUME
R_GENDER 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
targetConsumerGender

Feature Benefit String TRADE_ITEM_FEA
TURE_BENEFIT

TRADE_ITEM_FEA
TURE_BENEFIT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemFeatureBenefi
t

Compliance 
Regulation 
Code

String CLASS_COMPLIAN
CE_REG_CODE

CLASS_COMPLIAN
CE_REG_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
regulatoryInformation/
regulationTypeCode

Import 
Classification 
Type

String IMPORT_CLASS_T
YPE

IMPORT_CLASS_T
YPE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
importIdentification/i
mportClassification/im
portClassificationType
Code

Import 
Classification 
Value

String IMPORT_CLASS_V
ALUE

IMPORT_CLASS_V
ALUE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
importClassification/i
mportClassificationVal
ue

Max DC 
Delivery Temp

Decimal DELIVERY_DC_TE
MP_MAX 

DELIVERY_DC_TE
MP_MAX 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemTemperatureIn
formation/maximumTempe
rature

Max DC 
Delivery Temp 
UOM

String DELIVERY_DC_TE
MP_UOM

DELIVERY_DC_TE
MP_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
deliveryToDCTemperatur
eMaximum[@uom]
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Max Market 
Delivery Temp

Decimal DELIVERY_MARKE
T_TEMP_MAX 

DELIVERY_MARKE
T_TEMP_MAX 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemTemperatureIn
formation/maximumTempe
rature

Max Market 
Delivery Temp 
UOM

String DELIVERY_MARKE
T_TEMP_UOM

DELIVERY_MARKE
T_TEMP_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
deliveryToMarketTemper
atureMaximum[@uom]

Max Storage 
Humidity

Decimal STORAGE_HUMIDI
TY_MAX 

STORAGE_HUMIDI
TY_MAX 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemHumidityInfor
mation/maximumHumidity
Percentage

Min DC 
Delivery Temp

Decimal DELIVERY_DC_TE
MP_MIN 

DELIVERY_DC_TE
MP_MIN 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemTemperatureIn
formation/minimumTempe
rature

Min Market 
Delivery Temp

Decimal DELIVERY_MARKE
T_TEMP_MIN 

DELIVERY_MARKE
T_TEMP_MIN 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemTemperatureIn
formation/minimumTempe
rature

Min Storage 
Humidity

Decimal STORAGE_HUMIDI
TY_MIN 

STORAGE_HUMIDI
TY_MIN 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemHumidityInfor
mation/minimumHumidity
Percentage

Product Range String PRODUCT_RANGE PRODUCT_RANGE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
productRange
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Inner Pack String QUANTITY_OF_IN
NER_PACK

QUANTITY_OF_IN
NER_PACK 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
innerPack

Composition 
Width

Decimal TRADE_ITEM_COM
POS_WIDTH 

TRADE_ITEM_COM
POS_WIDTH 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/tradeI
temCompositionWidth

Composition 
Width UOM

String TRADE_ITEM_COM
POS_WIDTH_UOM

TRADE_ITEM_COM
POS_WIDTH_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemCompositionWi
dth[@uom]

Descriptive 
Size Dim

String DESCRIPTIVE_SI
ZE_DIMENSION

DESCRIPTIVE_SI
ZE_DIMENSION 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonPackageDimensions/n
onPackageSizeDimension
/nonPackagedSizeDimens
ion/descriptiveSizeDim
ension

Material Code String MATERIAL_CODE MATERIAL_CODE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
materialComposition/te
xtileMaterial/textileM
aterialComposition/mat
erialCode

Material 
Content

String MATERIAL_CONTE
NT

MATERIAL_CONTE
NT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
materialComposition/ma
terialComposition/mate
rialContent

Material 
Percentage

Decimal MATERIAL_PERCE
NTAGE 

MATERIAL_PERCE
NTAGE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
materialComposition/te
xtileMaterial/textileM
aterialComposition/mat
erialPercentage
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Material 
Weight

Integer MATERIAL_WEIGH
T 

MATERIAL_WEIGH
T 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
textileMaterial/textil
eMaterialComposition/m
aterialWeight

Material 
Weight UOM

String MATERIAL_WEIGH
T_UOM

MATERIAL_WEIGH
T_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
materialWeight[@uom]

Organic Claim 
Agency

String ORGANIC_CLAIM_
AGENCY

ORGANIC_CLAIM_
AGENCY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
organic/organicClaim/o
rganicClaimAgencyCode

Size 
Dimension

Decimal SIZE_DIMENSION SIZE_DIMENSION os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonPackageDimensions/n
onPackageSizeDimension
/nonPackagedSizeDimens
ion/sizeDimension

Size 
Dimension 
UOM

String SIZE_DIMENSION
_UOM

SIZE_DIMENSION
_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonPackageDimensions/n
onPackageSizeDimension
/sizeDimension[@uom]

Size Group String SIZE_GROUP SIZE_GROUP os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonPackageDimensions/s
izeGroupCode

Size System String SIZE_SYSTEM SIZE_SYSTEM os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonPackageDimensions/n
onPackageSizeDimension
/sizeSystemCode
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Size Type String SIZE_TYPE SIZE_TYPE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonPackageDimensions/n
onPackageSizeDimension
/sizeTypeCode

Thread Count String THREAD_COUNT THREAD_COUNT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
textileMaterial/textil
eMaterialComposition/m
aterialThreadCount

Consumer 
Availability 
Date

Date CONSUMER_UNIT_
AVAIL_DATE 

CONSUMER_UNIT_
AVAIL_DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
consumerAvailabilityDa
teTime

End Date of 
Exclusivity

Date END_DATE_OF_EX
CLUSIVITY 

END_DATE_OF_EX
CLUSIVITY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
endDateTimeOfExclusivi
ty

End Date of 
Max Buying 
Qty

Date END_DATE_MAX_B
UYING 

END_DATE_MAX_B
UYING 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
endDateMaximumBuyingQu
antity

End Date of 
Min Buying 
Qty

Date END_DATE_MIN_B
UYING 

END_DATE_MIN_B
UYING 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
endDateMinimumBuyingQu
antity

First Delivery 
Date

Date FIRST_DELIVERY
_DATE_TIME 

FIRST_DELIVERY
_DATE_TIME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
firstDeliveryDateTime

Start Date of 
Max Buying 
Qty

Date START_DATE_MAX
_BUYING_QTY 

START_DATE_MAX
_BUYING_QTY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
startDateMaximumBuying
Quantity
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Start Date of 
Min Buying 
Qty

Date START_DATE_MIN
_BUYING_QTY 

START_DATE_MIN
_BUYING_QTY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
startDateMinimumBuying
Quantity

Deposit Value 
End Date

Date DEPOSIT_VAL_EN
D_DATE 

DEPOSIT_VAL_EN
D_DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMaterial/pack
agingInformation/packa
gedeposit/returnablePa
ckageDepositAmount

Deposit Value 
Start Date

Date DEPOSIT_VAL_EF
F_DATE 

DEPOSIT_VAL_EF
F_DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMaterial/pack
agingInformation/packa
gedeposit/depositValue
EffectiveDate

Offer On Pack String OFFER_ON_PACK OFFER_ON_PACK os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
offerOnPack

Package Marks 
Diet Allergen

String PACKAGE_MARKS_
DIET_ALLERGEN

PACKAGE_MARKS_
DIET_ALLERGEN 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packageMarksDietAllerg
en

Package Marks 
Environment

String PACKAGE_MARKS_
ENVIRONMENT

PACKAGE_MARKS_
ENVIRONMENT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMarkedLabelAc
creditationCode

Package Marks 
Ethical

String PACKAGE_MARKS_
ETHICAL

PACKAGE_MARKS_
ETHICAL 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMarkedLabelAc
creditationCode

Package Marks 
Free From

String PACKAGE_MARKS_
FREE_FROM

PACKAGE_MARKS_
FREE_FROM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packageMarksFreeFrom
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Packaging 
Marked 
Expiration 
Date Type

String PKG_MARKED_EXP
IRE_DATE_TYPE

PKG_MARKED_EXP
IRE_DATE_TYPE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingDate/tradeIte
mDateOnPackagingTypeCo
de

Packaging 
Marked 
Recyclable 
Scheme

String PKG_MARKED_REC
YCLE_SCHEME

PKG_MARKED_REC
YCLE_SCHEME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMarkedRecycla
bleScheme

Returnable 
Package 
Deposit 
Amount

Amount RETURNABLE_PKG
_DEPOSIT_AMT 

RETURNABLE_PKG
_DEPOSIT_AMT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMaterial/pack
agingInformation/packa
gedeposit/returnablePa
ckageDepositAmount

Returnable 
Package 
Deposit Code

String RETURNABLE_PKG
_DEPOSIT_CODE

RETURNABLE_PKG
_DEPOSIT_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMaterial/pack
agingInformation/packa
gedeposit/returnablePa
ckageDepositAmount

Security Tag 
Location

String SECURITY_TAG_L
OCATION

SECURITY_TAG_L
OCATION 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
securityTagInformation
/securityTagLocationCo
de

Security Tag 
Type

String SECURITY_TAG_T
YPE

SECURITY_TAG_T
YPE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
securityTagInformation
/securityTagTypeCode

Terms or 
Conditions 
Code

Varchar PACKAGING_TERM
S_CONDITIONS

PACKAGING_TERM
S_CONDITIONS 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMaterial/pack
agingInformation/packa
gingTermsAndConditions
Code
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Generic 
Ingredient

String GENERIC_INGRED
IENT

GENERIC_INGRED
IENT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonFoodIngredient/nonF
oodIngredientName

Generic 
Ingredient 
Strength

String GENERIC_INGRED
IENT_STRENGTH

GENERIC_INGRED
IENT_STRENGTH 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
nonFoodIngredient/ingr
edientStrength/ingredi
entStrength

Generic 
Ingredient 
Strength UOM

String GENERIC_INGRED
IENT_STR_UOM

GENERIC_INGRED
IENT_STR_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
genericIngredientStren
gth[@uom]

Goods Pick Up 
Lead Time

Decimal GOODS_PICKUP_L
EAD_TIME 

GOODS_PICKUP_L
EAD_TIME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
goodsPickUpLeadTime

Goods Pick Up 
Lead Time 
UOM

String GOODS_PICKUP_L
EAD_TIME_UOM

GOODS_PICKUP_L
EAD_TIME_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
goodsPickUpLeadTime[@u
om]

Invoice Name String INVOICE_NAME INVOICE_NAME os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
invoiceName

Is Size Based 
Pricing

Boolean IS_TRADEITEM_S
IZE_BASED_PRIC 

IS_TRADEITEM_S
IZE_BASED_PRIC 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
isTradeItemSizeBasedPr
icing

Is Trade Item 
Reorderable

Boolean IS_REORDERABLE IS_REORDERABLE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
isTradeItemReorderable
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Ordering 
UOM

String ORDERING_UOM ORDERING_UOM os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
orderingUnitOfMeasure

Selling UOM String SELLING_UOM SELLING_UOM os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
sellingUnitOfMeasure

Max Buying 
Quantity

Integer AGREED_MAX_BUY
ING_QUANTITY 

AGREED_MAX_BUY
ING_QUANTITY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
agreedMaximumBuyingQua
ntity

Min Buying 
Quantity

Integer AGREED_MIN_BUY
ING_QUANTITY 

AGREED_MIN_BUY
ING_QUANTITY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
agreedMinimumBuyingQua
ntity

Price By 
Measure Type

String PRICE_BY_MEASU
RE_TYPE

PRICE_BY_MEASU
RE_TYPE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
priceByMeasureType

Price 
Comparison 
Measurement

Decimal PRICE_COMP_MEA
SUREMENT 

PRICE_COMP_MEA
SUREMENT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
priceComparisonMeasure
ment

Price 
Comparison 
Measurement 
UOM

String PRICE_COMP_UOM PRICE_COMP_UOM os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
priceComparisonMeasure
ment[@uom]

Retail Price On 
Trade Item

Amount RETAIL_PRICE_O
N_ITEM 

RETAIL_PRICE_O
N_ITEM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
additionalTradeItemPri
ce/tradeItemPrice
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Price 
Comparison 
Content Type

String PRICE_COMP_CON
TENT_TYPE

PRICE_COMP_CON
TENT_TYPE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
priceComparisonContent
Type

Suggested 
Retail Price 
Effective End 
Date

Date EFFECTIVE_END_
DATE 

EFFECTIVE_END_
DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
suggestedRetail/effect
iveEndDate

Suggested 
Retail Price 
Effective Start 
Date

Date EFFECTIVE_STAR
T_DATE 

EFFECTIVE_STAR
T_DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
suggestedRetail/effect
iveStartDate

Tax Amount Amount TAX_AMOUNT TAX_AMOUNT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
taxAmount/dutyFeeTaxIn
formation/dutyFeeTax/d
utyFeeTaxAmount

Tax Amount 
Currency

String CURRENCY_CODE CURRENCY_CODE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
taxAmount/currency

Tax (Rate) 
Type Agency

String TAX_AGENCY_COD
E

TAX_AGENCY_COD
E 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
taxRate/agencyCode

Tax (Rate) 
Type 
Description

String TAX_TYPE_DESC TAX_TYPE_DESC os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
taxRate/typeDescriptio
n

Finish 
Description

String TRADE_ITEM_FIN
ISH_DESC

TRADE_ITEM_FIN
ISH_DESC 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
tradeItemFinishDescrip
tion
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Min Product 
Lifespan from 
Production

String MINLIFE_SPAN_F
ROM_PRODUCTION

MIN_LIFE_SPAN_
TIME_OF_PUB 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
minimumTradeItemLifesp
anFromProduction

Retail Price On 
Trade Item 
Currency

String RETAIL_PRICE_O
N_ITEM_CURR

RETAIL_PRICE_O
N_ITEM_CURR 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
retailPriceOnTradeItem
[@currency]

Returnable 
Package 
Deposit 
Currency

String RETURN_PKG_DEP
OSIT_AMT_CURR

RETURN_PKG_DEP
OSIT_AMT_CURR 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMaterial/retu
rnablePackageDepositAm
ount[@currency]

Tax (Amount) 
Type 
Description

String TAX_AMT_TAX_TY
PE_DESC

TAX_AMT_TAX_TY
PE_DESC 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
taxAmount/dutyFeeTaxIn
formation/dutyFeeTaxTy
peDescription

Tax (Amount) 
Type Agency

String TAX_AMT_TAX_AG
ENCY_CODE

TAX_AMT_TAX_AG
ENCY_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
taxAmount/dutyFeeTaxIn
formation/dutyFeeTaxAg
ency/AgencyCode

Tax (Amount) 
Type Code

String TAX_AMT_TAX_TY
PE_CODE

TAX_AMT_TAX_TY
PE_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
taxAmount/dutyFeeTaxIn
formation/dutyFeeTaxTy
peCode

Material 
Agency Code

String MATERIAL_AGENC
Y_CODE

MATERIAL_AGENC
Y_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
materialComposition/te
xtileMaterial/material
AgencyCode
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Is Barcode 
Symbology 
Derivable

Boolean ISBARCODEDERIV
ABLE 

ISBARCODEDERIV
ABLE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
gs1TradeItemIdentifica
tionKey/isBarcodeSymbo
logyDerivable

Lead Time 
UOM

String LEADTIMEUOM LEADTIMEUOMCOD
E 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
leadTime[@uom]

TM 
Subdivision

String TARGET_MARKET_
SUBDIVISION

TARGET_MARKET_
SUBDIVISION 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
targetMarketSubdivisio
nCode

Party 
Receiving 
Private Data

String PARTY_RECEIVIN
G_PRIVATE_DATA

PARTY_RECEIVIN
G_PRIVATE_DATA 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
partyReceivingPrivateD
ataGLN

GTIN 
Variation 
Registry

Boolean GTIN_VARIATION
_REGISTRY 

GTIN_VARIATION
_REGISTRY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
gtinVariationRegistry

Manufacturer 
Name

String MANUFACTURER_N
AME

MANUFACTURER_N
AME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
manufacturer/name

Green Dot 
Indicator

Boolean GREEN_DOT_INDI
CATOR 

PACKAGE_MARKED
_GREEN_DOT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
greenDotIndicator

Order Sizing 
Factor UOM

String ORDER_SIZING_F
ACTOR_UOM

ORDER_SIZING_F
ACTOR_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
orderSizingFactor[@uom
]
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GLN Of Ship 
From Party

String SHIP_LOCATION_
GLN

SHIP_LOCATION_
GLN 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/partyInRole/gln 
with partyRoleCode = 
SHIP_FROM

Name Of Ship 
From Party

String SHIP_LOCATION_
NAME

SHIP_LOCATION_
NAME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/partyInRole/name 
with partyRoleCode = 
SHIP_FROM

Uniform 
Resource 
Identifier

String URI URI os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='externalFileLink']
/row/attr[@name='unifo
rmResourceIdentifier']

Link File 
Name

String FILE_NAME_EXT FILE_NAME_EXT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='externalFileLink']
/row/attr[@name='exter
nalFileLinkFileName']

File Format 
Name

String FILE_FORMAT_NA
ME

FILE_FORMAT_NA
ME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='externalFileLink']
/row/attr[@name='fileF
ormatName']

File Effective 
Start Date

Date FILE_EFFECTIVE
_START_DATE 

FILE_EFFECTIVE
_START_DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='externalFileLink']
/row/attr[@name='fileE
ffectiveStartDateTime'
]
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File Effective 
End Date

Date FILE_EFFECTIVE
_END_DATE 

FILE_EFFECTIVE
_END_DATE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='externalFileLink']
/row/attr[@name='fileE
ffectiveEndDateTime']

Link Content 
Description

String CONTENT_DESC CONTENT_DESC os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany/row
/attrQualMany[@name='e
xternalFileLinkContent
Description']/value

File Format 
Description

String FILE_FORMAT_DE
SC

FILE_FORMAT_DE
SC 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany/row
/attrQualMany[@name='f
ileFormatDescription']
/value

Consumer 
Usage Storage 
Instructions

String STORAGE_INSTRU
CTION

STORAGE_INSTRU
CTION 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrQualMany[@nam
e='consumerUsageStorag
eInstructions']/value

Layer Height Decimal LAYER_HEIGHT LAYER_HEIGHT os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrQual[@name='l
ayerHeight']

Layer Height 
UOM

String LAYER_HEIGHT_U
OM

LAYER_HEIGHT_U
OM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrQual[@name='l
ayerHeight'][@qual]

Type Of 
Information

String TYPE_INFORMATI
ON

TYPE_INFORMATI
ON 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='externalFileLink']
/row/attr[@name='typeO
fInformation']
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Is Trade Item 
Packed 
Irregularly?

String IS_ITEM_PACKED
_IRREGULARLY

SHIP_LOCATION_
NAME 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/isTrad
eItemPackedIrregularly

Item 
Composition 
Depth

Decimal ITEM_COMPOSITI
ON_DEPTH 

ITEM_COMPOSITI
ON_DEPTH 

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/tradeI
temCompositionDepth

Item 
Composition 
Depth UOM

Varchar ITEM_COMPOSITI
ON_DEPTH_UOM

ITEM_COMPOSITI
ON_DEPTH_UOM

os:envelope/catalogueR
equest/document/item/g
lobalAttributes/tradeI
temCompositionDepth/@u
om

Package Marks 
Hygienic

String PKG_MARKED_HYG
IENIC

PKG_MARKED_HYG
IENIC 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/packagingMarkedLa
belAccreditationCode

Tax Rate 
Applicability 
Code

String TAX_RATE_APPLI
CABILITY_CODE

TAX_RATE_APPLI
CABILITY_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
taxRate/taxRateApplica
bilityCode

Tax Amount 
Applicability 
Code

String TAX_AMT_APPLIC
ABILITY_CODE

TAX_AMT_APPLIC
ABILITY_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
taxAmount/taxAmountApp
licabilityCode

Clamp 
Pressure

Decimal CLAMP_PRESSURE CLAMP_PRESSURE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrQual[@name='c
lampPressure']

Clamp 
Pressure UOM

String CLAMP_PRESSURE
_UOM

CLAMP_PRESSURE
_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrQual[@name='c
lampPressure'][@qual]
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Orientation 
Type

String ORIENTATION_TY
PE

ORIENTATION_TY
PE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='tradeItemOrientati
on']/row/attr[@name='o
rientationType']

Orientation 
Preference 
Sequence

Integer ORIENTATION_PR
EF_SEQ 

ORIENTATION_PR
EF_SEQ 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='tradeItemOrientati
on']/row/attr[@name='o
rientationPreferenceSe
quence']

Nesting 
Direction

String NESTING_DIRECT
ION

NESTING_DIRECT
ION 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/tradeItemNesting/
nestingTypeCode

Nesting Type String NESTING_TYPE NESTING_TYPE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/tradeItemNesting/
nestingDirectionCode

Has Display 
Ready 
Packaging?

String HAS_DISPLAY_RE
ADY_PKG

HAS_DISPLAY_RE
ADY_PKG 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attr[@name='hasDi
splayReadyPackaging']

Electrical 
Usage Trade 
Item 
Classification 
Agency

String ELEC_USAGE_CLA
SS_AGENCY

ELEC_USAGE_CLA
SS_AGENCY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/physicalResourceU
sageInformation/physic
alResourceUsageTradeIt
emClassification/physi
calResourceUsageClassi
ficationAgency
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Electrical 
Usage Trade 
Item 
Classification 
Name

String ELEC_USAGE_CLA
SS_NAME

ELEC_USAGE_CLA
SS_NAME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/physicalResourceU
sageInformation/physic
alResourceUsageTradeIt
emClassification/physi
calResourceUsageClassi
ficationName

Electrical 
Usage 
Subclassificati
on Name

String ELEC_USAGE_SUB
CLASS_NAME

ELEC_USAGE_SUB
CLASS_NAME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/physicalResourceU
sageInformation/physic
alResourceUsageTradeIt
emClassification/physi
calResourceUsageSubcla
ssificationAgency

Display 
Dimension 
Type Code

String DISPLAY_DIMENS
ION_CODE

DISPLAY_DIMENS
ION_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='displayDimensions'
]/row/attr[@name='disp
layDimensionTypeCode']

Dimension 
Depth

Integer DISPLAY_DIMENS
ION_DEPTH 

DISPLAY_DIMENS
ION_DEPTH 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='displayDimensions'
]/row/attrQual[@name='
dimensionDepth']

Dimension 
Depth UOM

String DISPLAY_DIMENS
ION_DEPTH_UOM

DISPLAY_DIMENS
ION_DEPTH_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='displayDimensions'
]/row/attrQual[@name='
dimensionDepth'][@qual
]
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Dimension 
Width

Integer DISPLAY_DIMENS
ION_WIDTH 

DISPLAY_DIMENS
ION_WIDTH 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='displayDimensions'
]/row/attrQual[@name='
dimensionWidth']

Dimension 
Width UOM

String DISPLAY_DIMENS
ION_WIDTH_UOM

DISPLAY_DIMENS
ION_WIDTH_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='displayDimensions'
]/row/attrQual[@name='
dimensionWidth'][@qual
]

Dimension 
Height

Integer DISPLAY_DIMENS
ION_HEIGHT 

DISPLAY_DIMENS
ION_HEIGHT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='displayDimensions'
]/row/attrQual[@name='
dimensionHeight']

Dimension 
Height UOM

String DISPLAY_DIMENS
ION_HEIGHT_UOM

DISPLAY_DIMENS
ION_HEIGHT_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='displayDimensions'
]/row/attrQual[@name='
dimensionHeight'][@qua
l]

Warranty 
Effective Date 
Type

String WARRANTY_EFF_D
ATE_TYPE

WARRANTY_EFF_D
ATE_TYPE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/warrantyInformati
on/warrantyEffectiveDa
teType

Warranty Type String WARANTY_TYPE WARANTY_TYPE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/warrantyInformati
on/warrantyType
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Warranty 
Constraint

String WARRANTY_CONST
RAINT

WARRANTY_CONST
RAINT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/warrantyInformati
on/warrantyConditions/
warrantyConstraint

Warranty 
Period

Integer WARRANTY_DURAT
ION 

WARRANTY_DURAT
ION 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/warrantyInformati
on/warrantyConditions/
warrantyDuration

Warranty 
Information 
Description

String WARRANTY_DESC WARRANTY_DESC os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/warrantyInformati
on/warrantyDescription

Is Product A 
Pesticide?

String CONTAINS_PESTI
CIDE

CONTAINS_PESTI
CIDE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/doesTradeItemCont
ainPesticide

Is Product 
Aerosol?

String CONTAINS_PROPE
LLANT

CONTAINS_PROPE
LLANT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attr[@name='isPro
ductAerosol']

Is Product 
Chemical Not 
Intended For 
Human 
Consumption?

String CHEMICAL_FOR_H
UMAN_CONSUME

CHEMICAL_FOR_H
UMAN_CONSUME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attr[@name='isPro
ductChemicalNotIntende
dForHumanConsumption']

Percentage Of 
Plastic 
Components 
Made From a 
Plant Based 
Material

Integer RENEWABLE_PLAS
TIC_PERCENT 

RENEWABLE_PLAS
TIC_PERCENT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/renewablePlantBas
edPlasticComponentsPer
cent
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Is Product 
Subject To A 
Manufacturer 
Take Back 
Program?

String TAKE_BACK_PROG
RAM

TAKE_BACK_PROG
RAM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/doesManufacturerH
aveTakeBackProgram

Manufacturer 
Take Back 
Program Fee

Integer TAKE_BACK_PROG
RAM_FEE 

TAKE_BACK_PROG
RAM_FEE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrQualMany[@nam
e='manufacturerTakeBac
kProgramFee']/value

Packaging 
Marked 
Recyclable 
Scheme

String PKG_MARKED_REC
YCLABLE

PKG_MARKED_REC
YCLABLE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
packagingMarkedRecycla
bleScheme

Trade Item 
Default Time 
Limit Of Auto 
Power Down 
Function Value

Date POWER_DOWN_DEF
_TIME 

POWER_DOWN_DEF
_TIME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attr[@name='trade
ItemDefaultTimeLimitOf
AutoPowerDownFunctionV
alue']

Trade Item 
Default Time 
Limit Of Auto 
Power Down 
Function UOM

String POWER_DOWN_DEF
_TIME_UOM

POWER_DOWN_DEF
_TIME_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attr[@name='trade
ItemDefaultTimeLimitOf
AutoPowerDownFunctionU
OM']

Electrical 
Usage Agency 
Code

String ELE_USAGE_AGEN
CY_CODE

ELE_USAGE_AGEN
CY_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrMany[@name='e
lectricalUsageAgencyCo
de']/value

Is Trade Item 
Auto Powered 
Down Enabled 
When Shipped 
To Customer

String POWER_DOWN_ENA
BLED

POWER_DOWN_ENA
BLED 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/isTradeItemAutoma
ticPowerDownEnabled

Table 7   1WorldSync Attribute Mapping

1WorldSync 
Attribute

MDM 
Data 
Type

Sync Profile 
Attribute 

Repository 
Attribute Xpath in 1WorldSync 

message
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Electrical 
Usage Class 
Code

String ELEC_USAGE_CLA
SS_CODE

ELEC_USAGE_CLA
SS_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/physicalResourceU
sageInformation/physic
alResourceUsageTradeIt
emClassification/physi
calResourceUsageClassi
ficationCode

Electrical 
Usage Sub 
Class Code

String ELEC_USAGE_SUB
CLASS_CODE

ELEC_USAGE_SUB
CLASS_CODE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/physicalResourceU
sageInformation/physic
alResourceUsageTradeIt
emClassification/physi
calResourceUsageSubcla
ssificationCode

Maximum 
Energy Usage 
Time Period

Decimal MAX_ENERGY_USA
GE 

MAX_ENERGY_USA
GE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/physicalResourceU
sageInformation/physic
alResourceUsage/physic
alResourceUsage

Maximum 
Energy Usage 
Time Period 
UOM

String MAX_ENERGY_USA
GE_UOM

MAX_ENERGY_USA
GE_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='electricalUsage']/
row/attrQual[@name='ma
ximumEnergyUsageTimePe
riod'][@qual]

Electrical 
Usage Class 
Screen Area 
Value

String TOTAL_SCREEN_A
REA

TOTAL_SCREEN_A
REA 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/totalScreenArea

Electrical 
Usage Class 
Screen Area 
UOM

String TOTAL_SCREEN_A
REA_UOM

TOTAL_SCREEN_A
REA_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrQualMany[@nam
e='electricalUsageClas
sScreenAreaValue']/val
ue[@qual]

Table 7   1WorldSync Attribute Mapping

1WorldSync 
Attribute

MDM 
Data 
Type

Sync Profile 
Attribute 

Repository 
Attribute Xpath in 1WorldSync 

message
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Electrical 
Usage Class 
Resolution 
Code

String DISPLAY_RESOLU
TION

DISPLAY_RESOLU
TION 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/displayResolution
Code

Electrical 
Usage Class 
Mode Code

String RUN_MODE RUN_MODE os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/physicalResourceU
sageInformation/physic
alResourceUsage/runMod
eCode

Manufacturer 
Take Back 
Program 
Currency

String TAKE_BACK_PROG
RAM_FEE_CURR 

TAKE_BACK_PROG
RAM_FEE_CURR 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrQualMany[@nam
e='manufacturerTakeBac
kProgramFee']/value[@q
ual]

Warranty 
Condition 
Effective Date 
Type

String WARRANTY_CON_E
FF_DATE_TYPE 

WARRANTY_CON_E
FF_DATE_TYPE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/warrantyInformati
on/warrantyEffectiveDa
teType

Warranty 
Period UOM

String WARRANTY_DURAT
ION_UOM 

WARRANTY_DURAT
ION_UOM 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrGroupMany[@na
me='warrantyConditionI
nfo']/row/attr[@name=w
arrantyPeriod']

Country of 
Last 
Provenance/P
rocessing

String COUNTRY_LAST_P
ROVENANCE 

COUNTRY_OF_LAS
T_PROCESSING 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/productActivityDe
tails/countryOfActivit
y/countryCode 
productActivityTypeCod
e=LAST_PROCESSING

Table 7   1WorldSync Attribute Mapping
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Trade Channel String TRADE_CHANNEL TRADE_CHANNEL os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attrMany[@name='t
radeChannel']/value

Is Hazardous 
Component 
Broken Down 
Easily For 
Recycling

String HAZARDOUS_COMP
_REMOVABLE 

HAZARDOUS_COMP
_REMOVABLE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/areHazardousCompo
nentsRemovable

Percent Of 
Product 
Components 
Labeled For 
Disassembly 
And Recycling

Decimal
 

DISASSEMBLY_RE
CYCLE_PERCENT 

DISASSEMBLY_RE
CYCLE_PERCENT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/componentsLabeled
ForDisassemblyRecyclin
gPercen

Is Product 
Disassembly 
By Recycling 
Facility 
Completed 
Using 
Standard Tools

String DESIGN_FOR_EAS
Y_DISASSMBLY 

DESIGN_FOR_EAS
Y_DISASSMBLY 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attr[@name='isPro
ductDisassemblyByRecyc
lingFacilityCompletedU
singStandardTools']

Is Product 
RPPC 
Compliant in 
Target Market

String IS_RIGID_PLAST
IC_PACKAGING 

IS_RIGID_PLAST
IC_PACKAGING 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/isTradeItemRigidP
lasticPackagingContain
er

Product RoHS 
Compliance 
Code

String IS_ROHS_COMPLI
ANT 

IS_ROHS_COMPLI
ANT 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/isTradeItemROHSCo
mpliant

Is Product 
Considered 
Universal 
Waste?

String IS_UNIVERSAL_W
ASTE 

IS_UNIVERSAL_W
ASTE 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/isTradeItemUniver
salWaste

Table 7   1WorldSync Attribute Mapping
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Can Product 
Be Easily 
Upgraded Or 
Maintained By 
Consumer

String IS_UPGRADEABLE
_OR_MAINTAIN 

IS_UPGRADEABLE
_OR_MAINTAIN 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/isTradeItemConsum
erUpgradeableOrMaintai
nable

Materials That 
Fail RoHS 
Compliance

String ROHS_COMPL_FAI
LURE_MATERIAL 

ROHS_COMPL_FAI
LURE_MATERIAL 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/rOHSComplianceFai
lureMaterial

Link File 
Name

String EXT_FILE_LINK_
FILE_NAME 

EXT_FILE_LINK_
FILE_NAME 

os:envelope/catalogueR
equest/document/item/t
argetMarketAttributes/
flex/attr[@name='exter
nalFileLinkFileName']

Table 7   1WorldSync Attribute Mapping

1WorldSync 
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MDM 
Data 
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Sync Profile 
Attribute 
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TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



MDM Message Choreography for 1WorldSync | 107
MDM Operations for 1WorldSync Messages
The following is a list of 1WorldSync messages and corresponding operations 
selected by MDM for these messages.

Supplier Operations

Table 8   MDM Operations for 1WorldSync Messages (Supplier Operations)

1WorldSync 
message type Operation selected on Synchronization Profile

Corresponding 
Operation and 
sub-operation 
selected in 
synchronization 
event

ITEM ADD Incremental Deliver To Operation Add: New

Yes Datapool Add

ITEM 
MODIFY/CO
RRECT

Incremental Deliver To Operation

Yes/No Datapool Data Correction/

Cancel/ 
Discontinue/ 
Reinstate

ADD:CORRECT

Beside this 
ADD:CANCEL, 
ADD:DISCONTI
NUE and 
ADD:REINSTAT
E are also 
handled with 
this message.

LINK ADD Incremental Deliver To Operation LINK:NONE

Yes /No Datapool Add/ Data 
Correction

LINK DELETE Incremental Deliver To Operation LINK:UNLINK

Yes/No Datapool Add/ Data 
Correction
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PUBLICATIO
N ADD

Incremental Deliver To Operation PUBLISH:NEW

PUBLISH:IMPLI
CIT

PUBLISH: 
RELOAD-COPY

PUBLISH: 
RELOAD-ORIGI
NAL

Yes /No Trading Partner 
on Datapool

Add/ Publish

SubOperation for 
Add/Publish:

New

SubOperations 
Only applicable to 
Publish operation: 

For 
RELOAD-COPY: 
Initial Load

For 
RELOAD-ORIGIN
AL- Initial Load+ 
Include Rejected 
Records

Table 8   MDM Operations for 1WorldSync Messages (Supplier Operations)

1WorldSync 
message type Operation selected on Synchronization Profile

Corresponding 
Operation and 
sub-operation 
selected in 
synchronization 
event
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Retailer Operations

Specifying Catalogue Item Confirmation Response
Follow these steps to specify the Catalogue Item Confirmation response in MDM.

1. Log in to the user’s enterprise with user credentials.

Table 9   MDM Operations for 1WorldSync Messages (Retailer Operations)

Message Type Incoming/
Outgoing Description

1WorldSync 
Catalogue Item 
Notification 
(CIN)

Incoming This new or initial or correction load message is received 
from Datapool when the supplier publishes the record for the 
retailer.

1WorldSync 
Catalogue Item 
Confirmation 
(CIC)

Outgoing Catalog Item Confirmation message of the Received, 
Rejected, Review, and Synchronize type sent by the retailer in 
receipt of the CIN message received.

For the steps to specify this message, refer Specifying 
Catalogue Item Confirmation Response.

1WorldSync 
Request For 
Catalogue Item 
Notification 
(RFCIN)

Outgoing The RFCIN message sent by the retailer with isReload set as 
true/false.

For the steps to specify this message, refer to Specifying 
Request For Catalogue Item Notification Message.

1WorldSync 
Catalogue Item 
Notification 
Response 
(CINR)

Outgoing This response message is sent by MDM in response to CIN.

1WorldSync 
Catalogue Item 
Confirmation 
Response

Incoming The Catalog Item Confirmation response (CICR) received 
from Datapool in response to CIC messages.

1WorldSync 
Request For 
Catalogue Item 
Notification 
Response

Incoming The Request For Catalog Item Notification Response 
(RFCINR) received from Datapool in response to RFCIN 
messages.
 TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



110 | Chapter 6  Message Choreography
2. Click Browse and Search.

3. Select a repository and click the View All Records link.

4. Select the record for which the CIC message is to be specified.

5. Select More Actions > Send Response.

6. Select the required Action.

— Review: Select the Confirmation Status Code and Corrective Action.

— Received: Select the Retailer Credential.

— Synchronised: Select the Retailer Credential.

— Rejected: Select the Confirmation Status Code and Corrective Action.

7. Click Submit.

Specifying Request For Catalogue Item Notification Message
Follow these steps to specify the Request For Catalogue Item Notification 
message in MDM.

1. Login to the user’s enterprise with user credentials.

2. Click Browse and Search.

3. Select a repository and click the View All Records link.

4. Select the record for which message is to be specified.

5. Select More Actions > Send Message.

6. Select the Action as RFCIN - Generate RFCIN Message.

7. Select the Datapool.

8. Select Trading Partner.

9. Click Submit.

Verify the Company Credential and Trading Partner Credential details.
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Correction Versus Modify
Based on GS1 Standards and Global Data Synchronization Network (GDSN) 
standards, changes to some attributes require a new GTIN (information regarding 
the GS1 Standards is available at www.gs1.org/gtinrules). For these attributes, 
MDM generates a Correct message. For changes to all other attributes, MDM 
generates a Modify message.

MDM sends Item correction for the following 1WorldSync attributes:

• Alternate Item Classification Code

• Alternate Item Classification Scheme

• Brand Name

• Brand Owner GLN

• Canceled Date

• Depth (if change > 20%)

• Depth UOM

• Discontinued Date

• EANUCC Code

• EANUCC Type

• Global Item Classification Code

• Gross Weight (if change > 20%)

• Gross Weight UOM

• Height (if change > 20%)

• Height UOM

• Net Content

• Net Content UOM

• Net Weight

• Net Weight UOM

• Product Type

• Qty of Next Level Item(s)

• Volume (if change > 20%)

• Volume UOM

• Width (if change > 20%)
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• Width UOM

Supported 1WorldSync Responses
MDM supports the following 1WorldSync responses:

• Catalogue Response
— ITEM MAINTENANCE CATALOGUE RESPONSE

— ITEM LINK CATALOGUE RESPONSE

— ITEM PUBLICATION CATALOGUE RESPONSE

— MESSAGE EXCEPTION RESPONSE

— 1SYNC GDSN ITEM REGISTRY RESPONSE

• Item Synchronization Response 

• Item Authorization Response 

• 1SYNC Catalogue Item Notification (1SYNC CIN) 

• 1SYNC Catalogue Item Notification Response (1SYNC CINR) 

• 1SYNC Catalogue Item Confirmation (1SYNC CIC) 

• 1SYNC Catalogue Item Confirmation Response (1SYNC CICR) 

• 1SYNC Request For Catalogue Item Notification (1SYNC RFCIN) 

• 1SYNC Request For Catalogue Item Notification Response (1SYNC RFCINR) 
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Changing Message Choreography

Follow these steps for MDM to work with specific datapools:

Update Rulebase to support New Message Type
For MDM to support a new message type, the first step is to update the 
rbformatattributes_gdsn.xml rulebase file so the new synchronization format 
is detected in the synchronization profile UI.

1. Update the 
$MQ_COMMON_DIR/standard/rulebase/rbformatattributes_gdsn.xml file.

Update Map file to support New Message Type
The next step is to update the map file to support the new message type.

1. Update the datapool specific map file from the 
$MQ_COMMON_DIR/standard/maps folder.

For more details on datapool specific map files for different message types, 
refer to GDSN-Specific Maps, page 199.

Update Sync Operation Identifier Rulebase
Next, update the datapool specific sync operation identifier rulebase to identify 
datapool specific sync operations.

1. Update the appropriate file in:
$MQ_COMMON_DIR/standard/rulebase.

— For 1WorldSync, the rulebase name is rbtransorasupplier.xml

Status Derivation
When a datapool receives a message from the MDM supplier or retailer 
applications, a response is sent to the appropriate application. Based on the 
response, MDM updates the status of the record. For example, if an "Item add" 
message is sent, the record is internally updated based on the response received 
from the datapool.

To update the status derivation, do the following:

1. To add or to update an operation from the UI on the supplier or retailer 
applications, change the constraints from the following file
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$MQ_COMMON_DIR/standard/rulebase/rbsyncstatusupdatederivation.x

ml.

2. To update from the UI, change the constraints in the 
$MQ_COMMON_DIR/standard/rulebase/rbsyncstatusupdatederivation.x

ml update statusderivation.xml file.

3. To update record status derivation on receiving a response from the datapool, 
change the constraints in the 
$MQ_COMMON_DIR/standard/rulebase/statusderivation.xml file.

Message Handler Selection
To change the message handler selection, properties similar to the following 
should be updated in $MQ_HOME/config/gdsn.config

com.tibco.cim.connector.plugin.mapping.handlemessaging.supplier.*1
sync*=com.tibco.cim.init.connector.plugin.handlemessaging.supplier
.1Sync

com.tibco.cim.init.connector.plugin.handlemessaging.supplier.1Sync
.class=com.tibco.mdm.gdsn.integration.connector.TransoraMessagingH
andler
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Configurable Components

Record Validation on UI
To enable record validation through the UI, depending on your datapool, copy 
the appropriate rulebase from the standard rulebase folder to your enterprise 
specific repository location:

File to copy
For 1WorldSync: _1sync_mastercatalog_catalogvalidation.xml

Copy from
$MQ_HOME/plugins/gdsn/<version>/common/standard/rulebase

Copy to
$MQ_COMMON_DIR/<ENTERPRISE_INTERNALNAME>/catalog/master/<REPOSITOR

YID> 

Rename it to 
catalogvalidation.xml. 

Synchronization Profile Validation
Out-of-the-box catalog synchronization is provided through datapool specific 
rulebase files which declare validation rules.

File to copy
For 1WorldSync: _1Sync_catalogvalidation.xml

Copy from
$MQ_HOME/plugins/gdsn/<version>/common/standard/rulebase

Copy to
$MQ_COMMON_DIR/standard/rulebase 

Rulebase for Protocol Selection
This rulebase decides the protocol to be used by the messaging handler for 
outgoing messages or the response handler for incoming messages. 
$MQ_COMMON_DIR/standard/rulebase/rbconnectorprotocolderivation_gds
n.xml
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Chapter 7 GDSN Impact on Workflows and Rulebase

This chapter describes the GDSN impact on workflows and rulebase in TIBCO 
MDM.

Topics

• GDSN Impact on Rulebase, page 118

• GDSN Impact on Workflows, page 119
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GDSN Impact on Rulebase

Modifying Business Process Rules
In the Rule List screen, click the repository name to modify the rule. Use this 
screen to modify the existing conditions, actions, and defaults used in workflow 
processing. If a backend system is part of the rule template, only Datapools 
associated with that backend system are displayed.

SyncOperationAttribute
This function is used to find the operation date. The function gets the latest sync 
date for the given Operation (only ADD is supported) from a Datapool or Trading 
Partner.

Syntax

<var>OPERATION_DATE</var>
<op func="SyncOperationAttribute">
<const type="string">ADD</const>
<const type="string">1Sync</const> 
<!--const type="string">Trading Partner Name</const-->
</op>

For this function, three parameters can be specified.

The second parameter is the marketplace or datapool name. This is optional; if not 
specified, the rulebase evaluates it.

The third parameter is the trading partner name and is optional. If not specified, it 
looks for all trading partners; if specified, it looks for the operation for the given 
trading partner.
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GDSN Impact on Workflows

GDSN Specific Workflows
The following table lists the various GDSN processes along with supported 
Document Type, Document Sub Type, Repository, and so on.

Table 10   GDSN Processes

Document 
Type

Document 
Sub Type Repository Sync 

Profile
Default 
Sender

Default 
Receiver

Org 
Type

Software 
Edition

Doc 
Format

Process 
Definition 
Name

Default 

Record 
Authorization 
Notification 

Any Any Any 1Sync Any Any Any Any wfout1sync6
2cic26v1.xml 
- 1sync CIC 
Process 

No

Record
Authorization 
Notification 

Any Any Any 1SyncTest Any Any Any Any wfout1sync6
2cic26v1.xml 
- 1sync CIC 
Process

No

Record
Publication
Notification 

Any Any Any 1Sync Any Any Any Any wfout1sync6
2cic26v1.xml 
- 1sync CIC 
Process 

No

Record
Publication
Request 

Any Any Any 1Sync Any Any Any Any wfout1sync6
2cic26v1.xml 
- 1sync CIC 
Process 

No

Record
Publication
Notification 

Any Any Any 1SyncTest Any Any Any Any wfout1sync6
2cic26v1.xml 
- 1sync CIC 
Process

No

Record
Publication
Request 

Any Any Any 1SyncTest Any Any Any Any wfout1sync6
2cic26v1.xml 
- 1sync CIC 
Process 

No

Request for 
CIN 
Notification 

Any Any Any 1SyncTest Any Any Any Any wfout1sync6
2cic26v1.xml 
- 1sync CIC 
Process 

No

Request for 
CIN 
Notification 

Any Any Any 1Sync Any Any Any Any wfout1sync6
2cic26v1.xml 
- 1sync CIC 
Process 

No

Any Any Any Any Any Any Any Any cim2cim 
docume
nt 

wfoutvelosel
cin26v2.xml 
- CIN 
Process for 
CIM2CIM 

No
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Request for 
CIN 
Notification

Any Any Any Any Any Any Any Any wfin26rfcinv
2.xml - 
Receive 
RFCIN 
Process 

No

RFCIN 
Notification

Any Any Any Any Any Any Any Any wfin26catact
ionRFCINv2
.xml - RFCIN 
Retailer 
Process

No

Record
Publication
Notification

Publication 
Delivery 
Notification 

Any Any Any Any Any Any Any wfin26prodn
otifv2.xml - 
Response 
Notification 
process 

No

Record
Publication
Notification

Any Any Any Any Any Any Any Any wfin26prodn
otifretailerv4
.xml - 
Record 
Notification 
process

No

Record
Content
Notification

Datapool 
Response 
Notification 

Any Any Any Any Any Any Any wfin26prodn
otifv2.xml - 
Response 
Notification 
process

No

Record
Content
Notification

Registry 
Response 
Notification

Any Any Any Any Any Any Any wfin26prodn
otifv2.xml - 
Response 
Notification 
process

No

Record
Content
Notification

Internal 
Error 
Notification

Any Any Any Any Any Any Any wfin26prodn
otifv2.xml - 
Response 
Notification 
process

No

Record
Content
Notification

Record Add 
Notification

Any Any Any Any Retailer Any Any wfin26prodn
otifretailerv4
.xml - 
Record 
Notification 
process

No

Record
Content
Notification

Data 
Change 

Any Any Any Any Retailer Any Any wfin26prodn
otifretailerv4
.xml - 
Record 
Notification 
process

No

Table 10   GDSN Processes

Document 
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Record
Content
Notification

Delete Any Any Any Any Retailer Any Any wfin26prodn
otifretailerv4
.xml - 
Record 
Notification 
process

No

Record
Content
Notification

Discontinue Any Any Any Any Retailer Any Any wfin26prodn
otifretailerv4
.xml - 
Record 
Notification 
process

No

Record
Content
Notification

Cancel Any Any Any Any Retailer Any Any wfin26prodn
otifretailerv4
.xml - 
Record 
Notification 
process

No

Record
Content
Notification

Data 
Correction

Any Any Any Any Retailer Any Any wfin26prodn
otifretailerv4
.xml - 
Record 
Notification 
process

No

Record
Content
Notification

Record Add 
Notification

Any Any Any Any Any Any Any wfin26prodn
otifprocessv
2.xml - 
Record data 
notification 
Process

No

Record
Content
Notification

Data 
Change

Any Any Any Any Any Any Any wfin26prodn
otifprocessv
2.xml - 
Record data 
notification 
Process

No

Record
Content
Notification

Data 
Correction

Any Any Any Any Any Any Any wfin26prodn
otifprocessv
2.xml - 
Record data 
notification 
Process

No

Record
Content
Notification

Delete Any Any Any Any Any Any Any wfin26prodn
otifprocessv
2.xml - 
Record data 
notification 
Process

No
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Record
Content
Notification

Cancel Any Any Any Any Any Any Any wfin26prodn
otifprocessv
2.xml - 
Record data 
notification 
Process 

No

Record
Content
Notification

Discontinue Any Any Any Any Any Any Any wfin26prodn
otifprocessv
2.xml - 
Record data 
notification 
Process

No

Record
Authorization
Notification

Any Any Any Any Any Any Any Any wfin26prodn
otifbasicv3.x
ml - 
Incoming 
Message 
processing 
Process

No

Purge 
Historical 
Data

Any Any Any Any Any Any Any Any wfin26purge
v3.xml - 
Purge 
process

No

Any Any Any Any Any Any Any Any Any wfoutagentri
cs50cin26v2.
xml - 
Agentrics 
CIN Process

No

Any Any Any Any 1SyncTest Any Retailer Any 1Sync 
docume
nt

wfout1sync6
5cin26v1.xml 
- 1Sync CIN 
process 

No

Any Any Any Any 1Sync Any Retailer Any 1Sync 
docume
nt

wfout1sync6
5cin26v1.xml 
- 1Sync CIN 
process 

No

Any Any Any Any 1SyncTest Any Any Any Any wfout1sync6
2cic26v1.xml 
- 1sync CIC 
Process

No

Any Any Any Any 1Sync Any Any Any Any wfout1sync6
2cic26v1.xml 
- 1sync CIC 
Process 

No

Table 10   GDSN Processes

Document 
Type

Document 
Sub Type Repository Sync 

Profile
Default 
Sender

Default 
Receiver

Org 
Type

Software 
Edition

Doc 
Format

Process 
Definition 
Name

Default 
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Chapter 8 Setting up CIM to CIM

This chapter provides information on connecting two MDM applications. It 
describes the full setup for testing the CIM to CIM Synchronization capability.

Topics

• Overview, page 124

• Step 1 - Queue Configuration, page 126

• Step 2 - Enterprise Creation and Data Prepopulation, page 129

• Step 3 - Database Changes, page 136

• Step 4 - Company Profile and GLN Creation, page 138

• Step 5 - Trading Partner Profile Creation, page 141

• Step 6 - Rulebase Changes, page 143

• Step 7- Datasource and Input Map creation for BrandOwner, page 145

• Step 8 (Optional) - Processing Reverse Relationships, page 148

• Step 9 - Testing your CIM to CIM Setup, page 151

• Troubleshooting CIM to CIM, page 152
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Overview

This document guides an Administrator through all the steps required to connect 
and synchronize two MDM environments. 

Need for Synchronization
TIBCO MDM supports organizations to communicate with trading partners 
through datapools. For example, a supplier can do business with a trading 
partner through a datapool like 1WorldSync. 

However, an organization may sometimes want to communicate privately with 
its trading partners without a third party datapool. Also, companies in different 
locations may need to internally synchronize data in their systems, involving 
datapools. 

In such cases, organizations can deploy instances of CIM per location and 
synchronize as required. To do this, TIBCO provides an out-of-the-box 
functionality to connect and sync two or more CIM instances. Instances from 
different entities can communicate with each other directly, without involving a 
third party datapool.

Types of Synchronization
Synchronization can occur between any of the two types: 

• Two or more enterprises on a single TIBCO MDM instance

• Two different TIBCO MDM instances

How it Works
This chapter walks you through a process in which four different enterprises are 
created on a single CIM instance.

— BrandOwner, VeloselMarketPlace, Bottler1, and Bottler2 are four 
enterprises created.

— BrandOwner is the main enterprise of type Supplier. The BrandOwner 
subscribes to the VeloselMarketplace enterprise (to which it synchronizes 
all updates). It has Bottler1 and Bottler2 as trading partners.

— VeloselMarketplace is an enterprise of type Marketplace. Consider this as 
the central location to which data is synchronized and from where updates 
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are received (by the subscribed suppliers). It has BrandOwner, Bottler1 
and Bottler2 as trading partners.

— Bottler1 and Bottler2 are enterprises of type Supplier. They are both 
subscribed to the VeloselMarketplace enterprise (to receive BrandOwner’s 
updates) and have BrandOwner as a trading partner.

In the above scenario, whenever Brandowner has information to synchronize, for 
example a record, it is synchronized to VeloselMarketplace, from where Bottler1 
and Bottler2 receive the update (record) because of their subscription.

Steps to Sync CIM Instances
The following steps are involved in synchronizing two CIM instances. Each step 
is explained in detail in the following sections.

1. Step 1 - Queue Configuration
Make the required queue configuration changes.

2. Step 2 - Enterprise Creation and Data Prepopulation
Run the required database scripts.

3. Step 2 - Enterprise Creation and Data Prepopulation, page 129
Run the application server. Create three or more enterprises. Populate the 
enterprises with data by running XML packs.

4. Step 4 - Company Profile and GLN Creation
Create company profiles and GLN credentials for each enterprise.

5. Step 5 - Trading Partner Profile Creation
Define trading partners for each enterprise and input GLNs.

6. Step 6 - Rulebase Changes
Make the required rulebase changes.

7. Step 7- Datasource and Input Map creation for BrandOwner
Create Datasource and InputMap for BrandOwner enterprise.

8. Step 8 (Optional) - Processing Reverse Relationships, page 148
Only required if you need reverse relationships processed.

9. Step 9 - Testing your CIM to CIM Setup
Test your setup.

You can synchronize by creating a special enterprise of type 'Marketplace' with 
the name as VeloselMarketplace. The name of the enterprise has to be 
VeloselMarketplace for the application to work as provided out-of-the-box.
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Step 1 - Queue Configuration

Queue Setup for CIM to CIM Integration Messages
For communication between two enterprises, you need gateways to transport 
messages across two firewalls and from the 
Q_ECM_INTGR_STD_OUTBOUND_INTGR_MSG queue of the sender instance to 
Q_ECM_INTGR_STD_INBOUND_INTGR_MSG queue of the receiver instance. These 
gateways cannot be used for testing, but a simple trick can be used to simulate it. 

Because the messaging framework helps in mapping the logical and physical 
queue names and supports connectivity to multiple JMS servers from the same 
instance, you can use the Q_ECM_INTGR_STD_INBOUND_INTGR_MSG physical 
queue hosted on one of the JMS servers (the one connected to 
VeloselMarketplace) and map it to:

— the StandardOutboundIntgrMsg logical queue used to send outbound 
integration messages from the BrandOwner instance.

— the StandardInboundIntgrMsg logical queue used to receive inbound 
integration messages in the VeloselMarketplace instance. 

Changes to ConfigValues.xml for TIBCO EMS
The following changes need to be done in ConfigValues.xml. To connect to two 
different queue managers, BrandOwner will need two different clusters. 

If BrandOwner uses TIBCO EMS, add the following lines to ConfigValues.xml 
after the TIBCO Messaging Cluster section. 

Change 1

Search for <Category name="TIBCO EMS" visibility="Advanced">.
Add the following lines:

<!- V2V ENTRIES ->

<ConfValue description="com.tibco.cim.queue.cluster.TIBCOCluster2 - added for 
v2v" name="com.tibco.cim.queue.cluster.TIBCOCluster2" 
propname="com.tibco.cim.queue.cluster.TIBCOCluster2" readonly="false" 
sinceVersion="7.1" visibility="Basic">

  <ConfString default="inherit:com.tibco.cim.queue.cluster.DefCluster" 
value="inherit:com.tibco.cim.queue.cluster.DefCluster"/>

If you are in the process of synchronizing 1WorldSync datapool, do not follow the 
steps listed here for queue setup; instead use the out-of-the-box queue 
configuration.
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</ConfValue>

<ConfValue 
description="com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.class 
- added for v2v" 
name="com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.class" 
propname="com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.class" 
readonly="false" sinceVersion="7.1" visibility="Basic">

  <ConfString default = 
"com.tibco.mdm.integration.messaging.queue.tibco.TIBCOClusterLiaison" 
value = 
"com.tibco.mdm.integration.messaging.queue.tibco.TIBCOClusterLiaison"/>

</ConfValue>

<ConfValue description = "com.tibco.cim.queue.cluster.TIBCOCluster2.defUser - 
added for v2v" name = "com.tibco.cim.queue.cluster.TIBCOCluster2.defUser" 
propname = "com.tibco.cim.queue.cluster.TIBCOCluster2.defUser" readonly = 
"false" sinceVersion = "7.1" visibility = "Basic">

  <ConfString default = "admin" value = "admin"/>

</ConfValue>

<ConfValue description = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.defPassword - added for v2v" name 
= "com.tibco.cim.queue.cluster.TIBCOCluster2.defPassword" propname = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.defPassword" readonly = "false" 
sinceVersion = "7.1" visibility = "Basic">

  <ConfString default = "" value = ""/>

</ConfValue>

<ConfValue description = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.defClientID - added for v2v" name 
= "com.tibco.cim.queue.cluster.TIBCOCluster2.defClientID" propname = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.defClientID" readonly = "false" 
sinceVersion = "7.1" visibility = "Basic">

  <ConfString default = "null" value = "null"/>

</ConfValue>

<ConfValue description = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clusteredServers" 
name = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clusteredServers" 
propname = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clusteredServers" 
readonly = "false" sinceVersion = "7.1" visibility = "Basic">

  <ConfString default = "LocalhostServer" value = "LocalhostServer"/>

</ConfValue>

<ConfValue description = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clusteredServer.Lo
calhostServer" name = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clusteredServer.Lo
calhostServer" propname = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clusteredServer.Lo
calhostServer" readonly = "false" sinceVersion = "7.1" visibility = "Basic">

  <ConfString default = "tcp://localhost:7222" value = 
"tcp://localhost:7222"/>

</ConfValue>

<ConfValue description = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clusteredServer.en
coding.LocalhostServer - added for v2v" name = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clusteredServer.en
coding.LocalhostServer" propname = 
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clusteredServer.en
coding.LocalhostServer" readonly = "false" sinceVersion = "7.1" visibility = 
"Basic">

  <ConfString default = "UTF-8" value = "UTF-8"/>

</ConfValue>
 TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



128 | Chapter 8  Setting up CIM to CIM
<ConfValue description = 
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster - added for v2v" 
name = "com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster" propname 
= "com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster" readonly = 
"false" sinceVersion = "7.1" visibility = "Basic">

  <ConfString default = "TIBCOCluster2" value = "TIBCOCluster2"/>

</ConfValue>

<ConfValue description = 
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.addToJNDI - added for 
v2v" name = "com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.addToJNDI" 
propname = "com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.addToJNDI" 
readonly = "false" sinceVersion = "7.1" visibility = "Basic">

  <ConfBool default = "false" value = "false"/>

</ConfValue>

<ConfValue description = 
"com.tibco.cim.queue.queue.StandardInboundIntgrMsg.cluster - added for v2v" 
name = "com.tibco.cim.queue.queue.StandardInboundIntgrMsg.cluster" propname = 
"com.tibco.cim.queue.queue.StandardInboundIntgrMsg.cluster" readonly = 
"false" sinceVersion = "7.1" visibility = "Basic">

  <ConfString default = "TIBCOCluster2" value = "TIBCOCluster2"/>

</ConfValue>

Change 2

Search for <Category name="StandardOutboundIntgrMsg" 
visibility="Advanced">. Add the following lines:

<!- V2V ENTRIES ->

<ConfValue description = "" isHotDeployable = "false" name = "EMS Queue Name" 
propname = 
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster.TIBCOCluster2.qu
eue" sinceVersion = "7.0" visibility = "Advanced">

  <ConfString default = "Q_ECM_INTGR_STD_OUTBOUND_INTGR_MSG" value = 
"Q_ECM_INTGR_STD_OUTBOUND_INTGR_MSG"/>

</ConfValue>

Change 3

Search for <Category name="StandardInboundIntgrMsg" 
visibility="Advanced">. Add the following lines:

<!- V2V ENTRIES ->

 <ConfValue description="" isHotDeployable="false" name="EMS Queue Name" 
propname="com.tibco.cim.queue.queue.StandardInboundIntgrMsg.clust er.TIBCOC
luster2.queue" sinceVersion="7.0" visibility="Advanced">

  <ConfString default="Q_ECM_INTGR_STD_ OUTBOUND _INTGR_MSG" 
value="Q_ECM_INTGR_STD_ OUTBOUND_INTGR_MSG"/>

</ConfValue>
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Step 2 - Enterprise Creation and Data Prepopulation

Create four or more enterprises:

BrandOwner Enterprise Creation
Set up the BrandOwner enterprise as follows:

1. Create a BrandOwner Enterprise of type Supplier with Internal Name as 
bowner.

2. Create a user admin with first name admin and last name admin. Assign the 
Work Supervisor and Admin roles to this user.

Ensure that the Application Server is running.

Enterprise Type

BrandOwner
See BrandOwner Enterprise Creation, page 129.

Supplier

VeloselMarketplace
See VeloselMarketplace Enterprise Creation, page 130.

Marketplace

Bottler1
See Bottler1 Enterprise Creation, page 131.

Supplier

Bottler2 
See Bottler2 Enterprise Creation, page 132.

Supplier

Attribute Value

Enterprise BrandOwner

Enterprise Type Supplier

Internal Name bowner

Attribute Value

User Name admin

First/Middle/Last admin//admin
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Import XML Pack for BrandOwner Enterprise

Import an XML pack to prepopulate the enterprise with some data.

1. Log in to the BrandOwner enterprise.

2. Select System Operations > Import Meta Data.

3. Provide the path to the following xml file:
$MQ_COMMON_DIR/common/standard/samples/cim2cimmetadata/Brandown

er/BrandOwner-MetaData.jar.

To see what data is generated by importing this XML pack, see Data generated 
through XML Pack Import, page 133.

VeloselMarketplace Enterprise Creation

1. Create an Enterprise VeloselMarketplace of type Marketplace with Internal 
Name as Veloselm.

Roles Work Supervisor/Admin

Attribute Value

This is just for subscription purposes. The real Velosel Marketplace Enterprise 
resides on Instance 2.

Attribute Value

Enterprise VeloselMarketplace
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2. Create a user admin with first name admin and last name user. 
Assign the Work Supervisor and Admin roles to this user.

Import XML Pack for VeloselMarketplace Enterprise

Import an XML pack to prepopulate the enterprise with some data.

1. Log in to the VeloselMarketplace enterprise.

2. Select System Operations > Import Meta Data.

3. Provide the path to the following xml file:
$MQ_COMMON_DIR/standard/samples/cim2cimmetadata/VeloselMarketpl

ace/VeloselMarketplace-MetaData.jar

To see what data is generated by importing this XML pack, see Data generated 
through XML Pack Import, page 133.

Bottler1 Enterprise Creation
1. Create an Enterprise Bottler1 of type Supplier with Internal Name as 

Bottler1.

Enterprise Type Marketplace

Internal Name Veloselm

Attribute Value

User Name admin

First/Middle/Last admin//admin

Roles Work Supervisor/Admin

Attribute Value

Attribute Value

Enterprise Bottler1

Enterprise Type Supplier

Internal Name Bottler1
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2. Create a user admin with first name admin and last name user. Assign the 
Work Supervisor and Admin roles to this user.

Import XML Pack for Bottler1 Enterprise

Import an XML pack to prepopulate the enterprise with some data.

1. Log in to the Bottler1 enterprise.

2. Select System Operations > Import Meta Data.

3. Provide the path to the following xml file:
$MQ_COMMON_DIR/standard/samples/cim2cimmetadata/Bottler1/Bottle

r1-MetaData.jar.

To see what data is generated by importing this XML pack, see Data generated 
through XML Pack Import, page 133.

Bottler2 Enterprise Creation
1. Create an Enterprise Bottler2 of type Supplier with Internal Name as Bottler2

2. Create a user admin with first name admin and last name user. Assign the 
Work Supervisor and Admin roles to this user.

Attribute Value

User Name admin

First/Middle/Last admin//admin

Roles Work Supervisor/Admin

Attribute Value

Enterprise Bottler2

Enterprise Name Supplier

Internal Name Bottler2

Attribute Value

User Name admin

First/Middle/Last admin//admin
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Import XML Pack for Bottler2 Enterprise

Import an XML pack to prepopulate the enterprise with some data.

1. Log in to the Bottler2 enterprise.

2. Select System Operations > Import Meta Data.

3. Provide the path to the following xml file:
$MQ_COMMON_DIR/standard/samples/cim2cimmetadata/Bottler2/Bottle

r2-MetaData.jar

To see what data is generated by importing this XML pack, see Data generated 
through XML Pack Import, page 133.

Data generated through XML Pack Import
By importing the various XML packs, the respective enterprises are populated 
with the following:

Repository

A Repository MC_V2VITEMMASTER

Attributes

Some custom attributes in repository MC_V2VITEMMASTER

Roles Work Supervisor/Admin

Attribute Value
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Output Maps

An output map OM_V2VOUTPUT based on the EANUCCExt Output format created 
in repository MC_V2VITEMMASTER

Synchronization Format

EANUCCEXT synchronization format with some custom attributes

Business Process Rules

The following Business Process rules are created:

• Brandowner enterprise

— Custom Protocol Selection

— Rulebase Selection

• VeloselMarketplace enterprise

— Custom Protocol Selection

— Rulebase Selection

— Repository Selection for Received Records
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• Bottler1 and Bottler2 enterprises

— Custom Protocol Selection

— Repository Selection for Received Records
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Step 3 - Database Changes

Run the following scripts from the database: 

The OrgID of your organization and replace it in the SQL below where it displays 
<Org ID Here>.

Bottler Subscription Rulebase
insert into ConfigurationDefinition (ID, TYPE, OWNERID, GLOBAL, NAME, 
SELECTOR, DESCRIPTION, DEFINITIONTYPE, DEFINITION, ACTIVE, MODMEMBERID, 
MODDATE, MODVERSION)
VALUES (Mq_Sequence_1.nextval, 'Rulebase', <Brandowner's Org ID Here>, 'N', 
'Bottler Subscription', ‘SUBSCRIPTION’, 'Select Subscription.', 'File', 
'bottler/rulebase/rbsynchtradingpartner.xml', 'Y', 1, SYSDATE, 1);
COMMIT;

BrandOwner Translation Map
insert into ConfigurationDefinition 
(ID, TYPE, OWNERID, GLOBAL, NAME, SELECTOR, DESCRIPTION, DEFINITIONTYPE, 
DEFINITION,
 ACTIVE, MODMEMBERID, MODDATE, MODVERSION)
VALUES (Mq_Sequence_1.nextval, 'XSLT', <Brandowner's Org ID Here>, 'N', 
'Custom Map', 'CONNECTOR', 
'Message Translation.', 'File', 
'standard/maps/mpfromcatact26toveloselcinv1.xsl', 'Y', 1, SYSDATE, 1);
COMMIT;

VeloselMarketplace Translation Map
insert into ConfigurationDefinition 
(ID, TYPE, OWNERID, GLOBAL, NAME, SELECTOR, DESCRIPTION, DEFINITIONTYPE, 
DEFINITION, 
ACTIVE, MODMEMBERID, MODDATE, MODVERSION)
VALUES (Mq_Sequence_1.nextval, 'XSLT', <VeloselMarketplace's Org ID Here>, 
'N', 'Custom Map', 'CONNECTOR', 'Message Translation.', 'File', 
'standard/maps/mpfromcatact26toveloselcinv1.xsl', 'Y', 1, SYSDATE, 1);
COMMIT;

insert into ConfigurationDefinition 
(ID, TYPE, OWNERID, GLOBAL, NAME, SELECTOR, DESCRIPTION, DEFINITIONTYPE, 
DEFINITION,
 ACTIVE, MODMEMBERID, MODDATE, MODVERSION)
VALUES (Mq_Sequence_1.nextval, 'XSLT', <VeloselMarketplace's Org ID Here>, 
'N', 'Custom Map', 'CONNECTOR', 
'Message Translation to create Response.', 'File', 
'standard/maps/mpfromveloselcintoveloselcinrv1.xsl', 'Y', 1, SYSDATE, 1);
COMMIT;
TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



Step 3 - Database Changes | 137
VeloselMarketplace Subscription Rulebase
Make the rulebase Global for simplicity:
insert into ConfigurationDefinition (ID, TYPE, OWNERID, GLOBAL, NAME, 
SELECTOR, DESCRIPTION, DEFINITIONTYPE, DEFINITION, ACTIVE, MODMEMBERID, 
MODDATE, MODVERSION) VALUES (mq_sequence_1. nextval, 'Rulebase', 
<VeloselMarketplace's Org ID Here>, 'N', 'Bottler Subscription', 
'SUBSCRIPTION', 'Select Subscription.', 'File', 
'bottler/rulebase/rbsynchveloselmarketplace.xml', 'Y', 1, SYSDATE, 1)
COMMIT;

VeloselMarketplace Translation Maps (Instance 2)
• XSL Map for translating CIM CIN to mlXML: 

mpfromveloseltomlxml26v1.xsl

• XSL Map for translating CIM CIN to CIM CIN Response: 
mpfromveloselcintoveloselcinrv1.xsl

For simplicity, you can make all the above Subscription Rulebase and Translation 
Map files globally available as follows:

— Enter a value '1' instead of <Brandowner's OR VeloselMarketplace's 
Org ID Here> for column OWNERID

— Enter a value 'Y' instead of 'N' for column GLOBAL.
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Step 4 - Company Profile and GLN Creation

Create GLN credentials for each enterprise. These credentials are used to 
uniquely identify the enterprise to communicate with.

BrandOwner Enterprise
1. Log in to the BrandOwner enterprise.

2. Subscribe to VeloselMarketplace.

a. Select Administration >Datapool Profiles and click Subscribe (in the 
Actions column) against VeloselMarketplace.

b. Click Modify against VeloselMarketplace, click Modify in the Supported 
Synchronization Formats section and select the EANUCC 
synchronization format. Click Save.

3. Create a Company Profile called BrandOwner and create a GLN for it.

a. Select Administration >My Company Profile.

b. Create a valid credential by clicking the Create link in the Credential 
section.

c. On the Create Credential screen, provide Domain as GLN and ID as 
<GLN>. Click Save.
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VeloselMarketplace Enterprise
1. Log in to the VeloselMarketplace enterprise.

2. Subscribe to VeloselMarketplace.

a. Select Administration > Datapool Profiles and click Subscribe (in the 
Actions column) against VeloselMarketplace.

b. Click Modify against VeloselMarketplace, click Modify in the Supported 
Synchronization Formats section and select the EANUCC 
synchronization format. Click Save.

3. Create a Company Profile VeloselMarketplace and create a GLN for it.

a. Select Administration > Company Profile

b. Create a valid GLN by clicking the Create link in the Credential section.

c. On the Create Credential screen, provide Domain as GLN and ID as 
<GLN>. Click Save.

Bottler1 Enterprise
1. Log in to the Bottler1 enterprise.

2. Subscribe to VeloselMarketplace

a. Select Administration > Datapool Profiles and click Subscribe (in the 
Actions column) against VeloselMarketplace.

b. Click Modify against VeloselMarketplace, click Modify in the Supported 
Synchronization Formats section and select the EANUCC 
synchronization format. Click Save.

3. Create a Company Profile called Bottler1 and create a GLN for it.

a. Select Administration > Company Profile.

b. Create a valid GLN by clicking the Create link in the Credential section.

c. On the Create Credential screen, provide Domain as GLN and ID as 
<GLN>. Click Save.

Bottler2 Enterprise
1. Log in to the Bottler2 enterprise.
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2. Subscribe to VeloselMarketplace

a. Select Administration > Datapool Profiles and click Subscribe (in the 
Actions column) against VeloselMarketplace.

b. Click Modify against VeloselMarketplace, click Modify in the Supported 
Synchronization Formats section and select the EANUCC 
synchronization format. Click Save.

3. Create a Company Profile called Bottler2 and create a GLN for it.

a. Select Administration > Company Profile.

b. Create a valid GLN by clicking the Create link in the Credential section.

c. On the Create Credential screen, provide Domain as GLN and ID as 
<GLN>. Click Save.
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Step 5 - Trading Partner Profile Creation

Define trading partners for each enterprise and provide the GLN credentials of 
those trading partners.

BrandOwner Enterprise
1. Log in to the BrandOwner enterprise and define Bottler1 and Bottler2 as 

trading partners.

2. Create a Trading Partner Profile: Bottler1. 

a. Select Administration > Trading Partner Profiles.

b. Create a Trading Partner with name as Bottler1; select 
VeloselMarketplace under the Datapool section; select the EANUCCEXT 
Synchronization format. Click Save.

c. Once the Bottler1 Trading Partner Profile is created, click Bottler1 in the 
Trading Partner Profiles List.

d. Click Extended Credentials against VeloselMarketplace in the Datapool 
Participation section.

e. Click Create to create a Credential for Bottler1.

f. Select Domain as GLN, and provide the <GLN> as the Identity. Click 
Save. The GLN you provide here should be the one defined in Bottler1 
Enterprise, page 139.

3. Follow the same steps to create a Trading Partner Profile: Bottler2 and provide 
extended credentials listing the GLN.

VeloselMarketplace Enterprise
1. Log in to the VeloselMarketplace enterprise and define BrandOwner, 

Bottler1 and Bottler2 as trading partners.

The GLN credentials provided here for trading partners should be the same ones 
defined in Step 4 - Company Profile and GLN Creation, page 138 for each 
enterprise.
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2. Create a Trading Partner Profile: BrandOwner.

a. Select Administration > Trading Partner Profiles.

b. Create a Trading Partner with the name BrandOwner; From the Datapool 
section, select VeloselMarketplace. Now select the EANUCCEXT 
Synchronization format. Click Save.

c. After you create the BrandOwner Trading Partner Profile, click 
BrandOwner in the Trading Partner Profiles List.

d. Click Extended Credentials against VeloselMarketplace in the Datapool 
Participation section.

e. Click Create to create a Credential for BrandOwner.

f. Select Domain as GLN, and provide the <GLN> as the Identity. Click 
Save. The GLD you provide here should be the one defined in Bottler1 
Enterprise, page 139.

3. Follow the same steps to define Bottler1 and Bottler2 as trading partners and 
provide extended credentials listing their respective GLN IDs.

Bottler1 and Bottler2
Log in to the Bottler1 and Bottler2 enterprises respectively and define 
BrandOwner as a trading partner for each. Provide extended credentials listing 
the BrandOwner GLN.
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Step 6 - Rulebase Changes

You need to make some changes to the rbsynchtradingpartner.xml rulebase 
file through which marketplaces and trading partners are specified.

Changes to rbsynchtradingpartners.xml Rulebase File
1. In $MQ_COMMON_DIR/bottler/rulebase, open the 

rbsynchtradingpartner.xml rulebase file.

2. Make the following changes in this file for variable declaration.

Declare Variables for Enterprises

1. Search for the following section:
<!-- Convenience variables to hold GLN number to use.-->

2. Provide the following as the first four variable declarations:
BO_GLN, VM_GLN, TP1GLN, TP2GLN.

3. Your code should read as follows:

<declare usage="local">
  <var>BO_GLN</var> 
</declare>
<declare usage="local">
  <var>VM_GLN</var> 
</declare>
<declare usage="local">
  <var>TP1GLN</var> 
</declare>
<declare usage="local">
  <var>TP2GLN</var> 
</declare>

Assign Credential Variables and Values

1. Search for the following section:
<name>AssignCredentials</name> 

2. Provide the appropriate GLN variables (BO_GLN, VM_GLN, TP1GLN, TP2GLN) 
and the GLNs. Ensure that the GLNs match what you have defined in the UI.

3. Your code should read as follows:

<action>
 <assign>
   <var>BO_GLN</var> 
     <const type="string">0044444447786</const> 
 </assign>
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 <assign>
   <var>VM_GLN</var> 
     <const type="string">0044444447779</const> 
 </assign>
 <assign>
   <var>TP1GLN</var> 
     <const type="string">0044444447793</const> 
 </assign>
 <assign>
   <var>TP2GLN</var> 
     <const type="string">0044444447700</const> 
 </assign>
</action>

Define Marketplaces for each Product

1. Search for:
<description>Marketplaces for Each Products</description> 

2. Search for the following variable:
<var>SenderArray</var> 

3. Assign the following variables to SenderArray:
<var>BO_GLN</var> 

<var>BO_GLN</var> 

4. Search for the following variable:
<var>ChannelArray</var> 

5. Assign the following variables to ChannelArray:
<var>VM_GLN</var> 

<var>VM_GLN</var> 

6. Search for the following variable:
<var>TradingPartnerArray</var> 

7. Assign the following variables to TradingPartnerArray:
<var>TP1GLN</var> 

<var>TP2GLN</var> 

Two variables are added to the Sender Array and Channel Array sections 
respectively, for two trading partners. You need as many variables in these 
sections as trading partners.
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Step 7- Datasource and Input Map creation for BrandOwner

Create a datasource and input map for the BrandOwner enterprise.

Datasource Creation

1. Log in to the BrandOwner enterprise.

2. Select Item Data > Data Sources

a. Create Datasource DS_V2VItems.

b. Provide some data as input to the datasource.

Inputmap Creation

1. Create an input map between the DS_V2VItems datasource and the 
MC_V2VItemMaster repository.
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2. Select Item Data > Repositories

a. Select the check box against the MC_V2VITEMMASTER repository and 
click the Manage Input Maps button.

b. Click Create to create a new input map.

c. On the Create Input Map screen:

d.  Provide an Input Map Name and Input Map Description. Select 
Split/Approval Required.

e. Select DS_V2VItems check box and click Next.

f. Map the required attributes. The following are required:

— Record ID

— Record ID Extension

— Related Records

— SupplierID 

— GTIN 

— Brand_Owner_ID 

— Content_Owner_ID 

— Name_Of_Brand_Owner 

— Name_of_Datapool 

— Name_Of_Info_Provider 

— Source_Data_Pool_ID 
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— Target_Market_ID

g. Click Save.
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Step 8 (Optional) - Processing Reverse Relationships

By default, the workflows are set up to process forward relationships (for 
example: A contains B, B contains C, C contains D).

In case you have reverse relationship hierarchies (for example, A contained by B, 
B contained by C, and so on), you need to make some changes to process reverse 
relationships so that data is propagated correctly from BrandOwner to 
Marketplace and Bottlers.

Change to the wfin26cim2cimsyncV1.xml Workflow

1. Open the 
$MQ_COMMON_DIR/standard/workflow/wfin26cim2cimsyncV1.xml file.

2. Search for the following section:

<!--  Sample transition to flip the root of bundles --> 
<!-- Transition FromActivity="HandleRecordCollectionForFlipDecision" 
ToActivity="ManageRecordCollectionForFlip">

<Description>If the Rulebase Selection Business Process Rule is 
set, only then transition to ApplySynchRuleBase and Spawn Publish 
Workflow</Description>

<Rule>
<Parameter name="Rulebase" type="string" eval="rule" 
source="Rulebase Selection"           
direction="in">inDoc</Parameter>

          <Parameter name="result" type="boolean" direction="out"/>
            <Condition format="bsh"><![CDATA[
                result =  (Rulebase != null && !Rulebase.equals(""));
            ]]></Condition>
       </Rule>
  </Transition>
  <Transition FromActivity="ManageRecordCollectionForFlip"  
ToActivity="ApplySynchRuleBase"/
  --> 

3. Uncomment this section (commented out by default) to process reverse 
relationships.

This is the workflow for CIM to CIM synchronization.
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Change to the wfin26catsourceimportv2.xml Workflow

1. Open the 
$MQ_COMMON_DIR/standard/workflow/wfin26catsourceimportv2.xml file.

2. Search for:
<Activity Name="ManageRecordCollection">

3. Search for the RelationshipName parameter:
<Parameter direction="in" name="RelationshipName" type="string" 

eval="constant">Contains</Parameter>

4. Change this from Contains to ContainedBy to process reverse relationships.

Change to the wfin26catsourcev5.xml Workflow

1. Open the $MQ_COMMON_DIR/standard/workflow/wfin26catsourcev5.xml 
file.

2. Search for:
<Activity Name="ManageRecordCollection">

3. Search for the RelationshipName parameter:
<Parameter direction="in" name="RelationshipName" type="string" 

eval="constant">Contains</Parameter>

4. Change this from Contains to ContainedBy to process reverse relationships.

Change to the wfin26prodnotifprocessv2.xml Workflow

1. Open the 
$MQ_COMMON_DIR/standard/workflow/wfin26prodnotifprocessv2.xml 
file.

This is the workflow for import/load and import events.

This is the workflow for datasource loads and import of records.

This workflow is used to process the incoming record messages and to save data.
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2. Search for the following activities:

• <Activity Name="GetProductInfo">

• <Activity Name="GetProductInfo2">

3. Add the following parameter:
<Parameter direction="in" name="RelationshipName" type="string" 
eval="constant">Contains</Parameter>. 
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Step 9 - Testing your CIM to CIM Setup

After completing all the outlined steps, you can test your CIM to CIM setup by 
doing the following:

1. Log in to the BrandOwner enterprise and add a record.

2. This record is synchronized to VeloselMarketPlace and to Bottler1 and 
Bottler2.

3. You can login to VeloselMarketPlace, Bottler1, and Bottler2 to verify the 
synchronization.
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Troubleshooting CIM to CIM

Issue

In a CIM to CIM setup, when attempting to import over 100 records, you may get 
a "No data to read from socket" error. DB Error code: 17410. 

Solution

This problem may be seen if you are on an Oracle 11 version lower than 11.1.0.7 
(for example, 11.1.0.6). Try updating to 11.1.0.7.
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Chapter 9 Supplier and Retailer Setups

This chapter describes Supplier and Retailer side setups in TIBCO MDM. 

Topics

• Supplier Setup, page 154

• Retailer Setup, page 158
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Supplier Setup

Create the Supplier Enterprise
Follow these steps to define your supplier enterprise.

1. Log in to the tibcocim enterprise with superuser credentials.

2. Select Administration > All Company Profiles.

a. Click Create and create a new Profile with Type as Supplier.

b. Create a user for the enterprise with Administrator and Work Supervisor 
Roles.

3. Log out of the enterprise. 

Define the Supplier Enterprise
Follow these steps to define credentials, to subscribe to the datapool, to define the 
Synchronization Format, and to set up trading partners. 1Sync is used as an 
example here.

1. Log in to the newly created enterprise with the created user credentials.

2. Select Administration > My Company Profile.

a. Click the Create link in the Credentials section. 

b. Create a Credential with Domain as GLN and provide your <Supplier 
GLN> as the Identity.

3. Select Administration > Datapool Profiles. 

a. Subscribe to 1Sync by clicking the Subscribe link in the Actions column.

b. Click Modify in the Actions column. 

c. Click Modify again under Supported Synchronization Formats.

d. Select 1Sync from the list of Synchronization Formats. Click Save.
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4. Select Administration > Trading Partner Profiles. 

a. Click Create to create a new Trading Partner.

b. Provide details to create the Trading Partner and select 1Sync as the 
Default Synchronization Format. Click Save.

c. In newly created Trading Partner Profiles, click on Modify.

d. Select 1Sync as the Datapool. Click Save.

e. Click the newly created trading partner in the trading partner list.

f. Click the Extended Credentials link against the 1Sync in the Datapool 
Participation section.

g. Click Create to create a credential.

h. Select Domain as GLN and provide the GLN of the trading partner as the 
Identity.

i. Click Save.

5. Select Administration > My Company Profiles. 

a. Click the Credentials link against 1Sync in the Datapool Participation 
section.

b. Click Create to create a credential.

c. Select Domain as GLN. The Supplier GLN is populated in the Identity 
drop-down list.

d. Specify the Batch User ID, User ID, and Password for the Supplier GLN. 

e. Click Save.

Define Repository for Outgoing Messages
Create or define the repository that messages will go out from.

1. Deploy repository model from TIBCO MDM Studio containing the 1Sync 
output map and UDEX and GPC classification schemes. For more information 
on creating repositories, refer TIBCO MDM Repository User’s Guide.

2. (Optional step) Perform this step to use MDM’s out-of-the-box catalog 
validation file which has some predefined validations in sync with datapool 
validations.

TIBCO MDM supports more than one GLN in an enterprise. You can create more 
than one GLN in an enterprise. 
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On $MQ_COMMON_DIR/standard/rulebase , do the following:

a. Copy the _1sync_mastercatalog_catalogvalidation.xml rulebase file 
to the 
$MQ_COMMON_DIR/<enterprise>/catalog/master/<repositoryID> 
folder. 

b. Rename the file catalogvalidation.xml.
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Select Repository for Incoming Messages
Select the repository to which messages from the retailer side should be directed.

1. Log in with the Supplier credentials.

2. Create a Business Process Rule to select the repository for the Add 
Notification event. To create a Business Process Rule, follow these steps:

a. Click Business Processes, then click the Repository Selection rule.

b. Click the Default business process template and click Create.

c. Select Conditions > the trading partner name is, and then select your 
trading partner (specify the trading partner name only if you want 
messages from different trading partners to be added to partner specific 
repositories).

d. Select Conditions > The UDEX Code is, and then select your defined 
UDEX code or select Any.

e. Select Actions > The repository to add the record to, and then select your 
repository.

f. Select Actions > Treat new CINs as ’data change’ messages, and then 
select Yes, consider it as changes.

g. Click Save.
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Retailer Setup

Create the Retailer Enterprise
Follow these steps to define your retailer enterprise:

1. Log in to the tibcocim enterprise with superuser credentials.

2. Select Administration > All Company Profiles.

a. Click Create and create a new Profile with Type as Retailer.

b. Create a user for that enterprise with Administrator and Work Supervisor 
Roles.

3. Log out of the enterprise. 

Define the Retailer Enterprise
The Retailer side setup is similar to the Supplier setup. See Supplier Setup, 
page 154. 

The only difference is the GLN definition. For example:

Case 1

If the Supplier and Retailer is TIBCOCIM, then on the Retailer side, follow these 
steps:

• When defining the GLN in the Company Profile, provide the Trading Partner 
GLN of the Supplier.

• When defining the Trading partner GLN, provide the Supplier GLN defined 
in the Company Profile.

Case 2

If the Supplier is not TIBCOCIM, then on the Retailer side,follow these steps:

• Define the GLN of the Retailer in the Company Profile.

• Define the Supplier GLN in the Trading Partner’s GLN.

TIBCO MDM supports more than one GLN in an enterprise. You can create more 
than one GLN in an enterprise. 
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Select Repository for Incoming Messages
Select the repository to which messages from the supplier side should be directed.

1. Log in with the Retailer credentials.

2. Create a Business Process Rule to select the repository for the Add 
Notification event. To create a Busines Process Rule, follow these steps:

a. Click Business Processes, then click the Repository Selection rule.

b. Click the Default business process template and click Create.

c. Select Conditions > the trading partner name is, and then select your 
trading partner (specify the trading partner name only if you want 
messages from different trading partners to be added to partner specific 
repositories).

d. Select Conditions > The UDEX Code is, and then select your defined 
UDEX code or select Any.

e. Select Actions > The repository to add the record to, and then select your 
repository.

f. Select Actions > Treat new CINs as ’data change’ messages, and then 
select Yes, consider it as changes.

g. Click Save.

Select Approvers for Received Records
Set up a rule for approvers of received records. To set up a rule, follow these steps:

1. Click Business Processes, then click the Approvers for Received Records 
rule.

2. Click the Default Business Process Template. Click Create to create a new 
rule.

3. Under Conditions > the trading partner name is, and then select the defined 
trading partner.

4. Select Actions > Set the participant user to, and then provide the user 
information.

5. Select Actions > Set the next work item state to, and the define the next state 
of the workitem. For example, you can set the workitem state to Final Step.

6. Click Save.
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Select Editors for Received Records
Set up a rule for editors of received records.

1. Click Business Processes, then click the Editors for Received Records rule.

2. Click the Default Business Process Template. Click Create to create a new 
rule.

3. Select Conditions > the trading partner name is, and then select the defined 
trading partner.

4. Select Actions > Set the participant user to, and then provide the user 
information.

5. Select Actions > Set the next work item state to, and then define the next state 
of the workitem. For example, you can set the workitem state to Final 
Step/Done.

6. Click Save.

Detect New Backend Systems
Set up a rule to define the user or role to notify when a new backend system is 
detected. To set up such a rule, follow these steps:

1. Click Business Processes, then click Unknown Trading Partner Alert.

2. Click the Default Business Process Template. Click Create to create a new 
rule.

3. Select Actions > Set the participant user to, and then provide the user 
information.

4. Click Save.
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Chapter 10 Setting up GPC Classification Scheme Data 
Load

This chapter describes the procedure for setting up the data load for the Global 
Product Classification scheme.

Topics

• Configuring GPC Classification Scheme Loading, page 162

• Configuring Support for GPC Code, page 164
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Configuring GPC Classification Scheme Loading

The GPC data source is provided as the out-of-the-box set up in the TIBCOCIM 
enterprise. For uploading new GPC codes into CIM, follow these steps:

1. Add the following dataset to the filewatcher.xml catalog. 

<DataSet type="single">

<!--

There should be no MasterCatalog Element when importing a Standard 
Classification Scheme such as GPC, UDEX.

-->

<Name>DataSetS2</Name>

<Credential domain="ZZ">

<!-- This is a pre-defined credential-->

<Identity>GLOBAL</Identity>

</Credential>

<Action>ImportClassificationScheme</Action>

<URIInfo scheme="local">

<Relative>MQ_COMMON_DIR</Relative>

<!-- This directory is created outOfBox -->

<URI>velosel/GPC</URI>

</URIInfo>

<Incremental>Yes</Incremental>

<DataSource>

<RevisionID>

<!-- This a pre-defined data source in Velosel enterprise -->

<BaseName>GPC</BaseName>

</RevisionID>

</DataSource>

<ClassificationScheme>

<RevisionID>

<!-- This a pre-defined classification scheme -->

<BaseName>GPC</BaseName>

</RevisionID>

</ClassificationScheme>

</DataSet> 

2. Ensure that the following subdirectories exist under the 
$MQ_COMMON_DIR/velosel/GPC/ directory. 
— incoming

— rejected

— done

3. Place the data file (.csv) in the $MQ_COMMON_DIR/velosel/GPC/incoming 
directory. The .csv file is used to upload when the FileWatcher polling 
interval time is over. All the rows from the .csv file are uploaded into the 
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GPC data source. If the upload is successful, the .csv file is copied into the 
done directory.
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Configuring Support for GPC Code

Adding GPC Dropdowns for Editing Records in a Repository
For dependent drop-downs, add the following section to your catalog validation 
rulebase:

<declare>
<var>GPC_classification</var>
<link type="datasource">
<literal>GPC</literal>
</link>
</declare>
<constraint>
<name>GPC CODE</name>
<description>GPC CODE dropdown</description>
<usefor>
<var>GPC_SEGMENT_CODE</var>
</usefor>
<action>
<select novalue="option">
<table source="classification">
<literal>GPC_classification/SEGMENT_CODE</literal>
<literal>GPC_classification/SEGMENT_DESC</literal>
</table>
</select>
</action>
</constraint>
<constraint>
<name>FAMILY CODE</name>
<description>GPC Hierarchy Level 2 dropdown</description>
<usefor>
<var>GPC_FAMILY_CODE</var>
</usefor>
<condition>
<defined>
<var>GPC_SEGMENT_CODE</var>
</defined>
</condition>
<action>
<select novalue="default">
<table source="datasource">
<literal>GPC</literal>
<literal>FAMILY_CODE</literal>
<literal>FAMILY_DESC</literal>
<where>
<sql>
<eq>
        <literal>SEGMENT_CODE</literal>
        <const type="string">?</const>
</eq>
</sql>
<var>GPC_SEGMENT_CODE</var>
</where>
</table>
</select>
</action>
</constraint>
<constraint>
<name>CLASS CODE</name>
<description>GPC Hierarchy Level 3 dropdown</description>
<usefor>
<var>GPC_CLASS_CODE</var>
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</usefor>
<condition>
<defined>
<var>GPC_FAMILY_CODE</var>
</defined>
</condition>
<action>
<select novalue="default">
<table source="datasource">
<literal>GPC</literal>
<literal>CLASS_CODE</literal>
<literal>CLASS_DESC</literal>
<where>
<sql>
<and>
<eq>
<literal>SEGMENT_CODE</literal>
<const type="string">?</const>
</eq>
<eq>
<literal>FAMILY_CODE</literal>
<const type="string">?</const>
</eq>
</and>
</sql>
<var>GPC_SEGMENT_CODE</var>
<var>GPC_FAMILY_CODE</var>
</where>
</table>
</select>
</action>
</constraint>
<constraint>
<name>BRICK CODE</name>
<description>GPC Hierarchy Level 4</description>
<usefor>
<var>ADDITIONAL_CLASS_CAT_CODE</var>
</usefor>
<condition>
<defined>
<var>GPC_CLASS_CODE</var>
</defined>
</condition>
<action>
<select novalue="default">
<table source="datasource">
<literal>GPC</literal>
<literal>BRICK_CODE</literal>
<literal>BRICK_DESC</literal>
<where>
<sql>
<and>
<eq>
          <literal>SEGMENT_CODE</literal>
          <const type="string">?</const>
</eq>
<eq>
<literal>FAMILY_CODE</literal>
<const type="string">?</const>
</eq>
<eq>
<literal>CLASS_CODE</literal>
<const type="string">?</const>
</eq>
</and>
</sql>
<var>GPC_SEGMENT_CODE</var>
<var>GPC_FAMILY_CODE</var>
<var>GPC_CLASS_CODE</var>
</where>
</table>
</select>
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</action>
</constraint>
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Chapter 11 Configure TIBCO BusinessConnect and 
TIBCO BusinessWorks

This chapter explains the process for configuring TIBCO BusinessConnect for 
sending documents to and receiving documents from different data pools.

This chapter contains the details for configuring only TIBCO BusinessConnect to 
work with the application. Refer to the appropriate documentation if you want to 
use any other AS2 Gateway.

TIBCO BusinessConnect 5.x supports JMS, however the TIBCO BusinessWorks 
plug-in for BusinessConnect 5.x is still required.

Topics

• Configuring TIBCO BusinessConnect, page 168

• TIBCO Administrator Setup, page 169

• BusinessConnect Setup, page 170

• New BusinessConnect Configuration, page 171

• Business Works Setup, page 190

• Testing the MDM-BusinessWorks-BusinessConnect Connectivity, page 196
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Configuring TIBCO BusinessConnect

Prerequisites
• TIBCO BusinessConnect 5.3.0 must be installed on the system. 

Refer to TIBCO Business Connect documentation for details.

• A database must be installed. BusinessConnect 5.x supports Oracle, DB2, 
MySQL, and SQL Server.

• TRA 5.6.1, Business Works 5.7.2, TIBCO Administrator 5.4.0, TIBCO EMS 5.1.2 
must be installed on the system.

• UserID and password to access the TIBCO BusinessConnect Admin console.

• Port 4080 or any other port on which TIBCO BusinessConnect is listening 
needs to be opened.
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TIBCO Administrator Setup

1. Install TIBCO Administrator in console mode and read the installation guide.

2. For Linux/UNIX setup, create Domain using the domain utility 
TIBCO_TRA_HOME/bin/domainutility.

— Set defaults settings, give domain names as: <<DOMAIN_NAME>>/, choose 
UTF-8 for character set, default ports -> http port=9090, AJP 1.3 port 
=8009, shutdown port =8005, username=admin, password=admin

— If UTF-8 does not work, change the characters to another character set

— Change the owner to vsadmin and give all the rights to the tibco folder as - 
sudo chown -R vsadmin:vsadmin /home/tibco/

sudo chmod -R 777 /home/tibco

3. On Windows, you can create a new domain using Programs -> TIBCO -> 
TIBCO Runtime Agent & Adapter SDK 5.5 -> Domain Utility. 

4. After successfully configuring TIBCO Administrator, start TIBCO 
Administrator by executing the following on Linux/UNIX platform: 
<<TIBCO_HOME>>/administrator/domain/<<DOMAIN_NAME>>/bin/tibcoad

min_<<DOMAIN_NAME>>/&

5. Start TIBCO Hawk Agent by executing the following on Linux/UNIX 
platform: 
<<TIBCO_HOME>>/tra/domain/<<DOMAIN_NAME>>/hawkagent_<<DOMAIN_NA

ME>>/&

6. For Windows installations, start TIBCO Hawk Agent as an NT service.

7. On Windows, set up TIBCO Administrator as an NT service.

8. Access the Administrator URL as:
http://<machinename>:9090/administrator/servlet/tibco_administrator
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BusinessConnect Setup

You can configure BusinessConnect by:

— Configuring BusinessConnect (new configuration)

— Importing an existing setup from another installation and customizing the 
imported BusinessConnect configuration

Prerequisites 
1. Database and Database user.

A Database (which can be used by the BusinessConnect setup) should be 
configured. 

2. TIBCO EMS
TIBCO EMS 5.1.2 should be installed and started as an NT service on 
Windows; on Linux it should be started on root.

3. Install Unlimited Strength JCE Policy Files
To use BusinessConnect security features, download and install JavaTM 
Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files 
1.5.0. To download and install the policy files, follow these steps:

— Download the required files from the following web sites:

Windows, Sun Solaris, HP-UX, Linux:
http://java.sun.com/j2se/1.5.0/download.jsp

IBM AIX:
https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?so

urce=jcesdk

— Unzip jce_policy-1_5_0.zip

— Copy US_export_policy.jar and local_policy.jar to:
TIBCO_home\jre\1.5.0\lib\security

4. TIBCO Administrator and TIBCO Hawk
TIBCO Administrator and TIBCO Hawk should be started.
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New BusinessConnect Configuration

1. Start TIBCO Administrator
http://<machinename>:9090/administrator/servlet/tibco_administrator
Login as admin/admin.

2. Check if the BusinessConnect link appears in left side panel. If not, click 
Application management -> All service instance -> machine name -> 
Plug-Ins -> Add -> and browse to the bcwebadmin.war file of 
BusinessConnect. 

The .war file can be found on:
<<TIBCO_HOME>>/bc/5.3/admin-plugins/ bcwebadmin.war

Adding the .war file takes some time.

3. In the left side panel, BusinessConnect is available. Click BusinessConnect -> 
Manage Installation.

4. Provide database details for installation and test connection for Oracle. 
Sample database details:
JDBC Driver: tibcosoftwareinc.jdbc.oracle.OracleDriver 
JDBC URL: 
jdbc:tibcosoftwareinc:oracle://<oracleservername>:1521;SID=<<DA

TABASE_NAME>>
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Create Participants

Participant of type Partner

a. Click BusinessConnect -> Participants

b. Select type of participant as Partner and create and provide a name to the 
participant.

c. Provide all relevant details, click the Active check box to activate the 
participant.
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d. Click the Credentials tab.

e. Click the New Certificate tab. Provide the alias name and upload the 
certificate provided by the Trading partner (Data pool in case of MDM) 
followed by Save.

f. Click the Protocols -> Enable tab.

g. Select the EZComm protocol check box and click OK.

h. Click the newly enabled protocol EZcomm as in the following screen.

i. Click the Add New link to create a new AS2 ID.
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j. Click the Add New tab to create a new AS2 ID.

k. Create new AS2 ID.

l. Select the newly created AS2 ID and click OK.

m. Click Transports -> Add tab.

n. Add details to Transport; select the Transport Type as AS2_HTTP, click OK.
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o. Provide details for the newly created Transport.

p. Chnage the URL as per the trading partner specification.
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q. Keep the default proxy settings.

r. Click Save to save the participant.
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Participant of type Host

a. Click BusinessConnect -> Participant.

b. Select the type of participant as Host and create and provide a name to the 
participant.

c. Click the Active check box to activate the participant.

d. Click the Credentials tab - > New Private Key.

e. Provide the alias of the key, upload the private key (public key of which 
has sent to Partner) and click Save.

f. Click the Protocols tab and enable EZcomm protocol as enabled earlier to 
create Partner Participant.
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g. Create a new AS2 ID, clicking on the newly enabled protocol EZcomm -> 
AS2 Identifier -> Add new link. In AS2 Identity, provide GLN on data 
pool.

h. Click Save to save the participant.
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New Operations
a. Click Business Connect -> Operation Editor.

b. Click the Edit button in the right pane for Protocol EZComm.

c. Click the radio button for EZComm protocol and then click the New 
Category button.

d. Save the new category.

e. Click the new version button to create a new version for the new category. 
Provide details and Save the version.
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f. Click the New Operation button to create a new operation for this version.

g. Select the operation type as Asynchronous Request-Response and click 
OK.

h. On the next screen, enter a name for the new operation.

i. Click the Request Action tab and select the Require Digital Signature 
and Require Content Encryption check boxes.
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j. Click the Response Action tab and select the check boxes as previously 
mentioned.

k. Click the Save button to save the newly created operation.

l. Create this operation once for all participants.
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System Settings
a. Click the BusinessConnect -> System settings menu in the left panel.

b. Click JDBC Configuration in the right pane.

c. Click JDBC Configuration to create new JDBC connection details for 
BusinessConnect.
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Sample database details are as follows:
JDBC Driver Class: tibcosoftwareinc.jdbc.oracle.OracleDriver
JDBC URL: jdbc:tibcosoftwareinc:oracle://localhost:1521;SID=bcdb
Database User: bcuser
Password: bcuser

d. Click Test Connection, if the connection is successful, click Save.

e. Select the newly created BusinessConnect connection in Audit Logs, Non 
Repudiation Logs, Runtime Data Store, and click Done. 
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Business Agreement
a. Click BusinessConnect-> Business Agreement in the left panel.

b. Click the New tab to create a new agreement.

c. Select the Host party and Partner party radio buttons for which you want 
to make an agreement as shown in the following screen and click OK.

d. Click the newly created Agreement.

e. Click the Valid check box on the next screen and provide dates for start 
and end of the agreement.

f. Click the Add Protocol Binding tab, to add new protocol binding. Select 
EZComm from available protocols.

g. Click the EZComm protocol link and provide details.

h. Click the Document Security tab and select values.
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Here the values should be defined as follows:
Signing Key: Name of the TIBCO’s private certificate.
Digest Algorithm: MD5
Encryption Certificate: Name of Trading Partner Certificate
Encryption Algorithm: Encryption algorithm used by Trading Partner
Verification Certificate: Name of Trading Partner Certificate
Decryption Key: Name of the TIBCO’s private certificate

i. Click the Transports tab and select values.

Deploy the BusinessConnect configuration (Single Server Mode)
a. Deploy the configuration, click Administrator -> Business Connect -> 

System Settings -> Deployment Configuration -> click Create 
deployment Configuration. The Business Connect link in Application 
Management is displayed.

b. Select a machine to deploy the Business Connect installation 

Click Application Management -> Business Connect -> Configuration -> 
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Single Server.par. Select the machine name. If you do not see the machine 
name, it may be due to the hawk agent.

c. Select Application 
Management>BusinessConnect>Configuration>BusinessConnect>Con
figuration and click Save.

d. Click Application Management -> BusinessConnect -> Configuration -> 
Business Connect ->HTTP 

e. Ensure the port is enabled and a proper value is provided.

f. Click Application Management -> BusinessConnect -> Configuration -> 
BusinessConnect.

g. Click the Private Process Configuration tab and select the JMS radio 
button.
TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



New BusinessConnect Configuration | 187
h. Click the JMS link and provide the JMS details. After completing all the 
details click Test connection to test the JMS connection. Save the details, if 
the test connection is successful.

Sample details are as follows:
JNDI Context Factory: 
com.tibco.tibjms.naming.TibjmsInitialContextFactory

JNDI Context URL: tcp://localhost:7222
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Topic Connection Factory: TopicConnectionFactory
Queue Connection Factory: QueueConnectionFactory

i. Click Application Management -> BusinessConnect -> Configuration -> 
Business Connect -> Deploy.

j. Click the Deploy Tab. Ensure the Start successfully deployed services 
check box is selected.

k. Check the status of BusinessConnect availability. Click the Application 
Management -> BusinessConnect -> Service Instance. The 
BusinessConnect instance status displays as either stand by or running.
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l. If after the deployment, the BusinessConnect instance is not started, click 
Application Management -> BusinessConnect -> Service Instance -> 
BusinessConnect Instance check box and click Start.

m. If all the actions are successful, the BusinessConnect instance should be in 
running state. If the BusinessConnect instance cannot be started 
successfully, check the TIBCO Administrator logs 
(<<TIBCO_HOME>>administrator\domain\<<DOMAIN_NAME>>\logs\aud
it.txt) to find the cause.
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Business Works Setup

Prerequisites
1. Before you start a BW project, create a directory as follows:

<<TIBCO_HOME>>\fsjndi\designerExtendedJars

2. Add the following jars to this location:
— fscontext.jar

— jndi.jar

— providerutil.jar

3. Edit the designer.tra file located in <<TIBCO_HOME>>\designer\5.5\bin.

4. Add the following entry to this file:
tibco.class.path.extended 

%CUSTOM_CP_EXT%%PSP%%STD_CP_EXT%:<<TIBCO_HOME>>/fsjndi/designer

ExtendedJars

Setup
1. Start TIBCO Designer.

2. Click New empty project.
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3. Specify the project directory and encoding.

4. Click Project -> Import Full Project.

5. Import vcrepo.dat from the existing BW project directory (directory of the 
same name as your existing BW configuration).

6. Alternately, if you don’t want to import the existing project, copy the existing 
BW project directory with another name. This is similar to importing the 
existing BW project.

7. Edit the project as imported and copied above.
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8. Change the following Global variables per the project requirement:

— bindingFile: Provide the directory location  where you want to place your 
binding file for this project.

— receiveFile: Provide the directory location where you want the received 
messages to be saved.

— hostName: Provide the name of the participant which you configured in BC 
as Participant of type Host. 

— tpName: Provide the name of the participant which you configured in BC as 
Participant of type Partner. 

The Sample values are as follows:

9. Click Project Tab -> Shared Connection.

10. If you already have a BusinessConnect connection configured, update the 
connection.
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11. Click the ‘Update from Configuration stores’ button.

12. Select the Select operations check box; click OK on the next screen.

13. Click the Import selected Business Protocol button.
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14. Click the BusinessConnect Server Access tab.

15. Click Update from Configuration Store followed by the Import Selected 
Business Protocol button.

16. Click the JMS tab of the previous screen.

17. Click Update from Configuration Store followed by the Import Selected 
Business Protocol button.

18. If you have created a new BusinessConnect connection, ensure the property 
‘Server Details’ of all the activities point to a valid BC connection. A sample 
activity ‘Send Request to TP’ of process ‘Send to TP Process’ is as follows:
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19. Start the test engine by clicking the Tester tab on the left followed by a green 
start signal.

20. Click Load selected. 

21. After a successful start, all processes should be visible.
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Testing the MDM-BusinessWorks-BusinessConnect Connectivity

To test the MDM-BusinesWorks-BusinessConnect connectivity, follow these steps:

1. Have a ready-to-publish catalog in MDM.

2. In TIBCO Designer, ensure the tBW tester is running, check for 
Processes\Outbound\Send To TP Process, and all setup done.

3. The Binding file accessed by the BW setup should have the IP of the machine 
from where testing has to be done.

4. The BC engine should be running and all setups should be done. Open TIBCO 
Administrator.

5. Publish the product from MDM. 

6. Check BW for Processes\Outbound\Send To TP Process, whether the 
message received, as the activities flow shows green.

7. Check TIBCO Administrator for BusinessConnect, in Log Viewer, for a Audit 
Logs, for selected time range, whether the message reached and whether the 
message went out to the trading partner. 

8. Check for acknowledgement from the datapool.

9. Check for response in BusinessConnect, BusinessWorks and MDM eventLog.

10. TIBCO BusinessConnect EZComm Protocol does not record advisory 
messages, such as the Responder Acknowledgement, in the audit log.
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Appendix A GDSN Predefined Components

This appendix provides an overview of the out-of-the-box GDSN components 
provided in the $MQ_HOME/plugins/gdsn/<version>/common/standard 
folder. 

Topics

• Overview, page 198

• GDSN-Specific Maps, page 199

• GDSN-Specific Forms, page 200

• GDSN-Specific Rulebases, page 201

• GDSN-Specific Workflows, page 204

We do not recommend that you modify components supplied in this directory. If a 
modification is required, maintain the modified file in an enterprise-specific 
directory. 
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Overview

This chapter contains a listing of all standard predefined components shipped 
with the application. There are standard MDM specific components, and 
incremental GDSN specific components. You can see these components if you 
have the GDSN plug-in installed.

GDSN Components

For GDSN, you can see maps, rulebases, workflows, and templates.

All these components are present in relevant folders under 
$MQ_HOME/plugins/gdsn/<version>/common/standard.
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GDSN-Specific Maps

This section introduces you to translation maps specific to GDSN provided in the 
$MQ_HOME/plugins/gdsn/<version>/common/standard/maps folder.

Table 11   GDSN-Specific Maps

File Description

mpfrom1sync62cicwlto26v1.xsl This XSLT translates an incoming CIC message 
(1SYNC Item Authorization Response) to the 
mlXML format.

mpfromcatact26to1sync65v1.xsl This XSLT translates an outgoing mlXML 
message to the 1Sync Catalog Request message 
format (1SYNC Item Maintenance message).

mpfromcatact26tononebxml70v1.xsl This sample map file generates a non-ebxml 
outbound message. 

mpfromcatact26toveloselcinv1.xsl This file translates the outgoing mlXML 
messages to a message format used in 
CIM-to-CIM synchronization.

mpfromcatact26toveloselcinv1_all_Attri
butes.xsl

This file translates the outgoing mlXML 
messages to the message format used in 
CIM-to-CIM synchronization. It maps all the 
catalog attributes rather than filtering out 
EAN.UCC format specific attributes.

mpfromveloselcintoveloselcinrv1.xsl This file is used in CIM-to-CIM synchronization 
to generate a response for an incoming message.

mpfromveloseltomlxml26v1.xsl This file translates an incoming message to the 
mlXML format during CIM-to-CIM 
synchronization.
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GDSN-Specific Forms

This section introduces you to forms specific to GDSN provided in the 
$MQ_HOME/plugins/gdsn/<version>/common/standard/forms folder.

Table 12   GDSN-Specific Forms

File Description

fmretailer.xml Used to populate retailer information on retailer 
side
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GDSN-Specific Rulebases

This section introduces you to rulebases specific to GDSN provided in the 
$MQ_HOME/plugins/gdsn/<version>/common/standard/rulebase folder. 

Table 13   GDSN-Specific Rulebases

File Description

_1sync_catalogvalidation.xml This rulebase declares validation rules for 
out-of-the-box catalog synchronization for 1Sync 
datapool.

_1sync_mastercatalog_catalogvalidation
.xml

This rulebase declares validation rules for the 
master catalog used in synchronization having 
1SYNC catalog output map. 

rbapprover.xml This is an empty rulebase which is used in the 
workflow wfin26prodnotifretailerv4.xml to 
flag any errors or warnings in the incoming 
message data. This rulebase should be 
customized as per your business process needs. 

rbconnectorprotocolderivation_gdsn.xml This rulebase decides the protocol to be used by 
the message handler for outgoing messages or 
the response handler for incoming messages. 

rbconnectorrolederivation.xml This rulebase decides the protocol to be used by 
the message handler for outgoing messages or 
the response handler for incoming messages. 

rbduplicate.xml This rulebase provides a sample duplicate check 
constraint for incoming messages. The sample 
rulebase is used to implement a duplicate check 
for GDSN incoming messages.

rbeditor.xml This is an empty rulebase which is used in 
workflow wfin26prodnotifretailerv4.xml 
and other incoming message processing 
workflows to flag any errors or warnings in the 
incoming message data. This rulebase should be 
customized as per your business process needs. 

rbformatattributes_gdsn.xml Format specific attributes to be used for a 
marketplace.
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rbgdsnrelationship.xml This rulebase is used to identify the relationship 
to be used in the GDSN edition.

rbGPCClassificationscheme.xml This rulebase drives the classification codes for 
the GPC predefined classification scheme.

rbresponsehandlerprotocolderivation_gd
sn.xml 

This rulebase is used to identify the protocol 
used for message processing.

rbretailerval.xml This is a sample retailer validation rulebase.

rbsendmessage_gdsn.xml The generic screen is available from the Product 
View screen, where there is an actions link for 
SendMessage based on the user privileges (Role). 
The UI that opens on clicking this link is 
completely customizable based on the 
underlined rulebase rbsendMessage.xml. 
Currently, it is used to send an RFCIN message 
and generate a fact sheet.

The following customizations are possible:

• Customize the product attributes that can be 
displayed.

• Customize actions that can be performed.

• Customize the MarketPlace and 
TradingPartner Credentials.

• Customize the user defined attributes.

rbsyncstatusupdatederivation.xml This sample rulebase is used to customize the 
manual synchronization status update action.

rbtolerance.xml Permissible values for attributes are defined in 
this rulebase.

rbtransorasupplier.xml This rulebase identifies different sync operations 
for the 1SYNC datapool.

rbUDEXClassificationscheme.xml This rulebase derives the classification codes for 
the UDEX predefined classification scheme. 

Table 13   GDSN-Specific Rulebases

File Description
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rbworkitemdescription_gdsn.xml This rulebase derives out-of-the-box workitem 
descriptions for the GDSN edition.

rbcim2cimsupplier.xml This rulebase identifies the operation state 
machine for CIM to CIM supply side.

Table 13   GDSN-Specific Rulebases

File Description
 TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



204 | Appendix A  GDSN Predefined Components
GDSN-Specific Workflows

This section introduces you to workflows specific to GDSN provided in the 
$MQ_HOME/plugins/gdsn/<version>/common/standard/workflow folder 

Table 14   GDSN-Specific Workflows

File Description

wfin26RFCINv2.xml The workflow to receive and process publication 
request (RFCIN) for suppliers. 

wfin26catsynchv7_gdsn.xml The workflow to initiate synchronization with 
datapool or custom channel.

wfin26cim2cimsyncV1.xml CIM to CIM synchronization workflow.

wfin26proddatanotifbasicv2.xml The incoming record notification workflow for, 
primarily, data add/change messages. 
Recommended for GDSN retailers and similar 
usage where the received data needs to be 
processed and saved.

wfin26prodnotifbasicv3.xml The incoming record notification workflow, 
primarily, for data publication messages. It is a 
variation of wfin26proddatanotifbasicv2.

wfin26prodnotifprocessv2.xml The workflow to process the incoming record 
message and save data.

wfin26prodnotifretailerv4.xml The workflow to process the incoming record 
message and save data. It is a variation of 
wfin26prodnotifprocessv2 targeted towards 
datapools and integration hubs.

wfin26prodnotifv2.xml The workflow to receive a notification of a 
response for a previous synchronization request 
sent. The notification is issued by CIM when a 
response is received and processed. 

wfin26catactionRFCINv2.xml The workflow to implement initiation of 
publication request (RFCIN) for retailers. 

wfout1sync62cic26v1.xml The workflow to translate the incoming 1Sync 
CIC message to an mlXML format.
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wfoutveloselcin26v2.xml The workflow to translate the incoming 
CIM2CIM message to an mlXML format. 

wfout1sync65cin26v1.xml The workflow to translate the incoming 1Sync 
CIN message to an mlXML format.

Table 14   GDSN-Specific Workflows

File Description
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Appendix B Error Messages

This appendix lists GDSN-specific error messages.

Topics

• Catalog Errors, page 208

• Rulebase Errors, page 212

• Administration Errors, page 213

• Miscellaneous Errors, page 214
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Catalog Errors

This section contains GDSN-specific Catalog (CAT) errors.

Table 15   Catalog Errors

MDM Error 
Code Error Description

CAT-1068 No credentials for Trading partner <Parameter name='VALUE'> (<Parameter 
name='VARIABLE'>) defined on <Parameter name='VARIABLE2'>.

CAT-1069 Datapool or trading partner credentials not provided. Correct and re-try.

CAT-1201 Organization currently not subscribed to any datapools. Ensure subscription to at 
least one datapool before attempting to synchronize.

CAT-1202 Synchronization profile associated with datapool <Parameter name='NAME'> 
not subscribed by your organization. Subscribe to the specified datapool first.

CAT-1203 Already subscribed to this datapool.

CAT-1247 Associate GPC/UDEX classification scheme with repository for synchronization 
with predefined datapools.

CAT-1271 Invalid synchronization profile; Trading partner <Parameter name='NAME'> 
deleted.

CAT-1279 Synchronization format <Parameter name='VALUE2'> not supported by 
Datapool <Parameter name='VALUE'>.

CAT-1280 Repository does not support output formats of datapool <Parameter 
name='VALUE'>.

CAT-1293 Warning: <Parameter name='VALUE'> with relationships.

CAT-1304 Cannot load Synchronization profile '<Parameter name='NAME'>'.

CAT-1305 Synchronization profile <Parameter name='VALUE'>.

CAT-1306 Synchronization profile <Parameter name='VALUE'> (<Parameter 
name='VALUE2'> items).

CAT-1307 Synchronization profile <Parameter name='VALUE'> (<Parameter 
name='VALUE2'> items) synchronization with <Parameter name='VALUE3'>.
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CAT-1308 Synchronization profile <Parameter name='VALUE'> (<Parameter 
name='VALUE2'> items) synchronization on <Parameter name='VALUE3'>.

CAT-1309 Synchronization profile <Parameter name='VALUE'> synchronization with 
<Parameter name='VALUE3'>.

CAT-1310 Synchronization profile <Parameter name='VALUE'> synchronization on 
<Parameter name='VALUE3'>.

CAT-1311 Preview of synchronization profile <Parameter name='VALUE'> (<Parameter 
name='VALUE2'> items).

CAT-1312 Validation of synchronization profile <Parameter name='VALUE'> (<Parameter 
name='VALUE2'> items).

CAT-1313 Item <Parameter name='VALUE'> added to repository <Parameter 
name='VALUE2'>.

CAT-1314 Item <Parameter name='VALUE'> changed in repository <Parameter 
name='VALUE2'>.

CAT-1315 Item <Parameter name='VALUE'> deleted in repository <Parameter 
name='VALUE2'>.

CAT-1316 Conflicts in item <Parameter name='VALUE'> in repository <Parameter 
name='VALUE2'>. Action required.

CAT-1317 Synchronization profile <Parameter name='VALUE'> synchronization with 
<Parameter name='VALUE3'> on <Parameter name='VALUE4'>.

CAT-1318 Synchronization profile <Parameter name='VALUE'> (<Parameter 
name='VALUE2'> items) synchronization with <Parameter name='VALUE3'> on 
<Parameter name='VALUE4'>.

CAT-1319 On <Parameter name='VALUE3'>.

CAT-1320 Item <Parameter name='VALUE'> added <Parameter name='VALUE3'>.

CAT-1321 Item <Parameter name='VALUE'> changed <Parameter name='VALUE3'>.

CAT-1322 Item <Parameter name='VALUE'> deleted <Parameter name='VALUE3'>.

CAT-1323 Item <Parameter name='VALUE'> corrected <Parameter name='VALUE3'>.

Table 15   Catalog Errors

MDM Error 
Code Error Description
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CAT-1324 Item <Parameter name='VALUE'> pending <Parameter name='VALUE3'>.

CAT-1325 Item <Parameter name='VALUE'> pending with <Parameter name='VALUE2'> 
<Parameter name='VALUE3'>.

CAT-1326 Item <Parameter name='VALUE'> pre-authorized <Parameter name='VALUE3'>.

CAT-1327 Item <Parameter name='VALUE'> pre-authorized by <Parameter 
name='VALUE2'> <Parameter name='VALUE3'>.

CAT-1328 Item <Parameter name='VALUE'> authorized <Parameter name='VALUE3'>.

CAT-1329 Item <Parameter name='VALUE'> authorized by <Parameter name='VALUE2'> 
<Parameter name='VALUE3'>.

CAT-1330 Item <Parameter name='VALUE'> deleted <Parameter name='VALUE3'>.

CAT-1331 Item <Parameter name='VALUE'> deleted by <Parameter name='VALUE2'> 
<Parameter name='VALUE3'>.

CAT-1332 Item <Parameter name='VALUE'> rejected <Parameter name='VALUE3'>.

CAT-1333 Item <Parameter name='VALUE'> rejected by <Parameter name='VALUE2'> 
<Parameter name='VALUE3'>.

CAT-1334 Item <Parameter name='VALUE'> publication requested <Parameter 
name='VALUE3'>.

CAT-1335 Item <Parameter name='VALUE'> publication requested by <Parameter 
name='VALUE2'> <Parameter name='VALUE3'>.

CAT-1336 Item <Parameter name='VALUE'> load requested <Parameter name='VALUE3'>.

CAT-1337 Item <Parameter name='VALUE'> load requested to <Parameter 
name='VALUE2'> <Parameter name='VALUE3'>.

CAT-1338 Item <Parameter name='VALUE'> published <Parameter name='VALUE3'>.

CAT-1339 Item <Parameter name='VALUE'> published to <Parameter name='VALUE2'>.

CAT-1340 Item <Parameter name='VALUE'> changed <Parameter name='VALUE3'>.

Table 15   Catalog Errors

MDM Error 
Code Error Description
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CAT-1341 Item <Parameter name='VALUE'> changed to <Parameter name='VALUE2'> 
<Parameter name='VALUE3'>.

CAT-1342 Item <Parameter name='VALUE'> de-listed <Parameter name='VALUE3'>.

CAT-1343 Item <Parameter name='VALUE'> de-listed from <Parameter name='VALUE2'> 
<Parameter name='VALUE3'>.

CAT-1344 Item <Parameter name='VALUE'> withdrawn <Parameter name='VALUE3'>.

CAT-1345 Item <Parameter name='VALUE'> withdrawn from <Parameter 
name='VALUE2'> <Parameter name='VALUE3'>.

CAT-1346 Item <Parameter name='VALUE'> loaded <Parameter name='VALUE3'>.

CAT-1347 Item <Parameter name='VALUE'> loaded to <Parameter name='VALUE2'> 
<Parameter name='VALUE3'>.

CAT-1348 Item <Parameter name='VALUE'> corrected <Parameter name='VALUE3'>.

CAT-1349 Item <Parameter name='VALUE'> corrected to <Parameter name='VALUE2'> 
<Parameter name='VALUE3'>.

CAT-1350 Item <Parameter name='VALUE'> not received <Parameter name='VALUE3'>.

CAT-1351 Item <Parameter name='VALUE'> not received by <Parameter name='VALUE2'> 
<Parameter name='VALUE3'>.

Table 15   Catalog Errors

MDM Error 
Code Error Description
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Rulebase Errors

This section contains GDSN-specific Rulebase (RB) errors.

Table 16   Rulebase Errors

MDM Error 
Code Error Description

RB-1110 Synchronization profile $Catalog$ is being synchronized with retailer 
$TradingPartner$. Approval required. (<Parameter name='RECORD_COUNT'/> 
records.)

RB-1111 Synchronization profile $Catalog$ is validated for synchronization with retailer 
$TradingPartner$. Review required. (<Parameter name='RECORD_COUNT'/> 
records.)

RB-1112 Synchronization profile $Catalog$ is being synchronized with trading partner 
$TradingPartner$. Approval required.  (<Parameter name='RECORD_COUNT'/> 
records.)

RB-1113 Synchronization profile $Catalog$ is validated for synchronization with trading 
partner $TradingPartner$. Review required. (<Parameter 
name='RECORD_COUNT'/> records.)

RB-1115 A message was received for which the trading partner identified by <Parameter 
name='CUSTOM_DOMAIN'/> <Parameter name='CUSTOM_GLN'/> was not 
recognized. Actions required.
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Administration Errors

This section contains GDSN-specific Administration (ADM) errors.

Table 17   Administration Errors

MDM Error 
Code Error Description

ADM-3005 Invalid value <Parameter name='VALUE'> specified. Cannot generate Check 
digit.

ADM-3033 No trading partners found.

ADM-3315 Not subscribed to datapool.

ADM-3326 <Parameter name='TYPE'> of company cannot have trading partners.

ADM-3328 Global trading partner name <Parameter name='NAME'> already used within 
same enterprise. Specify unique name.

ADM-3329 Private trading partner name <Parameter name='NAME'> already used within 
same enterprise. Specify unique name.

ADM-3330 Global trading partner name <Parameter name='NAME'> used in another 
enterprise. Name should be unique across all enterprises.

ADM-3331 Private trading partner name <Parameter name='NAME'> used in another 
enterprise. Provide a unique name.

ADM-3332 Trading partner name <Parameter name='NAME'> already used.
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Miscellaneous Errors

This section contains GDSN-specific errors in the Rulebase (RUL), General (GEN), 
and Service (SVC) categories.

Table 18   Misc Errors

MDM Error 
Code Error Description

RUL-4620 Action Type must be either IRulebase.ELEM_ACTION_TYPE_THEN or 
IRulebase.ELEm_ACTION_TYPE_ELSE.

GEN-7073 Application shutting down. Internal error.

GEN-7218 Delete datapool <Parameter name='NAME'>?

GEN-7229 Synchronization format is default format for trading partner.

SVC-11013 Unsupported record state <Parameter name='RECORD_STATE'> specified for 
entity object.

SVC-11046 Cannot initiate workflow.
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Appendix C GDSN Samples

This appendix lists GDSN sample details. The samples are located in the 
$MQ_HOME/plugins/gdsn/1.2/common/standard/samples folder.

Topics

• 1WorldSync Samples, page 216

• cim2cim metadata, page 222
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1WorldSync Samples

This section contains the details of GDSN-specific 1WorldSync samples.

mlxml indoc (supplier)
These samples are located in the 
$MQ_HOME/plugins/gdsn/1.2/common/standard/samples/1Sync/mlxml 

indoc/Supplier folder:
• Add_Cancel.xml

• Add_Correct.xml

• Add_Discontinue.xml

• Add_New.xml

• Add-Reinstate.xml

• Link.xml

• Link-UnLink.xml

• Publish_New.xml

• Publish-Reload-copy.xml

• Publish-Reload-original.xml

These internal MDM messages are converted to 1WorldSync datapool format.

These are MDM specific internal formats for the corresponding sync 
operation/suboperation selected in the synchronization profile/workitem or 
send response/message screens. 

The naming convention for the sample files is OPER_SUBOPER.xml, where OPER 
is the operation selected in synchronization event, SUBOPER is the suboperation 
selected in synchronization event. For details of operation and suboperation, refer 
Table 8, MDM Operations for 1WorldSync Messages (Supplier Operations), on 
page 107.
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sync messages (retailer)
These samples are located in the 
$MQ_HOME/plugins/gdsn/1.2/common/standard/samples/1Sync/sync 

messages/Retailer folder.

Table 19   1WorldSync Samples: Sync Messages (Retailer)

File name Description

CICR.xml Catalog Item Confirmation Response (CICR) received from 
Datapool in response to CIC messages.

CINR.xml This message is sent by CIM in response to CIN.

CIN-Hierarchy-New.xml This new/initial load message is received from Datapool 
when the supplier publishes the hierarchy for the retailer.

CIN-Hierarchy-Correction.xml This correction message is received from Datapool when the 
supplier publishes the hierarchy for the retailer.

CIN-singleRecord-New.xml This new/initial load message is received from Datapool 
when the supplier publishes single record for the retailer.

CIC_RECEIVED.xml The CIC message with status as RECEIVED sent by retailer in 
receipt of CIN. By default, this is sent by CIM or by the 
retailer on clicking the send response link on the Record View 
page.

CIC_REJECTED.xml The CIC message with status as REJECTED sent by retailer in 
receipt of CIN. This message is sent when a user takes action 
on authorization work item and selects Reject Notification or 
by the retailer on clicking the send response link on the 
Record View page.

CIC_REVIEW.xml The CIC message with status as REVIEW sent by retailer in 
receipt of CIN. This message is sent when user takes action on 
authorization work item and selects Review Notification or 
by the retailer on clicking the send response link on the 
Record View page.

CIC_SYNCHRONISED.xml The CIC message with status as SYNCHRONISED sent by 
retailer in receipt of CIN. This message is sent by the retailer 
on clicking the send response link on the Record View page.
 TIBCO MDM Add-on for Global Data Synchronization - User’s Guide



218 | Appendix C  GDSN Samples
sync messages (supplier)
These samples are located in the 
$MQ_HOME/plugins/gdsn/1.2/common/standard/samples/1Sync/sync 

messages/Supplier folder.

Item Cancel.xml When the supplier publishes the hierarchy for the retailer 
with CancelDate populated, this correction message is 
received from Datapool.

Item Delete.xml This delete message is received from Datapool when the 
supplier publishes the delete operation for the retailer.

Item Discontinue.xml When the supplier publishes the hierarchy for the retailer 
with DiscontinueDate populated, this correction message is 
received from Datapool.

RFCIN.xml The RFCIN message sent by the retailer with isReload set as 
true/false.

This message is sent on selecting the Send Message link on 
the Record View page. The Include Rejected Record option 
should be selected/cleared.

RFCINR.xml Request For Catalog Item Notification Response (RFCINR) 
received from Datapool in response to RFCIN messages.

Table 19   1WorldSync Samples: Sync Messages (Retailer)

File name Description

Table 20   1WorldSync Samples: Sync Messages (Supplier)

File name Description Operation Selected on Synchronization 
Profile

Add_New.xml ITEM ADD message is 
sent for the new records 
added but not 
synchronized to the 
datapool.

Incremental

Yes

Deliver To

Datapool

Operation

Add

Add_Correct.xml ITEM CORRECTION 
message having values 
for the modified records.

Incremental

Yes/No

Deliver To

Datapool

Operation

Data 
Correction
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Add_Discontinue.x
ml

ITEM CORRECTION 
message having 
discontinueDate 
populated for the records, 
which have to be 
discontinued.

Incremental

Yes/No

Deliver To

Datapool

Operation

Data 
Correction/

Discontinue

Add_Cancel.xml ITEM CORRECTION 
message having 
cancelDate populated for 
the records, which have to 
be canceled.

Incremental

Yes/No

Deliver To

Datapool

Operation

Data 
Correction/

Cancel

Add-Reinstate.xml ITEM CORRECTION 
message not having 
cancelDate or 
discontinueDate for the 
records that were 
canceled or discontinued.

Incremental

Yes/No

Deliver To

Datapool

Operation

Data 
Correction/

Reinstate

Link.xml ITEM LINK ADD 
message sent to 
1WorldSync if a new 
relationship for the parent 
record or change in 
relationship of parent 
record is detected.

Incremental

Yes/No

Deliver To

Datapool

Operation

Add/Data 
Correction

Link-UnLink.xml ITEM LINK DELETE 
message sent to 
1WorldSync when a 
relationship change of 
parent record is detected.

Incremental

Yes/No

Deliver To

Datapool

Operation

Add/ Data 
Correction

Publish_New.xml PUBLICATION ADD 
message of New type sent 
to the retailer, for 
example, Trading Partner.

Incremental

Yes/No

Deliver To

Trading 
Partner on 
Datapool

Operation

Add/ 
Publish

Table 20   1WorldSync Samples: Sync Messages (Supplier)

File name Description Operation Selected on Synchronization 
Profile
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Publish-Reload-
original.xml

PUBLICATION ADD 
message of New type, 
sent to the retailer, for 
example, Trading Partner.

Incremental

Yes/No

Deliver To

Trading 
Partner on 
Datapool

Operation

For 
RELOAD-
ORIGINAL- 
Initial Load+ 
Include 
Rejected 
Records

Publish-Reload-
copy.xml

PUBLICATION ADD 
message of InitialLoad 
type, sent to the retailer, 
for example, Trading 
Partner.

Incremental

Yes/No

Deliver To

Trading 
Partner on 
Datapool

Operation

For 
RELOAD-
COPY: Initial 
Load

CIC_REVIEW.xml Catalog Item 
Confirmation message of 
the Review type received 
from Datapool initiated 
by retailer or Trading 
Partner.

This is an incoming 
message.

None None None

CIC_RECEIVED.xml Catalog Item 
Confirmation message of 
the Received type 
received from Datapool 
initiated by retailer or 
Trading Partner.

This is an incoming 
message.

None None None

Table 20   1WorldSync Samples: Sync Messages (Supplier)

File name Description Operation Selected on Synchronization 
Profile
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CIC_REJECTED.xml Catalog Item 
Confirmation message of 
the Rejected type received 
from Datapool initiated 
by retailer or Trading 
Partner.

This is an incoming 
message.

None None None

CIC_SYNCHRONISED.
xml

Catalog Item 
Confirmation message of 
the Synchronised type 
received from Datapool 
initiated by retailer or 
Trading Partner.

This is an incoming 
message.

None None None

Table 20   1WorldSync Samples: Sync Messages (Supplier)

File name Description Operation Selected on Synchronization 
Profile
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cim2cim metadata

This section contains the details of GDSN-specific cim2cim metadata samples 
located in the 
$MQ_HOME/plugins/gdsn/1.2/common/standard/samples/cim2cim metadata 
folder.

Table 21   cim2cim Metadata Samples

File name Description

Bottler1-MetaData.
jar

Bottler1-specific repository and Business Process Rules are created.

Bottler2-MetaData.
jar

Bottler2-specific repository and Business Process Rules are created.

BrandOwner-MetaDat
a.jar

Brandowner-specific repository and Business Process Rules are created.

VeloselMarketplace
-MetaData.jar

VeloselMarketplace-specific repository and Business Process Rules are 
created.
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